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safety information

These warnings and precautions are included in order to prevent injury to you and others, as well as preventing any
potential damage to your machine. Be sure to read and understand all of these instructions before using the machine.
Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place
for future reference.

IMPORTANT SAFETY SYMBOLS

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of
danger.

Explanation of all icons and signs used in the user’s guide:

Warning

Hazards or unsafe practices that may result in severe personal injury or death.

Caution

Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

P00 >p

Follow directions explicitly.

OPERATING ENVIRONMENT

A Warning

o

ﬁ*

Sras

Do not use if the power cord is damaged or if the
electrical outlet is not grounded.

» This could result in electric shock or fire.

Do not place anything on top of the machine (water,
small metal or heavy objects, candles, lit cigarettes,
etc.).

» This could result in electric shock or fire.
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Do not bend, or place heavy objects on the power
cord.

» Stepping on or allowing the power cord to be
crushed by a heavy object could result in electric
shock or fire.

Do not remove the plug by pulling on the cord; do not
handle the plug with wet hands.

» This could result in electric shock or fire.



If the machine gets overheated, it releases smoke,
makes strange noises, or generates an odd odor,
immediately turn off the power switch and unplug the
machine.

» This could result in electric shock or fire.

A Caution

During an electrical storm or for a period of
non-operation, remove the power plug from the
electrical outlet.

» This could result in electric shock or fire.

Be careful, the paper output area is hot.
» Burns could occur.

If the machine has been dropped, or if the cabinet appears
damaged, unplug the machine from all interface connections
and request assistance from qualified service personnel.

» Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in
performance, unplug the machine from all interface
connections and request assistance from qualified service
personnel.

» Otherwise, this could result in electric shock or fire.

OPERATING METHOD

A Caution

Do not forcefully pull the paper out during printing.
» It can cause damage to the machine.

Be careful not to put your hand between the machine
and paper tray.

» You may get injured.

® Do not block or push objects into the ventilation opening.

» This could result in elevated component temperatures which
can cause damage or fire.

Use care to avoid paper cuts when replacing paper or removing
jammed paper.

» You may get hurt.

®

©

©

Safety information_ 10

O

-
Em

If the plug does not easily enter the electrical outlet, do not
attempt to force it in.

» Call an electrician to change the electrical outlet, or this
could result in electric shock.

Do not allow pets to chew on the AC power, telephone or PC
interface cords.

» This could result in electric shock or fire and/or injury to your
pet.

If the machine does not operate properly after these
instructions have been followed, unplug the machine from all
interface connections and request assistance from qualified
service personnel.

» Otherwise, this could result in electric shock or fire.

When printing large quantities, the bottom part of the
paper output area may get hot. Do not allow children
to touch.

» Children may be burned.

When removing jammed paper, do not use tweezers
or sharp metal objects.

» It can cause damage to the machine.

Do not allow too many papers to stack up in the paper output
tray.

» It could cause damage to the machine.

This machine's power interception device is the power cord.

» To switch off the power supply, remove the power cord from
the electrical outlet.



INSTALLATION / MOVING

A Warning

Do not place the machine in an area with dust,
<> humidity or water leaks.

» This could result in electric shock or fire.

A Caution

When moving the machine, turn the power off and
disconnect all cords; then lift the machine with at
least two people.

» The machine could fall, causing human injury or
machine damage.

@ Do not place the machine on an unstable surface.

» The machine could fall, causing human injury or machine
damage.

The machine should be connected to
the power level which is specified on the label.

» If you are unsure and want to check the power level you are
using, contact the electrical utility company.

Use only No.26 AWG? or larger, telephone line cord, if
necessary.

» Otherwise, it can cause damage to the machine.

a. AWG: American Wire Gauge

MAINTENANCE / CHECKING

A Caution

®7_ Unplug this product from the wall outlet before

— cleaning the inside of the machine. Do not clean the
machine with benzene, paint thinner or alcohol; do
not spray water directly into the machine.

» This could result in electric shock or fire.

JAlcchl| XX

When you are working inside the machine replacing
supplies or cleaning the inside, do not operate the

’ machine.

» You may get injured.

"4

® Do not put a cover over the machine or place it in an airtight

location, such as a closet.
» If the machine is not well-ventilated, this could result in fire.

@ Make sure you plug the power cord into a grounded electrical

outlet.
» Otherwise, this could result in electric shock or fire.

® Do not overload wall outlets and extension cords.

» This can diminish performance, and could result in electric
shock or fire.

(D Use the power cord supplied with your machine for safe

operation. If you are using a cord which is longer than 2 meters
(79”) with a 140V machine, then the gauge should be 16 AWG
or larger.

» Otherwise, it can cause damage to the machine, and could
result in electric shock or fire.

D o Keep cleaning supplies away from children.
L » Children may get hurt.
A
®7 Do not disassemble, repair or rebuild the machine by
yourself.
/::\ "% | p It can cause damage to the machine. Call a
N certified technician when the machine needs repair.
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@ Keep the power cable and the contact surface of the plug clean @ To clean and operate the machine, strictly follow the user's
from dust or water. guide provided with the machine.

» This could result in electric shock or fire. » Otherwise, it can cause damage to the machine.
® Do not remove any covers or guards that are fastened with

Screws.

» The machine should only be repaired by Samsung service
technician.

SUPPLY USAGE

A Caution

When storing supplies such as toner cartridges, keep

®7 Do not disassemble the toner cartridge.
» Toner dust can be dangerous to humans. them away from children.
__’. » Toner dust can be dangerous to humans.
) Do not burn any of the supplies such as toner ® Using recycled supplies, such as toner, can cause damage to
_ - cartridge or fuser unit. the machine.
-Ef = » It can cause an explosion or fire. » In case of damage due to the use of recycled supplies, a
= < - service fee will be charged.

@ When changing the toner cartridge or removing jammed paper,
be careful not to let toner dust touch your body or clothes.

» Toner dust can be dangerous to humans.

Safety information_ 12



regulatory information

This machine is certified with several regulatory statements.

LASER SAFETY STATEMENT

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and
elsewhere is certified as a Class | laser product conforming to the requirements of IEC 60825-1:1993 + A1:1997 + A2:2001.

Class | laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to
laser radiation above a Class | level during normal operation, user maintenance or prescribed service condition.

*  Wavelenght: 800 nm
* Beam divergence
- Paraller: 11 degrees
- Perpendicular: 35 degrees
* Maximum power or energy output: 12 mW

WARNING

Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible,
can damage your eyes.

When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

CAUTION - CLASS 38 LASER RADIATION WHEN OPEN
AVOID EXPOSURE TO THE BEAM.
DANGER - LASER RADIATION AVOID DIRECT
EXPOSURE TO BEAM.
DANGER - RADIATIONS INVISIBLES DU LASER EN CAS
D'OUVERTURE. EVITER TOUTE EXPOSITION
DIRECTE AU FAISCEAU.
VORSICHT - UNSICHTBARE LASERSTRAHLUNG, WENN
ABDECKUNG GEOFFNET.
NICHT DEM STRAHL AUSSETZEN.
ATTENZIONE - RADIAZIONE LASER INVISIBILE IN CASO DI
APERTURA. EVITARE LESPOSIZIONE AL FASCIO.
PRECAUCION - RADIACION LASER INVISIBLE CUANDO SE ABRE.
EVITAR EXPONERSE AL RAYO
PERIGO - RADIAGAO LASER INVISIVEL AO ABRIR. EVITE
EXPOSIGAO DIRECTAAO FEIXE.
GEVAAR - ONZICHTBARE LASERSTRALEN Bl GEOPENDE
KLEP. DEZE KLEP NIET OPENEN.
ADVARSEL - USYNLIG LASERSTRALNING VED ABNING.
UNDGA UDSAETTELSE FOR STRALNING
ADVARSEL. - USYNLIG LASERSTRALNING NAR DEKSEL
APNES. UNNGA EKSPONERING FOR STRALEN.
VARNING - OSYNLIG LASERSTRALNING NAR DENNA DEL
AR OPPEN. STRALEN AR FARLIG.
VAROITUS - NAKYMATONTA LASERSATEILYA AVATTAESSA.
VARO SUORAA ALTISTUMISTA SATEELLE.
&K - FRBE URECHEEG
F o -0l HS Ll 2fo|xo LB  gloD2
Foslale,

OZONE SAFETY

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Samsung dealer.
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PERCHLORATE WARNING

This Perchlorate warning applies only to primary CR (Manganese Dioxide) Lithium coin cells in the product sold or distributed ONLY in
California USA.

Perchlorate Material - special handling may apply.

See www.dtsc.ca.gov/hazardouswaste/perchlorate. (U.S.A. only)

POWER SAVE

L)

ENERGY STAR

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered.
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks.

For more information on the ENERGY STAR program see http://www.energystar.gov.

RECYCLING

2,

&

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

CHINA ONLY

[EIEVe IR
N T RIS, AT LA IR ITI @ SE T RION PR R St
Fefire s e S RIS TH ™ S R R 55 o
NSRRI S, RN 5T ISR R,
FfiT 2 By A fE e e g5

CORRECT DISPOSAL OF THIS PRODUCT (WASTE ELECTRICAL & ELECTRONIC EQUIPMENT)

(Applicable in the European Union and other European countries with separate collection systems)

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB
cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or
human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to
promote the sustainable reuse of material resources.

Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and
how they can take these items for environmentally safe recycling.

Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic
accessories should not be mixed with other commercial wastes for disposal.
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CORRECT DISPOSAL OF BATTERIES IN THIS PRODUCT

(Applicable in the European Union and other European countries with separate battery return systems.)

This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed with other household
waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium
or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to
human health or the environment.

To protect natural resources and to promote material reuse, please separate batteries from other types of waste and recycle them through your
local, free battery return system.

TAIWAN ONLY
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RADIO FREQUENCY EMISSIONS

FCC Information to the User

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
+ This device may not cause harmful interference, and
* This device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or experienced radio TV technician for help.

'g Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to
operate the equipment.

Canadian Radio Interference Regulations

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par I'Industrie et Sciences Canada.
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UNITED STATES OF AMERICA

Federal Communications Commission (FCC)

Intentional emitter per FCC Part 15

Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be
present (embedded) in your printer system. This section is only applicable if these devices are present. Refer to the system label to verify the
presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the United States of America if an FCC ID number is on the system
label.

The FCC has set a general guideline of 20 cm (8 inches) separation between the device and the body, for use of a wireless device near the
body (this does not include extremities). This device should be used more than 20 cm (8 inches) from the body when wireless devices are on.
The power output of the wireless device (or devices), which may be embedded in your printer, is well below the RF exposure limits as set by
the FCC.

This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.

Operation of this device is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation of the device.

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to
use it. Contact manufacturer for service.

FCC Statement for Wireless LAN use:

A While installing and operating this transmitter and antenna combination the radio frequency exposure limit of 1m W/cm2 may be
exceeded at distances close to the antenna installed. Therefore, the user must maintain a minimum distance of 20cm from the antenna at
all times. This device cannot be colocated with another transmitter and transmitting antenna.

TURKEY ONLY
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GERMANY ONLY

Das Gerat ist nicht fiir die Benutzung am Bildschirmarbeitsplatz gemaR BildscharbV vorgesehen.

FAX BRANDING

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device to send any
message via a telephone facsimile machine unless such message clearly contains in a margin at the top or bottom of each transmitted page or
on the first page of the transmission the following information:

1. the date and time of transmission

2. identification of either business, business entity or individual sending the message; and

3. telephone number of either the sending machine, business, business entity or individual.

The Telephone Company may make changes in its communications facilities, equipment operations or procedures where such action is
reasonably required in the operation of its business and is not inconsistent with the rules and regulations in FCC Part 68. If such changes can
be reasonably expected to render any customer terminal equipment incompatible with telephone company communications facilities, or require
modification or alteration of such terminal equipment, or otherwise materially affect its use or performance, the customer shall be given
adequate notice in writing, to allow the customer an opportunity to maintain uninterrupted service.

RINGER EQUIVALENCE NUMBER

The Ringer Equivalence Number and FCC Registration Number for this machine may be found on the label located on the bottom or rear of the
machine. In some instances you may need to provide these numbers to the telephone company.

The Ringer Equivalence Number (REN) is a measure of the electrical load placed on the telephone line, and is useful for determining whether
you have “overloaded” the line. Installing several types of equipment on the same telephone line may result in problems making and receiving
telephone calls, especially ringing when your line is called. The sum of all Ringer Equivalence Numbers of the equipment on your telephone
line should be less than five in order to assure proper service from the telephone company. In some cases, a sum of five may not be usable on
your line. If any of your telephone equipment is not operating properly, you should immediately remove it from your telephone line, as it may
cause harm to the telephone network.

The equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On the rear of this equipment is a label that
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the
telephone company.

A FCC Regulations state that changes or modifications to this equipment not expressly approved by the manufacturer could void the user’s
authority to operate this equipment. In the event that terminal equipment causes harm to the telephone network, the telephone company
should notify the customer that service may be stopped. However, where prior notice is impractical, the company may temporarily cease
service, providing that they:
a) promptly notify the customer.
b) give the customer an opportunity to correct the equipment problem.

c) inform the customer of the right to bring a complaint to the Federal Communication Commission pursuant to procedures set out in
FCC Rules and Regulations Subpart E of Part 68.

You should also know that:

* Your machine is not designed to be connected to a digital PBX system.

» If you intend to use a computer modem or fax modem on the same phone line as your machine, you may experience transmission and
reception problems with all the equipment. It is recommended that no other equipment, except for a regular telephone, share the line with
your machine.

» If your area experiences a high incidence of lightning or power surges, we recommend that you install surge protectors for both the power
and the telephone lines. Surge protectors can be purchased from your dealer or telephone and electronic specialty stores.

« When programming emergency numbers and/or making test calls to emergency numbers, use a non-emergency number to advise the
emergency service dispatcher of your intentions. The dispatcher will give you further instructions on how to actually test the emergency
number.

» This machine may not be used on coin service or party lines.
» This machine provides magnetic coupling to hearing aids.
You may safely connect this equipment to the telephone network by means of a standard modular jack, USOC RJ-11C.
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REPLACING THE FITTED PLUG (FOR UK ONLY)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until
you have another fuse cover.

Contact the people from you purchased the machine.

The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

A If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

Important warning:

You must earth this machine.

The wires in the mains lead have the following color code:
* Green and Yellow: Earth

* Blue: Neutral

* Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:

You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or
green.

You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

DECLARATION OF CONFORMITY (EUROPEAN COUNTRIES)

3

Approvals and Certifications

The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable
93/68/EEC Directives of the European Union as of the dates indicated:

Hereby, Samsung Electronics declare that this product is in compliance with the essential requirements and other relevant provisions of:
SCX-4623FW Series: R&TTE Directive (1999/5/EC)

The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer (MFP)
name to browse the EuDoC.

January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.

January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic
compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics
Co., Ltd. representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European single terminal connection to the analogue public switched
telephone network (PSTN) in accordance with Directive 1999/5/EC. The product has been designed to work with the national PSTNs and
compatible PBXs of the European countries:

In the event of problems, you should contact the Euro QA Lab of Samsung Electronics Co., Ltd. in the first instance.

The product has been tested against TBR21. To assist in the use and application of terminal equipment which complies with this standard, the
European Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 201 121) which contains notes and additional
requirements to ensure network compatibility of TBR21 terminals. The product has been designed against, and is fully compliant with, all of the
relevant advisory notes contained in this document.
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REGULATORY COMPLIANCE STATEMENTS

Wireless Guidance
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be
present (embedded) in your printer system. The following section is a general overview of considerations while operating a wireless device.

Additional limitations, cautions, and concerns for specific countries are listed in the specific country sections (or country group sections). The
wireless devices in your system are only qualified for use in the countries identified by the Radio Approval Marks on the system rating label. If
the country you will be using the wireless device in, is not listed, contact your local Radio Approval agency for requirements. Wireless devices
are closely regulated and use may not be allowed.

The power output of the wireless device or devices that may be embedded in your printer is well below the RF exposure limits as known at this
time. Because the wireless devices (which may be embedded into your printer) emit less energy than is allowed in radio frequency safety
standards and recommendations, manufacturer believes these devices are safe for use. Regardless of the power levels, care should be taken
to minimize human contact during normal operation.

As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a wireless device near the body
(this does not include extremities) is typical. This device should be used more than 20 cm (8 inches) from the body when wireless devices are
on and transmitting.

This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Some circumstances require restrictions on wireless devices. Examples of common restrictions are listed below:

A

Radio frequency wireless communication can interfere with equipment on commercial aircraft. Current aviation regulations require wireless
devices to be turned off while traveling in an airplane. IEEE 802.11 (also known as wireless Ethernet) and Bluetooth communication devices
are examples of devices that provide wireless communication.

A

In environments where the risk of interference to other devices or services is harmful or perceived as harmful, the option to use a wireless
device may be restricted or eliminated. Airports, Hospitals, and Oxygen or flammable gas laden atmospheres are limited examples where use
of wireless devices may be restricted or eliminated. When in environments where you are uncertain of the sanction to use wireless devices, ask
the applicable authority for authorization prior to use or turning on the wireless device.

A

Every country has different restrictions on the use of wireless devices. Since your system is equipped with a wireless device, when traveling
between countries with your system, check with the local Radio Approval authorities prior to any move or trip for any restrictions on the use of
a wireless device in the destination country.

A

If your system came equipped with an internal embedded wireless device, do not operate the wireless device unless all covers and shields are
in place and the system is fully assembled.

A

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to use it.
Contact manufacturer for service.

A

Only use drivers approved for the country in which the device will be used. See the manufacturer System Restoration Kit, or contact
manufacturer Technical Support for additional information.

OPENSSL LICENSE

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
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documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment: “This product includes
software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without

5. Prior written permission. For written permission, please contact openssl-core@openssl.org.

6. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

7. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the
OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ""AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE

DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND

ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young(eay@cryptsoft.com). This product includes software written by Tim Hudson

(tih@cryptsoft.com).

ORIGINAL SSLEAY LICENSE

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with

Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to

all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this

distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's,
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given
attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation

(online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes
cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic’ can be left out if the rouines from the library
being used are not cryptographic related:-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an
acknowledgement: "This product includes software written by Tim Hudson (tih@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN

NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,

OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF

THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot simply

be copied and put under another distribution licence [including the GNU Public Licence.
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aoout this user's guide

This user’s guide provides information about how to use the machine. Both novice and professional users can refer to this
as a guide for installing and using the machine.

',g * Read the safety information before using the machine.
» If you have a problem using the machine, refer to the troubleshooting chapter (See "Troubleshooting" on page 104).
+ Terms used in this user’s guide are explained in the glossary chapter (See "Glossary" on page 127).
+ Allillustrations in this user's guide may differ from your machine depending on its options or models.
* The procedures in this user’s guide are mainly based on Windows XP.

CONVENTION

Some terms in this guide are used interchangeably, as below:
« Document is synonymous with original.

« Paper is synonymous with media, or print media.

* Machine refers to printer or MFP.

The following table offers the conventions of this guide:

CONVENTION DESCRIPTION EXAMPLE
Bold For texts on the display or button names on the machine. Start
Note Provides additional information or detailed specification of the machine function 'g The date format may differ from country
and feature. to country.
Caution Gives users information to protect the machine from possible mechanical Do not touch the green underside of the
damage or malfunction. toner cartridge.
Footnote Provides additional more detailed information on certain words or a phrase. a. pages per minute

(“Cross-reference”)

Guides users to a reference page for the additional detailed information.

(See Finding more information).
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FINDING MORE INFORMATION

You can find information for setting up and using your machine from the following resources, either as a print-out or on screen.

MATERIAL NAME

DESCRIPTION

Quick Install Guide

This guide provides basic information on setting up your machine.

User’s Guide

<

This guide provides you with step-by-step instructions for using your machine’s full features, and contains information for maintaining
your machine, troubleshooting, and replacing supplies.

Machine Driver Help

This help provides you with help information on printer driver and instructions for setting up the options for printing (See "Using help" on
page 68).

Samsung website

If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website,
www.samsung.com/printer.

Downloadable
software

You can download useful software programs from the Samsung website.

+  SyncThru™ Web Admin Service: convenient for network administrators who need to manage many machines simultaneously. This
program is for network model only. (http://solution.samsungprinter.com)

+ Samsung AnyWeb Print: helps personal users to screen-capture the website screen in Windows Internet Explorer easily.
(http://solution.samsungprinter.com/personal/anywebprint)
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features of your new product

Your new machine is equipped with a number of special features that improve the quality of the documents you print.

SPECIAL FEATURES

DPI

s
U
. b

Print with excellent quality and speed

You can print with a resolution of up to 1200 x 1200 dpi
effective output.

Your machine prints A4-sized paper at up to 22 ppm and
letter-sized paper at up to 23 ppm.

Handle many different types of printable material

Manual tray supports plain paper in various sizes, letterhead,
envelopes, labels, custom-sized media, postcards, and
heavy paper.

The 250-sheet tray supports plain paper.

Create professional documents

Print Watermarks. You can customize your documents with
words, such as “Confidential” (See "Using watermarks" on
page 69).

Print Posters. The text and pictures of each page of your
document are magnified and printed across the sheet of
paper and can then be taped together to form a poster (See
"Printing posters" on page 68).

You can use preprinted forms with plain paper (See"Using
overlay" on page 70).

Save time and money

To save paper, you can print multiple pages on one single
sheet of paper (See "Printing multiple pages on one sheet of
paper" on page 68).

This machine automatically conserves electricity by
substantially reducing power consumption when not in use.
To save paper, you can print on both sides of the paper
(manual) (See "Printing on both sides of paper (Manual)" on
page 69).

Print in various environments

You can print with various operating system such as
Windows, Linux and Macintosh systems (See "System
requirements” on page 32).

Your machine is equipped with a USB interface and a
network interface.

Features of your new product_ 24

Copy originals in several formats

Your machine can copy multiple image copies from the
original document on a single page (See "2-up or 4-up
copying (N-up)" on page 75).

The print quality and image size may be adjusted and
enhance at the same time.

Scan the originals and send it right away

Scan in color and use the precise compressions of JPEG,
TIFF and PDF formats.

Quickly scan and send files to multiple destinations using
Networks scanning (See "For network connected machine"
on page 77).

Set a specific time to transmit a Fax

You can specify a certain time to transmit the fax and also
send the fax to several stored destinations.

After the transmission, the machine may print out the fax
reports according to the setting.

IPvé
This machine supports IPv6.



FEATURES BY MODELS

The machine is designed to support all of your document needs from printing and copying to more advanced networking solutions for your business.
Some features and optional goods may not be available depending on models or countries.
Features by models include:

FEATURES SCX-4623FW(K)

Print .
Duplex (2-sided) printing (manual) °
Copy °
FAX °
Network PC fax °
Fax to PC (Samsung Scan & Fax Manager) °
On hook dial °
USB 2.0 °
Network Interface Ethernet 10/100 Base TX °
wired LAN

Network Interface 802.11b/g wireeless LAN °
IPv6 °
SyncThru™ Web Service °
Document Feeder .

( ®: Included, o: Optional, Blank: Not available)
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Ntroduction

This chapter gives you an overview of your machine:

This chapter includes:

* Machine overview

« Control panel overview

« Understanding the LED

« Introducing the useful buttons
« Turning on the machine

MACHINE OVERVIEW

Front view

This illustration may differ from your machine depending on its model.

@ Document feeder cover @ Front door handle @ Document output tray Scanner glass
Document feeder width .

@ guides Handle @ Control panel Scan unit

@ Document feeder input tray Tray 1 @ Toner cartridge Scan unit close button?

@ Document feeder output tray @ Manual tray gﬂjggsl tray paper width

@ Output support Front door @ Scanner lid

a.This button is used when you close the scan unit.
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Rear view

This illustration may differ from your machine depending on its model.

Extension telephone socket
(EXT)

@ Network port @ Power receptacle
@ USB port @ Rear door
@ Telephone line socket Rear door handle
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CONTROL PANEL OVERVIEW

This control panel may differ from your machine depending on its model.

©§

@ ®

3
8
e ©F

© @@

HE @O

You can copy both sides of an ID Card such as a driver’s license to a single side of paper (See "ID card copying" on

ID Copy page 75).

WPS If your wireless access point supports Wi-Fi Protected Setup™(WPS), you can configure the machine easily without a
compurter (See "Using a wireless network with WPS button on the control panel" on page 43).

Display Shows the current status and prompts during an operation.

. Shows the status of wireless network. When the LED on, the machine is connected wirelessly (See "Wireless LED" on

Wireless
page 29).

Status Shows the status of your machine (See "Understanding the LED" on page 29).

s (Fax)

Activates fax mode.

(Copy) Activates copy mode.

@ (Scan) Activates scan mode.

Arrow Scroll through the options available in the selected menu, and increase or decrease values.

Menu Enters Menu mode and scrolls through the available menus (See "Machine status and advanced feature" on page 91).
OK Confirms the selection on the screen.

Back Sends you back to the upper menu level.

Numeric keypad

Dials fax number, and enters the number value for document copies or other options.

Address Book

Allows you to store frequently used fax numbers or search for stored fax numbers.

Redial/Pause

In standby mode, redials the last number. Also in edit mode, inserts a pause into a fax number.

@EFEERRRREEEU® YWD WM G

On Hook Dial Enables you to dial a number with the receiver on the hook.

Start Starts a job.

Stop/Clear Stops an operation at any time. The pop-up window appears on the screen showing the current job that the user can stop or
resume.

Power You can turn the power on and off (See "Power button" on page 29).
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UNDERSTANDING THE LED
Status LED

The color of the status LED indicates the machine's current status.

STATUS DESCRIPTION

Off * The machine is off-line.

* The machine is in power saver mode. When
data is received, or any button is pressed, it
switches to on-line automatically.

Green | Blinking * When the backlight slowly blinks, the machine
is receiving data from the computer.

*  When the backlight blinks rapidly, the
machine is printing data.

On The machine is on-line and can be used.

Red Blinking * A minor error has occurred and the machine is
waiting for the error to be cleared. Check the
display message. When the problem is
cleared, the machine resumes.

» Small amount of toner is left in the cartridge.
The estimated cartridge life? of toner is close.
Prepare a new cartridge for replacement. You
may temporarily increase the printing quality
by redistributing the toner. (See
"Redistributing toner" on page 104.)

On » Atoner cartridge has almost reached the end
of its estimated cartridge life®. It is
recommended to replace the toner cartridge
(See "Replacing the toner cartridge" on
page 120).

* A paper jam has occurred (See "Clearing
paper jams" on page 106).

» The cover is opened. Close the cover.

» There is no paper in the tray. Load paper in
the tray.

* The machine has stopped due to a major
error. Check the display message (See
"Understanding display messages" on
page 108).

a.Estimated cartridge life means the expected or estimated toner
cartridge life, which indicates the average capacity of print-outs and is
designed pursuant to ISO/IEC 19752. The number of pages may be
affected by operating environment, printing interval, media type, and
media size. Some amount of toner may remain in the cartridge even
when End of life Replace new cart appears and the printer stops
printing. (See www.samsung.com/printer for current information.)

A Samsung does not recommend using a non-genuine Samsung toner

cartridge such as one that is refilled or remanufactured. Samsung
cannot guarantee a non-genuine Samsung toner cartridge's quality.
Service or repair required as a result of using non-genuine Samsung
toner cartridges will not be covered under the machine warranty.

w » Check the message on the display. Follow the instructions in the
message or refer to troubleshooting part (See "Understanding
display messages" on page 108). If the problem persists, call for
service.

« Al printing errors will be appear in the Smart Panel program
window. If the problem persists, call for service.

Wireless LED

WIRELESS LED STATUS DESCRIPTION

Blue Off (_v_) The machine failed to connect to a
wireless network.
On () Wireless network is connected.
Slowly blinks The machine starts connecting to a
(=) wireless network.
Fast blinks » The machine is connecting to

(==) access point (or wireless router).
* Wireless network connection is
being disconnected.

INTRODUCING THE USEFUL BUTTONS

Menu button

When you want to know the machine status and set your machine to use an
advanced feature, click the Menu button (See "Machine status and
advanced feature" on page 91).

Print screen button

Supported optional devices and features may differ according to your
model. Please check your model name.
(See "Features by Models" on page 25).

Press the Print Screen button:

MESSAGE DESCRIPTION
Active The machine prints the active screen displayed on the
monitor.
Full The machine prints the whole screen displayed on the
monitor.

',g « The page will be printed on the default page like A4, Letter.
* You can only use this function with a USB-connect machine.
« Print Screen can only be used with Windows and Mac OS.
* You can only use this function if the machine driver is installed.

WPS button

A
@ (CLP-325W(K) only.)

This feature automatically detects which mode your access point uses,
Wi-Fi Protected Setup™(WPS). By pushing a button on the wireless LAN
router / access point and the machine, you can setup the wireless network
and security settings (See "Using a wireless network with WPS button on
the control panel” on page 43).

Power button

When you want to turn the power off, press this button until Power Down
appear. Choose Yes, to turn the power off. This button can also be used to
turn the machine on.
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STATUS

DESCRIPTION

Off

* The machine is in ready mode.
* The machine’s power is off.

On

The machine is in power save mode.

TURNING ON THE MACHINE

Plug in the power cord, the machine will be turned on.

',g If you want to turn the power off, press the Power button until Power

Down appear on the display.
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getting startec

This chapter gives you step-by-step instructions for setting up the USB connected machine and software.

This chapter includes:

« Setting up the hardware
« Supplied software
« System requirements

SETTING UP THE HARDWARE

This section shows the steps to set up the hardware, as is explained in the
Quick Install Guide. Make sure you read the Quick Install Guide first and
follow the steps below:
1. Select a stable location.
Select a level, stable place with adequate space for air circulation. Allow
extra space to open covers and trays.
The area should be well ventilated and away from direct sunlight or
sources of heat, cold, and humidity. Do not set the machine close to the
edge of your desk or table.

A

00 mm
3.9in)

A 4
100 mm 100 mm
> <P
(3.91in) (3.91n)

Printing is suitable for altitudes under 1,000 m (3,281 ft.). Refer to the
altitude setting to optimize your printing (See "Altitude adjustment” on
page 55).

Place the machine on a flat, stable surface so that there is no incline

greater than 2 mm (0.08 inch). Otherwise, printing quality may be

482.6 mm (18.8in.)

affected.
omm == = T 2mm
0.08in) f& .- i S J1 (.08

2. Unpack the machine and check all the enclosed items.
3. Remove all tape.

Installing USB connected machine’s driver
« Sharing your machine locally

Install the toner cartridge.

Load paper (See "Loading paper in the tray" on page 61).
Make sure that all cables are connected to the machine.
Turn the machine on.

A This equipment will be inoperable when mains power fails.

No oM

SUPPLIED SOFTWARE

After you have set up your machine and connected it to your computer. You
must install the machine software. If you are a Windows, Macintosh OS
user, install the software from the supplied CD and if you are a Linux OS
user, download the software from the Samsung website
(www.samsung.com/printer) and install.

',g Machine software are occasionally updated due to release of new
operating system and etc. If needed, download the latest version from
the Samsung website (www.samsung.com/printer).
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CONTENTS

Windows

Printer driver: Use this driver to take full advantage of
your machine’s features.

Scanner driver: TWAIN and Windows Image
Acquisition (WIA) drivers are available for scanning
documents on your machine.

Smart Panel: This program allows you to monitor the
machine’s status and alerts you when an error occurs
during printing.

SmarThru®: This program is the accompanying
Windows-based software for your multifunctional
machine.

Samsung Scan and Fax Manager: You can find out
about Scan & Fax Manager program information and
installed scan driver's condition.

SetIP: Use this program to set your machine’s TCP/IP
addresses.

Macintosh

Printer driver: Use this driver to take full advantage of
your machine’s features.

Scanner driver: TWAIN driver is available for
scanning documents on your machine.

Smart Panel: This program allows you to monitor the
machine’s status and alerts you when an error occurs
during printing.

Samsung Scan and Fax Manager: You can find out
about Scan & Fax Manager program information and

installed scan driver's condition.

+ SetlP: Use this program to set your machine’s TCP/IP
addresses.

REQUIREMENT (RECOMMENDED)
OPERATING
SYSTEM FREE HDD
CPU RAM SPACE
Windows 2000® | Intel® Pentium® Il 400 64 MB 600 MB
MHz (Pentium 111 933 (128 MB)
MHz)
Windows XP® Intel® Pentium® I11 933 128 MB 1.5 GB
MHz (Pentium IV 1 GHz) | (256 MB)
Windows Intel® Pentium® Il 933 128 MB 1.25GB to
Server® 2003 MHz (Pentium IV 1 GHz) | (512 MB) 2GB
Windows Intel® Pentium® IV 1 GHz | 512 MB 10 GB
Server® 2008 (Pentium IV 2 GHz) (2048 MB)
Windows Intel® Pentium® IV 3 GHz | 512 MB 15 GB
Vista® (1024 MB)
Windows® 7 Intel® Pentium® IV 1 GHz | 1 GB (2 16 GB
32-bit or 64-bit processor | GB)
or higher
« Support for DirectX® 9 graphics with 128 MB memory
(to enable the Aero theme).
+ DVD-R/W Drive
Windows Intel® Pentium® IV 1 GHz | 512 MB 10 GB
Server® 2008 (x86) or 1.4 GHz (x64) (2048 MB)
R2 processors (2 GHz or
faster)

Unified Linux Driver: Use this driver to take full

advantage of your machine’s features.

*  SANE: Use this driver to scan documents.

* Smart Panel: This program allows you to monitor the
machine’s status and alerts you when an error occurs
during printing.

» SetIP: Use this program to set your machine’s TCP/IP

addresses.

Linux .

w .

Internet Explorer® 5.0 or higher is the minimum requirement for all
Windows operating systems.

« Administrator rights are required to install the software.
*  Windows Terminal Services is compatible with this machine.

a.Allows you to edit a scanned image in various ways using a powerful
image editor and to send the image by email. You can also open
another image editor program, such as Adobe Photoshop, from
SmarThru. For details, refer to the on screen help supplied on the
SmarThru program (See "Smarthru" on page 97).

SYSTEM REQUIREMENTS

Before you begin, ensure that your system meets the following
requirements:

Microsoft® Windows®

Your machine supports the following Windows operating systems.

Macintosh
REQUIREMENTS (RECOMMENDED)
OPERATING
SYSTEM FREE HDD
CPU RAM SPACE
Mac OS X * Intel *« 128 MB for a 1GB
10.3~10.4 Processors PowerPC based
+  PowerPC G4/ Mac (512 MB)
G5 « 512 MB for a
Intel-based Mac
(1 GB)
Mac OS X * Intel 512 MB (1 GB) 1GB
10.5 Processors
* 867 MHz or
faster Power
PC G4/ G5
Mac OS X * Intel 1 GB (2 GB) 1GB
10.6 Processors
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Linux

ITEM REQUIREMENT (RECOMMENDED)
Operating RedHat® Enterprise Linux WS 4, 5 (32/64 bit)
system Fedora Core 2~10 (32/64 bit)

SuSE Linux 9.1 (32 bit)

OpenSuSE® 9.2, 9.3, 10.0, 10.1, 10.2, 10.3, 11.0,
11.1 (32/64 bit)

Mandrake 10.0, 10.1 (32/64 bit)

Mandriva 2005, 2006, 2007, 2008, 2009 (32/64 bit)
Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04, 8.10 (32/64 bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64 bit)
Debian 3.1, 4.0, 5.0 (32/64 bit)

CPU Pentium IV 2.4 GHz (Intel Core™2)

RAM 512 MB (1024 MB)

Free HDD space | 1 GB (2 GB)

',g » Itis necessary to claim swap partition of 300 MB or larger for
working with large scanned images.

* The Linux scanner driver supports the optical resolution at
maximum.

INSTALLING USB CONNECTED MACHINE’S
DRIVER

A locally connected machine is a machine directly attached to your

computer using the USB cable. If your machine is attached to a network,

skip the following steps below and go on to installing network connected

machine’s driver (See "Installing wired network connected machine’s driver"

on page 39).

'g . Sele(l:lting Custom installation allows you to choose programs to
install.

* Only use an USB cable no longer then 3 m (10 ft.).

Windows
You can install the machine software using the typical or custom method.

The following steps below are recommended for most users who use a
machine directly connected to your computer. All components necessary for
machine operations will be installed.

1. Make sure that the machine is connected to your computer and powered
on.

'g If the “Found New Hardware Wizard” window appears during the
installation procedure, click Cancel to close the window.

2. Insert the supplied software CD into your CD-ROM drive.

* The software CD should automatically run and an installation window
appears.

» If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents
your drive. Click OK.

» If you use Windows Vista, Windows 7 and Windows 2008 Server R2
click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter which represents
your drive and click OK.

» If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the

User Account Control windows.

+ If the AutoPlay window appears in Windows 7 and Windows 2008
Server R2, click Run Setup.exe in Install or run program field, and
click Yes in the User Account Control windows.

3. Select Install Now.
° =)

s

.3 Install Now &

" ‘Wesless Settr and instalston B

17| venusers Gude &

€ rrvancesinmtven

Instalstion LANDIMR:  Engloh v [._.‘i‘:l
If necessary, select a language from the drop-down list.

',g * The Wireless Setting and Installation allows you to install a
wireless network to connect to the machine with USB cable.
(See "Setting a wireless network with USB cable" on page 46.)

* The Advanced Installation has two options, Custom
Installation and Install Software Only. The Custom
Installation allows you to select the machine’s connection and
choose individual component to install. The Install Software
Only allows you to install the supplied softwares, such as
Smart Panel. Follow the guide on the window.
4. Read License Agreement, and select | accept the terms of the
License Agreement. Then, click Next.

BIX
R—
PR | iconse Agreement
+ 7. cenee Agrecesent Flnssn read the Lianse Aymemere.
Uceroe Langusge: | trateh. v
[0 USER LICENSE AGREEMENT FOR SAMSUNG ELECTROMCS SOFTWARE 3
w

poRTANT. n(_w AREFULLY: Ths Samaung Edctionics End-User Licante Agrasmant
(EV o

k LEC e product My inchede atsociated toftwane
(tv"owll MeSs, prrted matensls and “onkne’ of elCtrond SoCUMEntson developed
{und prowsed by SAMSUNG ELECTRONCS ("SOFTWARE PRODUCT") Far ol other third
fparty software products which may be suppled wih o for the SAMSUNG devices, your wre
fef such software products shall be subject fo separate terms of use and end user icense
| areaments of vuch thie paries By etaling, copying, domriowdng or uses the

ARE PROCUCT, you agres 10 be bound by the ems of this EULA, ¥ you do not
{570 19 the teems ofthis EULA, yoo may nat et or wse fhe SOFTWARE PRODUCT

. GRANT OF LICENSE.
‘h- SOFTWARE PRODUCT is Banted, not 1043 Subject 10 the condtion thit you e i

700 oK e o the Licern Ay panart

T | e e

The program searches the machine.
w If your machine is not found in the network or locally, the following
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window will appear.
Bx

Printers Not Found
Pome corviy read e notxe sl seerch resits

oy rtrh o
Sk “Sewrch agan” o Twect ot for mestance to frd o prrter

N 7 U Catie P e Oucorrected [rom you CGngLter, (1 S50 STEVert 000 from detectrs any
srrtens o O T far

()00 € s ek 1o ket o e sl i, tbend corvection of the griker

wton [ owaver | e )

* Check if you want to install the software without
connecting the printer to the network or locally.

- Check this option to install this program without a machine
connected. In this case, the print a test page window will be
skipped, and completes the installation.

+ Search again

When you press this button, the firewall notice window

appears.

- Turn off the firewall and Search again. For Window
operating system, click Start > Control Panel > Windows
Firewall, and inactivate this option. For other operating
system, refer to its on-line guide.

- Turn off the firewall from the third party's program beside
the operating system. Refer to the manual provided by
individual programs.

« Direct Input

The Direct Input allows you to search a specific machine on

the network.

- Search by IP address: Enter the IP address or the host
name. Then click Next.

To verify your machine’s IP address, print a network
configuration report (See "Printing a machine report" on
page 72).

- Search by network path: To find a shared machine (UNC
Path), enter the shared name manually or find a shared
printer by clicking the Browse button. Then click Next.

¢ Help

If your machine is not connected to the computer or network,

This help button gives detailed information about the how to

connect the machine.

. The searched machines will be shown on the screen. Select the one you
wish to use and click Next.

w If the driver searched only one machine, the confirmation window
appears.

. After the installation is finished, a window asking you to print a test page
appears. If you want to print a test page, click Print a test page.

Otherwise, just click Next and skip to step 8.
. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

. To register as a user of the machine in order to receive information from
Samsung, click On-line Registration.

w If your machine is not already connected to the network or
computer, click How to connect?. How to connect? gives
detailed information about the how to connect the machine. Follow
the instructions in the window.

9. Click Finish.
'g If the printer driver does not work properly, follow the steps below to
repair or reinstall the driver.
a) Make sure that the machine is connected to your machine and
powered on.

b) From the Start menu, select Programs or All Programs >
Samsung Printers > your printer driver name > Maintenance.

c) Select the option as you wish, follow the instruction on the window.

Macintosh

The software CD that came with your machine provides you with the Driver
files that allows you to use the CUPS driver or PostScript driver (only
available when you use a machine which supports the PostScript driver) for
printing on a Macintosh computer.

Also, it provides you with the TWAIN driver for scanning on a Macintosh

computer.

1. Make sure that the machine is connected to your computer and powered

on.

Insert the supplied software CD into your CD-ROM drive.

Double-click the CD-ROM icon that appears on your Macintosh desktop.

Double-click the MAC_lInstaller folder.

Double-click the Installer OS X icon.

Enter the password and click OK.

The Samsung Installer window opens. Click Continue.

Read the license agreement and click Continue.

Click Agree to agree to the license agreement.

0. Select Easy Install and click Install. Easy Install is recommended for
most users. All components necessary for machine operations will be
installed.

If you select Custom Install, you can choose individual components to
install.

11. When the message which warns that all applications will close on your

computer appears, click Continue.

2o NOUA®N

',g If a window asking you to select an installation type appears,
select Typical installation for a local printer and then click OK.

12. After the installation is finished, click Quit.
w If you have installed scan driver, click Restart.

13. Open the Applications folder > Utilities > Print Setup Utility.
*  For Mac OS X 10.5 ~ 10.6, open the Applications folder > System
Preferences and click Print & Fax.
14. Click Add on the Printer List.
* ForMac OS X 10.5 ~ 10.6, press the “+” icon; a display window will
pop up.
15. For Mac OS X 10.3, select the USB tab.
¢ For Mac OS X10.4, click Default Browser and find the USB
connection.
*  For Mac OS X 10.5 ~ 10.6, click Default and find the USB
connection.
16. For Mac OS X 10.3, if Auto Select does not work properly, select
Samsung in Printer Model and your machine name in Model Name.
*  For Mac OS X 10.4, if Auto Select does not work properly, select
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Samsung in Print Using and your machine name in Model. 6. When the welcome screen appears, click Next.

* ForMac OS X 10.5 ~ 10.6, if Auto Select does not work properly,
select Select a driver to use... and your machine name in Print

Unified Linux Driver installer x

Using.
Your machine appears on the Printer List, and is set as the default
machine.
17. Click Add. q\ mmn:ummnnm-r
instaliation wizard!
'g If the printer driver does not work properly, uninstall the driver and -\
reinstall it. Thiis program will install all necessary software

for printers and MFP devices.

Follow steps below to uninstall the driver for Macintosh. Click Next i coninue with tha Setup program

L

a) Make sure that the machine is connected to your computer and 5

powered on.
b) Insert the supplied software CD into your CD-ROM drive. _— =
c) Double-click CD-ROM icon that appears on your Macintosh - = -

desktop. top | cpsck | | met> | genoat |
d) Double-click the MAC_Installer folder.
e) Double-click the Installer OS X icon.
f) Enter the password and click OK.

-~

\

®

7. When the installation is complete, click Finish.
The installation program has added the Unified Driver Configurator
desktop icon and the Unified Driver group to the system menu for your

g) The Samsung Installer window opens. Click Continue. convenience. If you have any difficulties, consult the on screen help that
h) Select Uninstall and click Uninstall. is available through your system menu or can otherwise be called from
i) When the message which warns that all applications will close on the driver package Windows applications, such as Unified Driver

your computer appears, click Continue. Configurator or Image Manager.

j)  When the uninstall is done, click Quit. Installing the Smart Panel

Linux 1. Make sure that the machine is connected to your computer and
Y dtod load Li ft ki f the S bsit powered on.
ou need to download Linux software packages from the Samsung website 2. When the Administrator Login window appears, fype in root in the

to install the printer software.

Login field and enter the system password.
Follow the steps below to install the software. 9 Y P

You must log in as a super user (root) to install the machine

Installing the Unified Linux Driver software. If you are not a super user, ask your system

1. Make sure that the machine is connected to your computer and administrator.
powered on. . . . . 3. From the Samsung website, download the Smart Panel package to
2. When the Administrator Login window appears, type in root in the your computer.
Login field and enter the system password. 4. Right click the Smart Panel package and extract the package.
You must log in as a super user (root) to install the machine 5. Double click cdroot > Linux > smartpanel > install.sh.
software. If you are not a super user, ask your system . . i .
administrator. Installing the Printer Settings Utility
3. From the Samsung website, download the Unified Linux Driver 1. gﬂoﬁzrzgrgr:hat the machine is connected to your computer and

package to your computer.
4. Right click the Unified Linux Driver package and extract the
package.
5. Double click cdroot > autorun. 'Q You must log in as a super user (root) to install the machine
software. If you are not a super user, ask your system
administrator.

2. When the Administrator Login window appears, type in root in the
Login field and enter the system password.

3. From the Samsung website, download the Printer Settings Utility
package to your computer.
4. Right click the Printer Settings Utility package and extract the
package.
5. Double click cdroot > Linux > psu > install.sh.
w If Fhe prir_1ter driver does not work properly, uninstall the driver and
reinstall it.
Follow the steps below steps to uninstall the driver for Linux.
a) Make sure that the machine is connected to your computer and
powered on.

b) When the Administrator Login window appears, type in “root
in the Login field and enter the system password.
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You must log in as a super user (root) to uninstall the printer
driver. If you are not a super user, ask your system
administrator.

c) Click the icon at the bottom of the desktop. When the Terminal
screen appears, type in:
[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

d) Click Uninstall.

e) Click Next.

f) Click Finish.

SHARING YOUR MACHINE LOCALLY

Follow the steps below to set up the computers to share your machine
locally.

If the Host computer is directly connected to the machine with a USB cable
and is also connected to the local network environment, the client computer
connected to the local network can use the shared machine through the
host computer to print.

N |

0 c
&
!
!

@

Host computer A computer which is directly connected to

the machine by USB cable.

®

Client computers | Computers which use the machine shared

through the host computer.

Windows

Setting up a host computer

1.

2.
3.

N

Install your printer driver (See "Installing USB connected machine’s
driver" on page 33).

Click the Windows Start menu.

For Windows 2000, select Settings > Printers.

* For Windows XP/2003, select Printers and Faxes.

* For Windows 2008/Vista, select Control Panel > Hardware and
Sound > Printers.

* For Windows 7, select Control Panel > Hardware and Sound >
Devices and Printers.

« For Windows Server 2008 R2, select Control Panel > Hardware
> Devices and Printers.

Right click your printer icon.

For Windows XP/2003/2008/Vista, press Properties.

For Windows 7 and Windows Server 2008 R2, from context menus,
select the Printer properties.

(g If Printer properties item has » mark, you can select other
printer drivers connected with selected printer.

Select the Sharing tab.
Check the Change Sharing Options.
Check the Share this printer.

9.

Fill in the Share Name field. Click OK.

Setting up a client computer

1. Install your printer driver (See "Installing USB connected machine’s
driver" on page 33).

2. Click the Windows Start menu.

3. Select All programs > Accessories > Windows Explorer.

4. Enterin IP address of the host computer and press Enter in your
keyboard.
|h 1, & w
[,g In case host computer requires User name and Password, fill

in User ID and password of the host computer account.

5. Right click the printer icon you want to share and select Connect.

6. If a set up complete message appears, click OK.

7. Open the file you want to print and start printing.

Macintosh

14

The following steps are for Mac OS X 10.5 ~ 10.6. Refer to Mac Help
for other OS versions.

Setting up a host computer

1.
2.

3.
4.

Install your printer driver (See "Macintosh" on page 34).

Open the Applications folder > System Preferences and click
Print & Fax.

Select the printer to share in the Printers list.
Select Share this printer.

Setting up a client computer

1.
2.

3.
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Install your printer driver (See "Macintosh" on page 34).

Open the Applications folder > System Preferences and click
Print & Fax.

Press the “+” icon.
A display window showing the name of your shared printer appears.
Select your machine and click Add.



NEtWOork setup

This chapter gives you step-by-step instructions for setting up the network connected machine and software.

This chapter includes:

* Network environment
* Introducing useful network programs
« Using a wired network

Supported optional devices and features may differ according to your
model. Please check your model name.

(See "Features by Models" on page 25).

NETWORK ENVIRONMENT

You need to set up the network protocols on the machine to use it as your
network machine. You can set up the basic network settings through the
machine's control panel.

The following table shows the network environments supported by the
machine:

ITEM REQUIREMENTS

Network interface » Ethernet 10/100 Base-TX

Network operating system |+« Windows
2000/XP/2003/2008/Vista/7/2008
Server R2

* Various Linux OS

*+ Mac OS X10.3~10.6

Network protocols + TCP/IP
+ DHCP, BOOTP
» DNS, WINS, Bonjour, SLP, UPnP

» Standard TCP/IP Printing(RAW), LPR,
IPP

*  SNMPv 1/2/3, HTTP(S), IPSec

+ TCP/IPv6 (DHCP, DNS, RAW, LPR,
SNMPv 1/2/3, HTTP(S), IPSec)

(See "IPv6 Configuration" on page 41).

INTRODUCING USEFUL NETWORK PROGRAMS

There are several programs available to setup the network settings easily in
network environment. For the network administrator especially, managing
several machines on the network is possible.

[,g Before using the programs below, set the IP address first.
SyncThru™ Web Service

Web server embedded on your network machine, which allows you to:

« Configure the network parameters necessary for the machine to connect
to various network environments.

« Customize machine settings.
(See "Using SyncThru™ Web Service" on page 96).

» Installing wired network connected machine’s driver
« IPv6 Configuration

SyncThru™ Web Admin Service

Web-based machine management solution for network administrators.
SyncThru™ Web Admin Service provides you with an efficient way of
managing network devices and lets you remotely monitor and troubleshoot
network machines from any site with corporate internet access. Download
this program from http://solution.samsungprinter.com.

SetlP

This utility program allows you to select a network interface and manually
configure the IP addresses for use with the TCP/IP protocol (See "IPv4
setting using SetlP Program (Windows)" on page 38 or "IPv4 setting using
SetlP Program (Macintosh)" on page 38).

@ TCP/IPv6 is not supported by this program.

USING A WIRED NETWORK

You must set up the network protocols on your machine to use it on your
network. This chapter will show you how this is easily accomplished.
You can use network after connecting network cable to a corresponding
port on your machine.

[N

4 o o o

Printing Network Configuration report

You can print a Network Configuration Report from the machine’s control
panel that will show the current machine’s network settings. This will help
you to set up a network and troubleshoot problems.

1. Press Menu on the control panel.

2. Press the left/right arrow until Network appears and press OK.

3. Press the left/right arrow until Network Info. appears and press OK.

4. Press the left/right arrow until Yes appears and press OK.

Using this Network Configuration Report, you can find your machine MAC
address and IP address.

For example:
*  MAC Address:00:15:99:41:A2:78
* IP Address:192.0.0.192

.
d
.
d
.
| o
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Setting IP address

First, you have to set up an IP address for network printing and
managements. In most cases a new IP address will be automatically
assigned by a DHCP (Dynamic Host Configuration Protocol) server located
on the network.

In a few situations the IP address must be set manually. This is called a
static IP and is often required in corporate Intranets for security reasons.

DHCP IP assignment: Connect your machine to the network, and wait a
few minutes for the DHCP server to assign an IP address to the
machine. Then, print the Network Configuration Report as explained
above. If the report shows that the IP address has changed, the
assignment was successful. You will see the new IP address in the
report.

Static IP assignment: Use SetIP program to change the IP address
from your computer. If your machine has a control panel, you can also
change IP address using the machine's control panel.

In an office environment, we recommend that you contact a network
administrator to set this address for you.

IP setting using control panel
Connect your machine to the network with a network cable.
Turn on the machine.
Press Menu on the control panel.
Press the left/right arrow until Network appears and press OK.
Press the left/right arrow until TCP/IP (IPv4) appears and press OK.
Press the left/right arrow until Static appears and press OK.
Press the left/right arrow until IP Address appears and press OK.
Enter the IP address using numeric keypad and press OK.
(g Enter a byte between 0 and 255 using the number keypad and
press the left/right arrow to move between bytes.
Repeat this to complete the address from the 1st byte to the
4th byte.
9. Enter other parameters, such as the Subnet Mask and Gateway
appears and press OK.
10. After entering all parameters, press Stop/Clear to return to ready
mode.
Now go to "Installing wired network connected machine’s driver" on
page 39.

©ONoGahA~WN=

IPv4 setting using SetlP Program (Windows)

This program is for manually setting the network IP address of your
machine using its MAC address to communicate with the machine. A
MAC address is the hardware serial number of the network interface and
can be found in the Network Configuration Report.

For using SetIP program, disable the computer firewall before continuing
by performing the following:

1. Open Control Panel.

2. Double click Security Center.
3. Click Windows Firewall.

4. Disable the firewall.

Installing the program

1. Insert the Printer Software CD-ROM provided with your machine.
When the driver CD runs automatically, close that window.

2. Start Windows Explorer and open the X drive (X represents your
CD-ROM drive).

3. Double-click Application > SetIP.
4. Double-click Setup.exe to install this program.

5. Select a language, then click Next.
6. Follow the instructions in the window and complete the installation.

Starting the program

1. Connect your machine to the network with a network cable.

2. Turn on the machine.

3. From the Windows Start menu, select All Programs > Samsung
Printers > SetIP > SetIP.

4. Click on the ﬁ icon (third from left) in the SetlP window to open the
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window
as follows. In a corporate intranet, you may need to have this
information assigned by a network manager before proceeding.

TER/IP Canfiguration

TCRAP |
Mat Address !
IP Addrazs * P
Subnet Magk e ——
Dedault Gateway : T
Apply Cancal Hasel

* MAC Address: Find the machine’s MAC address from the
Network Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

« [P Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150,
enter 192.168.1.X (X is number between 1 and 254 other than
the computer’'s address).

« Subnet Mask: Enter a Subnet Mask.
« Default Gateway: Enter a Default Gateway.

6. Click Apply, and then click OK. The machine will automatically print
the Network Configuration Report. Confirm that all the settings are
correct.

7. Click Exit to close the SetlP program.
8. If necessary, restart the computer’s firewall.

IPv4 setting using SetlP Program (Macintosh)
For using SetIP program, disable the computer firewall before continuing
by performing the following:

The path and Uls may differ by Mac OS version. Refer to the Mac
OS manual to turn firewall off.

Open System Preferences.
Click Security.

Click the Firewall menu.
Turn firewall off.

PN~

w The following instructions may vary for your model.

1. Connect your machine to the network with a network cable.

2. Insert the Installation CD-ROM, and open the disk window, select
MAC_Installer > MAC_Printer > SetIP > SetlPapplet.html.
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3. Double click the file and Safari will automatically open, then select
Trust. The browser will open the SetlPapplet.html page that shows
the printer's name and IP address information.

4. Clickonthe ﬁ icon (third from left) in the SetlP window to open the
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window
as follows. In a corporate intranet, you may need to have this
information assigned by a network manager before proceeding.

*  MAC Address: Find the machine’s MAC address from the
Network Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

« IP Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150,
enter 192.168.1.X (X is number between 1 and 254 other than
the computer’s address).

* Subnet Mask: Enter a Subnet Mask.

« Default Gateway: Enter a Default Gateway.

6. Select Apply, then OK, and OK again. The printer will automatically
print the configuration report. Confirm that all the settings are correct.
Quit Safari. You may close and eject the installation CD-ROM. If
necessary, restart the computer’s firewall. You have successfully
changed the IP address, subnet mask, and gateway.

IPv4 setting using SetIP Program (Linux)
SetlP program should be automatically installed during the printer driver
installation.

w The path and Uls may differ by Linux OS version. Refer to the
Linux OS manual to turn firewall off.

1. Print the machine’s network configuration report to find your
machine’s MAC address.

Open the /opt/Samsung/mfp/share/utils/.

Double click the SetlPApplet.html file.

Click to open the TCP/IP configuration window.

Enter the network card’s MAC address, IP address, subnet mask,
default gateway, and then click Apply.

When you enter the MAC address, enter it without a colon(:).

o pON

6. The machine prints the network information. Confirm all the settings
are correct.

7. Close the SetlP program.

Network parameter setting

You can also set up the various network settings through the network
administration programs such as SyncThru™ Web Admin Service and
SyncThru™ Web Service.

Restoring factory default settings

You may need to reset the machine to the factory default settings when
machine that you are using is connected to new network environment.

Restoring factory default settings using control panel
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appears and press OK.

3. Press the left/right arrow until Clear Settings appears and press
OK.

4. Turn off and restart machine to apply settings.

Restoring factory default settings using SyncThru™
Web Service

1. Start a web browser such as Internet Explorer, Safari or Firefox and
enter your machine’s new IP address in the browser window.

For example,

(€] http://192,168,1,133/

2. When the SyncThru™ Web Service window opens, click Network
Settings.
3. Click Reset. Then, click Clear for network.
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4. Turn off and restart machine to apply settings.

INSTALLING WIRED NETWORK CONNECTED
MACHINE’S DRIVER

Windows

You can set up the machine driver, follow the steps below.

This is recommended for most users. All components necessary for

machine operations will be installed.

1. Make sure that the machine is connected to the network or USB and
powered on.

2. Insert the supplied software CD into your CD-ROM drive.

* The software CD should automatically run and an installation window
appear.

» If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents
your drive. Click OK.

» If you use Windows Vista, Windows 7 and Windows 2008 Server R2
click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter which represents
your drive and click OK.

» If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the
User Account Control windows.

» If the AutoPlay window appears in Windows 7 and Windows 2008
Server R2, click Run Setup.exe in Install or run program field, and
click Yes in the User Account Control windows.
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3. Select Install Now.
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If necessary, select a language from the drop-down list.

'Q The Advanced Installation has two options, Custom Installation
and Install Software Only. The Custom Installation allows you to
select the machine’s connection and choose individual component
to install. The Install Software Only allows you to install the
supplied software, such as Smart Panel. Follow the instruction on
the window.

4. Read License Agreement, and select | accept the terms of the

License Agreement. Then, click Next.
The program searches the machine.

’Q If your machine is not found in the network or locally, the error
message appears.
* Check if you want to install the software without
connecting the printer to the network or locally.

- Check this option to install this program without a machine
connected. In this case, the print a test page window will be
skipped, and completes the installation.

» Search again

When you press this button, the firewall notice window

appears;

- Turn off the firewall and Search again. For Windows
operating system, click Start > Control Panel > Windows
Firewall, and inactivate this option.

- Turn off the firewall from the third party's program
beside the operating system. Refer to the manual
provided by individual programs.

* Direct Input

The Direct Input allows you to search a specific machine on

the network.

- Search by IP address: Enter the IP address or the host
name. Then click Next.

To verify your machine’s IP address, print a network

configuration report (See "Printing Network Configuration

report" on page 37).

- Search by network path: To find a shared machine (UNC
Path), enter the shared name manually or find a shared
printer by clicking the Browse button. Then click Next.

* Help

If your machine is not connected to the computer or network,

This help button gives detailed information about the how to

connect the machine.

+ SetIP Address
If you want to set a specific IP address on a specific network

machine, click the Set IP Address button. The Set IP Address

window appears. Do as follows:

a) Select a machine to be set with a specific IP address from
the list.

b) Configure an IP address, subnet mask, and gateway for the
machine manually and click Apply to set the specific IP
address for the network machine.

c) Click Next.
The searched machine will be shown on the screen. Select one you wish
to use.
@ If the driver searched only one printer, the confirmation window
appears.

The program starts installation.

After the installation is finished, a window asking you to print a test page
appears. If you want to print a test page, click Print a test page.

Otherwise, just click Next and skip to step 8.
If the test page prints out correctly, click Yes.
If not, click No to reprint it.

To register as a user of the machine in order to receive information from
Samsung, click On-line Registration.

Click Finish.

'g « After the driver setup, you may enable firewalls.

« If your printer driver doesn’t work properly after setup has been
completed, repair or reinstall the printer driver (See "Installing
wired network connected machine’s driver" on page 39).

Macintosh

1.

20NN

1.

Make sure that the machine is connected to your network and powered
on. Also, your machine’s IP address should have been set.

Insert the supplied software CD into your CD-ROM drive.

Double-click the CD-ROM icon that appears on your Macintosh desktop.
Double-click the MAC_Installer folder.

Double-click the Installer OS X icon.

Enter the password and click OK.

The Samsung Installer window opens. Click Continue.

Read the license agreement and click Continue.

Click Agree to agree to the license agreement.

. Select Easy Install and click Install. Easy Install is recommended for

most users. All components necessary for machine operations will be
installed.

If you select Custom Install, you can choose individual components to
install.

The message which warns that all applications will close on your
computer appears. Click Continue.

@ » If awindow asking you to select an installation type appears,
select Typical installation for a network printer and then
click OK.

» If you select Typical installation for a network printer, the
SetlP program automatically runs. If the machine has already
configured network information, close the SetlP program. Go to
the next step.

12. After the installation is finished, click Quit.
13. Open the Applications folder > Utilities > Print Setup Utility.

* For Mac OS X 10.5 ~ 10.6, open the Applications folder > System
Preferences and click Print & Fax.

14. Click Add on the Printer List.
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»  ForMac OS X 10.5 ~ 10.6, press the “+” icon; a display window will
pop up.
15. For Mac OS X 10.3, select the IP Printing tab.
¢ For Mac OS X 10.4, click IP Printer.
e For Mac OS X 10.5 ~ 10.6, click IP.
16. Select Socket/HP Jet Direct in Printer Type.
When printing a document containing many pages, printing performance
may be enhanced by choosing Socket for Printer Type option.
17. Enter the machine’s IP address in the Printer Address field.
18. Enter the queue name in the Queue Name field. If you cannot determine

the queue name for your machine server, try using the default queue

first.

19. For Mac OS X 10.3, if Auto Select does not work properly, select
Samsung in Printer Model and your machine name in Model Name.
» For Mac OS X 10.4, if Auto Select does not work properly, select

Samsung in Print Using and your machine name in Model.

» ForMac OS X 10.5 ~ 10.6, if Auto Select does not work properly,
choose Select a driver to use... and your machine name in Print
Using.

Your machine’s IP address appears on the Printer List, and is set as

the default machine.

20. Click Add.
[g If the printer driver does not work properly, uninstall the driver and
reinstall it.

Follow steps below to uninstall the driver for Macintosh.

a) Make sure that the machine is connected to your computer and
powered on.

b) Insert the supplied software CD into your CD-ROM drive.

c) Double-click CD-ROM icon that appears on your Macintosh

desktop.

Double-click the MAC_Installer folder.

Double-click the Installer OS X icon.

f) Enter the network key and click OK.

The Samsung Installer window opens. Click Continue.

Select Uninstall and click Uninstall.

i)  When the message which warns that all applications will close on
your computer appears, click Continue.

i)  When the uninstall is done, click Quit.

-

o QO
~ —

=]
= =

Linux

Install Linux Driver and add network Printer

1. Make sure that the machine is connected to your network and
powered on. Also, your machine’s IP address should have been set.

2. Download the Unified Linux Driver package from the Samsung
website.

Double-click the Linux folder.

Double-click the install.sh icon.

The Samsung Installer window opens. Click Continue.

The Add printer wizard window opens. Click Next.

Select Network printer and click Search button.

9. The Printer’'s IP address and model name appears on list field.
10. Select your machine and click Next.

11. Input the printer description and Next

12. When the add printer is done, click Finish

O NOo O

Extract the UnifiedLinuxDriver.tar.gz file and open the new directory.

13. When the install is done, click Finish

Add network Printer

Double-click the Unified Driver Configurator.

Click Add Printer...

The Add printer wizard window opens. Click Next.

Select Network printer and click the Search button.

The printer’s IP address and model name appears on list field.
Select your machine and click Next.

Input the printer description and Next

When the add printer is done, click Finish.

O NOORON=S

IPV6 CONFIGURATION
A TCP/IPv6 is supported properly only in Windows Vista or higher.

'g If the IPv6 network seems to not be working, set all the network setting
to the factory defaults and try again (See "Restoring factory default
settings" on page 39).

To use the IPv6 network environment, follow the next procedure to use the

IPv6 address:

1. Connect your machine to the network with a network cable.

2. Turn on the machine.

3. Print a Network Configuration Report from the machine’s control

panel that will check IPv6 addresses.
'.g a) Press Menu on the control panel.
b) Press the left/right arrow until Network appears and press OK.

c) Press the left/right arrow until Network Info. appears and
press OK.

d) Press the left/right arrow until Yes appears and press OK.

5. Select Start > Control Panel > Hardware and Sound > Printers > Add
Printer.

6. Click Add a local printer on the Add Printer windows.
7. Follow the instruction on the window.

',g If the machine does not work in the network environment, activate
IPv6. Refer to the next section followed by.

Activating IPv6

The machine is provided with IPv6 feature on.

Press Menu on the control panel.

Press the left/right arrow until Network appears and press OK.
Press the left/right arrow until TCP/IP (IPv6) appears and press OK.
Press the left/right arrow until IPv6 Activate appears and press OK.
Press the left/right arrow until On appears and press OK.

Turn the machine off and turn it on again.

Reinstall your printer driver.

Noakowbh=

Setting IPv6 addresses

Machine supports following IPv6 addresses for network printing and
managements.

» Link-local Address: Self-configured local IPv6 address (Address starts
with FE80).

+ Stateless Address: Automatically configured IPv6 address by a
network router.

» Stateful Address: IPv6 address configured by a DHCPV6 server.
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Manual Address: Manually configured IPv6 address by a user.

DHCPv6 address configuration (Stateful)

If you have a DHCPV6 server on your network, you can set one of the
following option for default dynamic host configuration:

1. Press Menu on the control panel.
. Press the left/right arrow until Network appears and press OK.

2
3. Press the left/right arrow until TCP/IP (IPv6) appears and press OK.
4

. Press the left/right arrow until DHCPv6 Config appears and press
OK.

5. Press the left/right arrow to access the required value.
« Router: Use DHCPv6 only when requested by a router.

« DHCPv6 Addr.: Always use DHCPV6 regardless of router
request.

« DHCPv6 Off: Never use DHCPV6 regardless of router request.
6. Press OK.

Manual address configuration
1. Start a web browser such as Internet Explorer that supports IPv6
addressing as a URL (See "Connecting SyncThru™ Web Service"
on page 42).
w For IPv4, enter the IPv4 address (http://xxx.xxx.xxx.xxx) in the
address field and press the Enter key or click Go.

2. When the SyncThru™ Web Service window opens, click Network
Settings.

3. Click TCP/IP.
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4. Enable the Manual Address In the TCP/IPv6 section.

5. Select the Router Prefix and click the Add button, then the router
prefix will automatically be entered into the address field.
Enter the rest of address (ex:3FFE:10:88:194::AAAA. “A” is the
hexadecimal 0 through 9, A through F).

6. Click the Apply button.

Connecting SyncThru™ Web Service

1.

2.

Start a web browser such as Internet Explorer that supports IPv6
addressing as a URL.

Select one of the IPv6 addresses (Link-local Address, Stateless
Address, Stateful Address, Manual Address) from Network
Configuration Report.

. Enter the IPv6 addresses (ex: http://[FE80::215:99FF:FE66:7701]).

A Address must be enclosed in '[ ] brackets.
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wireless network setup

This chapter gives you step-by-step instructions for setting up the wireless network connected machine and software.

This chapter includes:

* Using a wireless network with WPS button on the control panel
« Using a wireless network from the control panel

* Using a wireless network from the computer

« Setting a wireless network with USB cable

For more information about network environment, network programs
and Installing network connected machine’s driver, refer to following
chapters.

» See "Network environment" on page 37.
» See "Introducing useful network programs" on page 37.

» See "Installing wired network connected machine’s driver" on
page 39.

USING A WIRELESS NETWORK WITH WPS
BUTTON ON THE CONTROL PANEL

If your machine and access point (or wireless router) supports Wi-Fi
Protected Setup™(WPS), you can easily configure the wireless network

settings by pressing WPS( " ) button on the control panel.

Items to prepare
You need to ensure you have the following items ready to use.

« Check if access point (or wireless router) supports Wi-Fi Protected
Setup™(WPS).
* Check if your machine supports Wi-Fi Protected Setup™(WPS).

Choosing your network connection

There are two methods to connect your machine to a wireless network by
using WPS( ¢% ) button on the control panel.

Push Button\Configuration (PBC) method allows you to connect your
machine to the wireless network by pressing both WPS button on the

control panel of your machine and WPS (PBC) button on a Wi-Fi Protected
Setup™(WPS)-enabled access point (or wireless router) respectively.

Personal Identification Number (PIN) method helps you to connect your
machine to a wireless network by entering the supplied PIN information on a
Wi-Fi Protected Setup™(WPS)-enabled access point (or wireless router).
Factory default in your machine is PBC mode, which is recommended for a
typical wireless network environment.

Access point (or wireless router) that supports WPS (Wi-Fi Protected
Setup™) has the symbols shown below.

Changing WPS mode

Factory default in your machine is PBC mode. To change WPS mode,
follow the below steps.

1. Press Menu on the control panel.
2. Press the left/right arrow until Network appears and press OK.

» Setting a wireless network with network cable
* Completing the installation
* Using a wireless network from the control panel

3. Press the left/right arrow until Wireless appears and press OK.

Press the left/right arrow until WLAN Setting appears and press OK.

5. Press the left/right arrow until WPS mode you want appears and press
OK.
*  PBC mode: Pressing both WPS( " ) button on the control panel of

your machine and WPS (PBC) button on a Wi-Fi Protected
Setup™(WPS)-enabled access point (or wireless router)
respectively, you can easily connect your machine to the wireless
network.

» PIN mode: Entering the supplied PIN number on a Wi-Fi Protected
Setup™(WPS)-enabled access point (or wireless router), you can
manually connect your machine to the wireless network.

6. Press Stop/Clear to return to ready mode.

&>

Setting a wireless network in PBC mode
Factory default in your machine is PBC mode.

Connecting to a wireless network in PBC mode

To connect your machine to the wireless network in PBC mode, follow
the below steps. You also need to check WPS( " ) button on the
control panel and messages on the display.

'g You can check the status of the wireless network connection (See
"Wireless LED" on page 29).

1. Press WPS( ‘, ) button on the control panel.

2. Push WPS on AP within 02:00: The machine starts waiting for up
to 2 minutes until you press WPS (PBC) button on access point (or
wireless router).

3. ¢ : Press WPS (PBC) button on the access point.

4. Connecting: The machine is connecting to access point (or
wireless router).
5. Connected: When the machine is successfully connected to the

o

wireless network, wireless LED(==) lights on blue.
* AP SSID: After completing the wireless network connection
process, AP’s SSID information is automatically printed out.

w If the machine fails to connect to the wireless network, Wait 2
minutes for Reconnecting message appears on the display. The
machine tries to re-connect to the wireless network.

Re-connecting to a wireless network in PBC mode

If you press WPS( " ) button on the control panel when the wireless
function is off, the machine automatically tries to re-connect to access
point (or wireless router) with previously used wireless connection
settings and address.
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1.

Connecting: If you press WPS( ‘, ) button on the control panel
when the wireless function is off, the machine automatically tries to
re-connect to access point (or wireless router) with previously used
wireless connection settings and address.

Connected: When the machine is successfully connected to the

o

wireless network, wireless LED(==) lights on blue.

« AP SSID: After completing the wireless network connection
process, AP’s SSID information is automatically printed out.

’g If there is no previously used access point (or wireless router),
or the network settings are changed, Wait 2 minutes for
Reconnecting message appears on the display, and there the
machine tries to re-connect to the wireless network. After the
second attempt to connect, the machine stops the wireless
connection function, and the error report is automatically
printed out. Try again to connect to the wireless network after
solving the connection problem.

Canceling a wireless network connection process in
PBC mode

To cancel the wireless network connection function when the machine is
connecting to access point (or wireless router) in PBC mode, press
WPS ( " ) button on the control panel again. Connecting Canceled
and Wait 2 minutes for Reconnecting messages appears in order on
the display.

Disconnecting a wireless network connection in PBC
mode

To disconnect the wireless network connection, press WPS( " )
button on the control panel again.

When access point (Wi-Fi Network) is in idle mode: Completed
message appears on the display. The machine is returned to ready

mode.

When access point (Wi-Fi Network) is being used: Wait Job to

Finish message appears on the display. The machine waits until the
current job is finished. Then, the wireless network connection is

automatically disconnected. The machine is returned to ready mode.

Setting a wireless network in PIN mode

Factory default in your machine is PBC mode. To change PIN mode, refer
to "Changing WPS mode" on page 43.

Connecting a wireless network in PIN mode

To connect to the wireless network in PIN mode, follow the below steps.
You also need to check the status of WPS( g% ) button and wireless
LED. B

1.
2.

Press WPS( g% ) button on the control panel.

Enter xxxx-xxxx on AP:02:00: Eight-digit PIN number appears on

the display. Then, the machine starts waiting for up to 2 minutes until

you enter PIN number on access point (or wireless router).

32> : Enter the supplied PIN number on access point (or wireless

router) within 2 minutes.

Connecting: The machine is connecting to the wireless network.

Connected: When the machine is successfully connected to the

wireless network, wireless LED(=== ) lights on blue.

« AP SSID: After completing the wireless network connection
process, AP’s SSID information is printed out.

(g If the machine fails to connect to the wireless network, Wait 2

minutes for Reconnecting message appears on the display.
The machine tries to re-connect to the wireless network.

Re-connecting to a wireless network in PIN mode

If you press WPS( ‘,‘ ) button on the control panel when the wireless

function is off, the machine automatically tries to re-connect to access

point (or wireless router) with previously used wireless connection

settings and address.

1. Connecting: If you press WPS( ‘, ) button on the control panel
when the wireless function is off, the machine automatically tries to
re-connect to access point (or wireless router) with previously used
wireless connection settings and address.

2. Connected: When the machine is successfully connected to the

wireless network, wireless LED(==) lights on blue.

« AP SSID: After completing the wireless network connection
process, AP’s SSID information is automatically printed out.

w If there is no previously used access point (or wireless router),
or the network settings are changed, Wait 2 minutes for
Reconnecting message appears on the display, and there the
machine tries to re-connect to the wireless network. After the
second attempt to connect, the machine stops the wireless
connection function.

Canceling a wireless network connection process in
PIN mode

To cancel the wireless network connection function when the machine is
connecting to access point (or wireless router) in PIN mode, press
WPS( " ) button on the control panel again. Connecting Canceled

and Wait 2 minutes for Reconnecting messages appears in order on
the display.

Disconnecting a wireless network connection in PIN
mode

To disconnect the wireless network connection, press WPS( ‘, )
button on the control panel again.

*  When Wi-Fi Network is in idle mode: Completed message
appears on the display. The machine is returned to ready mode.

*  When Wi-Fi Network is being used: Wait Job to Finish message
appears on the display. The machine waits until the current job is
finished. Then, the wireless network connection is automatically
disconnected. The machine is returned to ready mode.

USING A WIRELESS NETWORK FROM THE
CONTROL PANEL

Before starting you will need to know the network name(SSID) of your
wireless network and the network key if it is encrypted. This information was
set when the wireless router(access point) was installed. If you do not know
about your wireless environment, please ask the person who has set up
your network.

To configure wireless parameters, you can use both control panel

Using the control panel

1. Press Menu on the control panel.

2. Press the left/right arrow until Network appears and press OK.

3. Press the left/right arrow until Wireless appears and press OK.

4. Press the left/right arrow until WLAN Settings appears and press OK.
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5. Press the left/right arrow to select the setup method you want appears
and press OK.
* Wizard: The wireless network interface card in your printer
searches for wireless networks in the area and shows the results.
» Custom: You can configure the wireless settings according to your
needs.

Wizard mode

1. The wireless network interface card on your machine searches for
wireless network in the area and shows the results.

2. Press the left/right arrow to select a network you want to use in
Search List and press OK. You can select a network using SSID.

3. When None appears in WLAN Security on the display, press OK to
save your selection. go to step 6.

If you see another messages, go to the next step.

4. According to the network you select, WLAN security encryption type
will be WEP or WPA.
* In case of WEP, Press the up/down to selcet Open System or

SharedKey.

- Open System: Authentication is not used, and Encryption
may or may not be used, depending on the need for data
security. Enter the WEP Key using number keypad after
selecting Open System.

- SharedKey: Authentication is used. A device that has a
proper WEP Key can access the network. Enter the WEP
Key using number keypad after selecting SharedKey.

« In case of WPA, Enter the WPA Key using number keypad. The

Key length should be between 8 to 63 characters long.

5. Press OK.
6. Press Stop/Clear to return to ready mode.

',g + SSID: SSID (Service Set Identifier) is a name that identifies a
wireless network. access points and wireless devices
attempting to connect to a specific wireless network must use
the same SSID. The SSID is case-sensitive.

+  WEP: WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged on a

wireless network using a 64-bit or 128-bit WEP encryption key.

*«  WPA: WPA authorizes and identifies users based on a secret
key that changes automatically at regular intervals. WPA also
uses TKIP (Temporal Key Integrity Protocol) and AES
(Advanced Encryption Standard) for data encryption.

Custom mode
1. Enter the SSID when Edit SSID appears on the top line of the
display, the name that identifies a wireless network. SSID is
case-sensitive so you need to enter it carefully. Press OK.
2. Select the type of wireless connections. Press the left/right arrow to
select the method of Operation Mode you want and press OK.
* Ad-hoc: Allows wireless devices to communicate directly with
each other in a peer-to-peer environment. Go to step 3.
« Infrastructure: Allows wireless devices to communicate with
each other through an access point. Go to step 4.
3. Press the left/right arrow to select the method of Channel you want
and press OK.
If you select Auto, the wireless network interface card on your
machine will automatically adjust the channels.
4. Press the left/right arrow to select the method of WLAN Security
you want and press OK.

* None: This is used when the validation of a wireless device’s
identity and data encryption are not required for your network.
Open system is used for IEEE 802.11 authentication.

« Static WEP: This uses the WEP (Wired Equivalent Privacy)
algorithm suggested by IEEE 802.11 standard for security. Static
WEP security mode requires a proper WEP key for data
encryption, decryption, and IEEE 802.11 authentication. Press
the left/right arrow to select the setup method you want in
Authentication and press OK.

- Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security. Enter the WEP Key using number keypad after
selecting Open System and then press OK.

- SharedKey: Authentication is used. A device that has a
proper WEP Key can access the network. Enter the WEP
Key using number keypad after selecting SharedKey and
then press OK.

«  WPA-PSK or WPA2-PSK: You can select WPA-PSK or
WPA2-PSK to authenticate the print server based on WPA
Pre-Shared Key. This uses a shared secret key (generally called
Pre Shared Key passphrase) which is manually configured on
the access point and each of its clients.

a) Press OK when WPA-PSK or WPA2-PSK appears on the
bottom line of the display.

b) Press the up/down arrow to select TKIP or AES in
Encryption and press OK. If you select WPA2-PSK, press
the up/down arrow to select AES or TKIP + AES in
Encryption and press OK.

c) Enter the WPA Key using number keypad and press OK.

4. When you have finished, press Stop/Clear to return to the ready
mode. If you do not know about your wireless environment, please
ask the network administrator.

Disconnect the network cable (standard or crossover). Your
machine should then start communicating wirelessly with the
network. In case of Ad-hoc mode, you can use a wireless LAN and
wired LAN simultaneously.

Now go to "Installing wired network connected machine’s driver" on
page 39.

USING A WIRELESS NETWORK FROM THE
COMPUTER

Choosing your network connection

Typically, you can only have one connection between your computer and
the machine at a time. There are types of network connections to consider.

* Wireless network without access Point (Ad-Hoc mode)
* Wireless network with an access Point (Infrastructure mode)

Printing network configuration report

You can print a Network Configuration Report from the machine’s control
panel that will show the current machine’s network settings. This will help
you to set up a network and troubleshoot problems.

1. Press Menu on the control panel.

2. Press the left/right arrow until Network appears and press OK.

3. Press the left/right arrow until Network Info. appears and press OK.
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4. Press the left/right arrow until Yes appears and press OK.

Using this Network Configuration Report, you can find your machine MAC
address and IP address.

For example:

*  MAC Address:00:15:99:41:A2:78

* IP Address:192.0.0.192

IP addresses

Every device in a network has a unique numerical address called an IP

Address. Your machine came with a Default IP address of 192.0.0.192,

which you can verify by printing out a Network Configuration Report or

Configuration Report.

« DHCP IP assignment: Connect your machine to the network, and wait a
few minutes for the DHCP server to assign an IP address to the
machine. Then, print the Network Configuration Report as explained
above. If the report shows that the IP address has changed, the
assignment was successful. You will see the new IP address in the
report.

« Static IP assignment: Use the SetlP program to change the IP address
from your computer (See "Setting IP address" on page 38).

In an office environment, we recommend that you contact a network

administrator to set this address for you.

Wireless network name and network key

Wireless networks require higher security, so when an access point is first
set up, a network name (SSID), the type of security used, and a Network
Key are created for the network. Locate this information before proceeding
with the machine installation.

. Infrastructure mode
st This is an environment generally used for homes

]_i_ and SOHOs. This mode uses an access point to

communicate with the wireless machine.

+ See "Installing the machine on a wireless
network with an access point (Windows)" on
page 46.

+ See "Installing the machine on a wireless
network with an access point (Macintosh)" on
page 49.

Ad-Hoc mode

This mode does not use an access point. The

wireless computer and wireless machine

communicates directly.

« See "Installing the machine on an Ad-Hoc
wireless network (Windows)" on page 48.

« See "Installing the machine on an Ad-Hoc
wireless network (Macintosh)" on page 50.

w After choosing your configuration, follow the simple directions for your
computer operating system, but first locate the software CD supplied
with the machine before proceeding.

Installing the wireless network

There are three ways to install the wireless network to connect to the
machine. You can install a wireless network with a USB cable or a network
cable.

For most users, we recommend using a USB cable with the program
provided in the supplied software CD.

The following are ways to install a wireless network.

*  With a USB cable: You can simply set up a wireless network using the
program in the supplied software CD. Only Windows and Macintosh
operating system are supported (See "Setting a wireless network with
USB cable" on page 46).

w You can also install a wireless network in Printer Settings Utility
with USB cable after installing driver (Windows and Macintosh
operating system are supported).

* With a network cable: You can set up a wireless network using the
SyncThru™ Web Service program (See "Setting a wireless network with
network cable" on page 51).

SETTING A WIRELESS NETWORK WITH USB
CABLE

w Refer to your network administrator, or the person that set up your
wireless network, for information about your network configuration.

Installing the machine on a wireless network with an
access point (Windows)

Items to prepare

Ensure you have next items ready.

* Access point

* Networked computer

+ Software CD that provided with your machine
*  Wireless network your machine

» USBcable

Creating the infrastructure network in Windows
When the items are ready, follow below steps:

1. Check whether the USB cable is connected to the machine.
2. Turn on your computer, access point and machine.

3. Insert the supplied software CD into your CD-ROM drive.

« The software CD should automatically run and an installation
window appears.

« If the installation window does not appear, click Start and then
Run. Type X:\Setup.exe, replacing “X” with the letter which
represents your CD-ROM drive. Click OK.

* If you use Windows Vista, Windows 7 or Windows Server 2008
R2 click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter which represents
your CD-ROM and click OK.

* Ifthe AutoPlay window appears in Windows Vista, Windows 7 or
Windows Server 2008 R2, click Run Setup.exe in Install or run
program field, and click Continue or Yes in the User Account
Control windows.
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4. Select the Wireless Setting and Installation option.

- BIX)
P umsinng

’3 Install Now &

b ‘ Wireless Setting and Installation »

Only for the users who have nat set up the wireless connectio
47 vewusers ude #

& pavancedinsataion

Installation Language: |Englsh v Ext

Install Now: First you must configure the wireless network
settings of your printer to print through wireless.

Wireless Setting and Installation: Configure the wireless
network settings of your printer with a USB cable then install the
printer driver. Press this button to set up the wireless connection
if you have not set up the wireless connection before.

may differ according to its security mode, WEP or WPA.

* In case of WEP
Select Open System or Shared Key for the authentication
and enter WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

* In case of WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key
that changes automatically at regular intervals. WPA also
uses TKIP (Temporal Key Integrity Protocol) and AES
(Advanced Encryption Standard) for data encryption.

8. The window shows the wireless network setting and check if settings
are right. Click Next.

5. Read License Agreement, and select | accept the terms of the
License Agreement. Then, click Next.

6. The software searches the wireless network.
'g If the searching has failed, you may check if the USB cable is

connected between the computer and machine properly, and
follow the instruction on the window.

7. After searching, the window shows the wireless network devices.
Select the name (SSID) of access point you are using and click

Next.

(Q When you set the wireless configuration manually, click

Advanced Setting.

* Enter the wireless Network Name: Type the SSID of
access point you want (SSID is case-sensitive).

* Operation Mode: Select Infrastructure.

+ Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to
authenticate the print server based on WPA Pre-Shared
Key. This uses a shared secret key (generally called Pre
Shared Key pass phrase) which is manually configured on
the access point and each of its clients.

* Encryption: Select the encryption. (None, WEP64,
WEP128, TKIP, AES, TKIP AES)

* Network Key: Enter the encryption network key value.

* Confirm Network Key: Confirm the encryption network
key value.

*  WEP Key Index: If you are using the WEP Encryption,
select the appropriate WEP Key Index.

'g The wireless network security window does appear when the
access point has security setting.
The wireless network security window appears. The window
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For the DHCP method

If the IP address assignment method is DHCP, check if DHCP is

shown in the window. However, if it shows Static, click Change

TCP/IP to change the assignment method to DHCP.

For the Static method

If the IP address assignment method is Static, check if Static is

shown in the window. However, if it shows DHCP, click Change

TCPI/IP to enter the IP address and other network configuration

values for the machine. Before entering the IP address for the

machine, you must know the computer’s network configuration

information. If the computer is set to DHCP, you must contact the

network administrator to get the static IP address.

Example)

If computer’s network information is as below:

- IP address: 169.254.133.42

- Subnet Mask: 255.255.0.0

Machine’s network information should be as below:

- [P address: 169.254.133. 43 (Use computer’s IP address,
with changed last three digits.)

- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)

- Gateway: 169.254.133.1 (Change the last three digits from IP
address of your machine to 1.)

9. You need to change the computer network settings to
communication with the wireless machine. Follow the steps on the
Change PC Network Setting window.

Click Next if you are finished setting the computer’s wireless network
settings.

If you set the computer’s wireless network as DHCP, it will take
several minutes to receive the IP address.

10. When the wireless network setting is completed, disconnect the USB
cable between the computer and machine. Click Next.

11. Wireless Network Setting Complete window appears. Then, click
Next.

Select Yes if you accept the current settings and continue the setup
procedure.

Select No if you want to return to the beginning screen.
Then, click Next.
12. Click Next.
13. Select the components to be installed. Click Next.
After selecting the components, you can also change the machine



name, set the machine to be shared on the network, set the machine
as the default machine, and change the port name of each machine.
Click Next.

14. After the installation is finished, a window asking you to print a test
page appears. If you want to print a test page, click Print a test
page. Otherwise, just click Next and skip to step 16.

15. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

16. To register as a user of the machine in order to receive information
from Samsung, click On-line Registration.

17. Click Finish.

Installing the machine on an Ad-Hoc wireless
network (Windows)

If you do not have an access point (AP), you may still connect the machine
wirelessly to your computer by setting up an Ad-Hoc wireless network by
following the simple steps below.

Items to prepare

Ensure you have next items ready.

*  Wireless network computer

» Software CD provided with your machine
*  Wireless network machine

* USB cable

Creating the Ad-Hoc network in Windows

When the items are ready, follow below steps:

1. Check whether the USB cable is connected to the machine.
2. Turn on your computer and the wireless network machine.
3. Insert the supplied software CD into your CD-ROM drive.

¢ The software CD should automatically run and an installation
window appear.

« If the installation window does not appear, click Start and then
Run. Type X:\Setup.exe, replacing “X” with the letter which
represents your drive. Click OK.

« If you use Windows Vista, Windows 7 or Windows Server 2008
R2 click Start > All programs > Accessories > Run.

Type X:\Setup.exe replacing “X” with the letter which represents
your drive and click OK.

« Ifthe AutoPlay window appears in Windows Vista, Windows 7 or
Windows Server 2008 R2, click Run Setup.exe in Install or run
program field, and click Continue or Yes in the User Account
Control windows.

4. Select the Wireless Setting and Installation option.
o - BX)
Pinsune

'3 Install Now &

" Wireless Setting and Installation
Only for the users who have not set up the wireless cannection befare.
47 vewusers Gude #

& tavancedinsataton

Installation Language:  |Englsh v X

« Install Now: First you must configure the wireless network
settings of your printer to print through wireless.

« Wireless Setting and Installation: Configure the wireless
network settings of your printer with a USB cable then install the
printer driver. Press this button to set up the wireless connection
if you have not set up the wireless connection before.

5. Read the License Agreement, and select | accept the terms of the

License Agreement. Then, click Next.

6. The software searches the wireless network.

@ If the software has failed to search the network, check if the
USB cable is connected properly between the computer and
machine, and follow the instruction on the window.

7. After searching the wireless network, a list of wireless network your
machine has searched appears.

If you want to use the Samsung default ad-hoc setting, select the last
wireless network on the list, which Network Name(SSID) is
airportthru and Signal is Printer Self Network.

Then, click Next.

If you want to use other ad-hoc settings, select other wireless
network from the list.

w If you want to change ad-hoc settings click the Advanced

Setting button.

« Enter the wireless Network Name: Type in the SSID
name you want (SSID is case-sensitive).

« Operation Mode: Select Ad-hoc.

+ Channel: Select the channel. (Auto Setting or 2412 MHz
to 2467 MHz).

+ Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.

« Encryption: Select the encryption. (None, WEP64,
WEP128)

* Network Key: Enter the encryption network key value.

« Confirm Network Key: Confirm the encryption network
key value.

«  WEP Key Index: If you are using the WEP Encryption,
select the appropriate WEP Key Index.

Wireless network setup_ 48



[.g The wireless network security window appears when the

ad-hoc network has security setting.

The wireless network security window appears. Select Open

System or Shared Key for the authentication and click Next.

+ WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

8. The window which shows the wireless network setting appears.
Check the settings and click Next.

Before entering the IP address for the machine, you must know
the computer’s network configuration information. If the
computer’s network configuration is set to DHCP, the wireless
network setting should also be DHCP. Likewise, if the
computer’s network configuration is set to Static, the wireless
network setting should also be Static.

If your computer is set to DHCP and you want to use Static
wireless network setting, you must contact the network
administrator to get the static IP address.
*  For the DHCP method
If the IP address assignment method is DHCP, check if
DHCP is shown in the Wireless Network Setting Confirm
window. However, if it shows Static, click Change TCP/IP
to change the assignment method to Receive IP address
automatically (DHCP).
* For the Static method
If the IP address assignment method is Static, check if
Static is shown in the Wireless Network Setting Confirm
window. However, if it shows DHCP, click Change TCP/IP
to enter the IP address and other network configuration
values for the machine.
Example)
If computer’s network information is as below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
- IP address: 169.254.133. 43 (Use computer’s IP
address, with changed last three digits.)
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)
- Gateway: 169.254.133.1 (Change the last three digits
from IP address of your machine to 1.)

9. You need to change the computer network settings to
communication with the wireless machine. Follow the steps on the
Change PC Network Setting window.

Click Next if you are finished setting the computer’s wireless network

settings.

If you set the computer’s wireless network as DHCP, it will take

several minutes to receive the IP address.

10. When the wireless network setting is completed, disconnect the USB
cable between the computer and machine. Click Next.

11. Wireless Network Setting Complete window appears. Then, click
Next.

Select Yes if you accept the current settings and continue the setup

procedure.

Select No if you want to return to the beginning screen.

Then, click Next.

12. Click Next.
13. Select the components to be installed. Click Next.

After selecting the components, you can also change the machine
name, set the machine to be shared on the network, set the machine
as the default machine and change the port name of each machine.
Click Next.

14. After the installation is finished, a window asking you to print a test
page appears. If you want to print a test page, click Print a test
page. Otherwise, just click Next and skip to step 16.

15. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

16. To register as a user of the machine in order to receive information
from Samsung, click On-line Registration.

17. Click Finish.

Installing the machine on a wireless network with an
access point (Macintosh)

Items to prepare

Ensure you have next items ready.

» Access point

* Networked computer

» Software CD that provided with your machine
»  Wireless network your machine

* USB cable

Creating the infrastructure network in Macintosh
When the items are ready, follow below steps:

1. Check whether the USB cable is connected to the machine.
Turn on your computer, access point and machine.

Insert the supplied software CD into your CD-ROM drive.

Double-click the CD-ROM icon that appears on your Macintosh
desktop.

Double-click the MAC_Installer folder.

Double-click the Installer OS X icon.

Enter the password and click OK.

The Samsung Installer window opens. Click Continue.
9. Read the license agreement and click Continue.

10. Click Agree to agree to the license agreement.

11. The Samsung Installer window opens. Click Continue.
12. Select Easy Install and click Install.

13. Select the Wireless Setting and Installation option.
14. The software searches the wireless network.

'.g If the searching has failed, you may check if the USB cable is

connected between the computer and machine properly, and
follow the instruction on the window.

PODd
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15. After searching, the window shows the wireless network devices.
Select the name (SSID) of access point you are using and click
Next.

@ When you set the wireless configuration manually, click
Advanced Setting.

« Enter the wireless Network Name: Type the SSID of
access point you want (SSID is case-sensitive).

« Operation Mode: Select Infrastructure.
« Authentication: Select an authentication type.
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Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to
authenticate the print server based on WPA Pre-Shared
Key. This uses a shared secret key (generally called Pre
Shared Key pass phrase) which is manually configured on
the access point and each of its clients.

* Encryption: Select the encryption. (None, WEP64,
WEP128, TKIP, AES, TKIP AES)

» Network Key: Enter the encryption network key value.

» Confirm Network Key: Confirm the encryption network
key value.

*  WEP Key Index: If you are using the WEP Encryption,
select the appropriate WEP Key Index.

[g The wireless network security window does appear when the
access point has security setting.
The wireless network security window appears. The window
may differ according to its security mode, WEP or WPA.

* In case of WEP
Select Open System or Shared Key for the authentication
and enter WEP security key. Click Next.
WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

* In case of WPA
Enter the WPA shared key and click Next.
WPA authorizes and identifies users based on a secret key
that changes automatically at regular intervals. WPA also
uses TKIP (Temporal Key Integrity Protocol) and AES
(Advanced Encryption Standard) for data encryption.

16. The window shows the wireless network setting and check if settings

are right. Click Next.

* For the DHCP method
If the IP address assignment method is DHCP, check if DHCP is
shown in the window. However, if it shows Static, click Change
TCPIIP to change the assignment method to DHCP.

« For the Static method
If the IP address assignment method is Static, check if Static is
shown in the window. However, if it shows DHCP, click Change
TCPIIP to enter the IP address and other network configuration
values for the machine. Before entering the IP address for the
machine, you must know the computer’s network configuration
information. If the computer is set to DHCP, you must contact the
network administrator to get the static IP address.
Example)
If computer’s network information is as below:
- |IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
- |P address: 169.254.133. 43 (Use computer’s IP address,

with changed last three digits.)
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)

- Gateway: 169.254.133.1 (Change the last three digits from IP
address of your machine to 1.)

17. The wireless network is connecting according to the network
configuration.

18. When the wireless network setting is completed, disconnect the USB
cable between the computer and machine.

19. After the installation is finished, click Quit.

Installing the machine on an Ad-Hoc wireless
network (Macintosh)

If you do not have a access point (AP), you may still connect the machine
wirelessly to your computer by setting up an Ad-Hoc wireless network by
following these simple directions.

Items to prepare

Ensure you have next items ready.

*  Wireless network computer

» Software CD that provided with your machine
*  Wireless network your machine

* USB cable

Creating the Ad-Hoc network in Macintosh
When the items are ready, follow below steps:
1. Check whether the USB cable is connected to the machine.
Turn on your computer and machine.
Insert the supplied software CD into your CD-ROM drive.
Double-click the CD-ROM icon that appears on your Macintosh
desktop.
Double-click the MAC_Installer folder.
Double-click the Installer OS X icon.
Enter the password and click OK.
The Samsung Installer window opens. Click Continue.
9. Read the license agreement and click Continue.
10. Click Agree to agree to the license agreement.
11. The Samsung Installer window opens. Click Continue.
12. Select Easy Install and click Install.
13. Click Wireless Setting and Installation.
14. The software searches the wireless network devices.
fg If the searching has failed, you may check if the USB cable is

connected between the computer and machine properly, and
follow the instruction on the window.

hpoON
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15. After searching the wireless network, a list of wireless network your
machine has searched appears.
If you want to use the Samsung default ad-hoc setting, select the last
wireless network on the list, which Network Name(SSID) is
airportthru and Signal is Printer Self Network.
Then, click Next.
If you want to use other ad-hoc settings, select other wireless
network from the list.

',g If you want to change ad-hoc settings click the Advanced
Setting button.
* Enter the wireless Network Name: Type in the SSID
name you want (SSID is case-sensitive).
« Operation Mode: Select Ad-hoc.
* Channel: Select the channel. (Auto Setting or 2412 MHz
to 2467 MHz).
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« Authentication: Select an authentication type.
Open System: Authentication is not used, and encryption
may or may not be used, depending on the need for data
security.
Shared Key: Authentication is used. A device that has a
proper WEP key can access the network.

* Encryption: Select the encryption. (None, WEP64,
WEP128)

* Network Key: Enter the encryption network key value.

+ Confirm Network Key: Confirm the encryption network
key value.

*  WEP Key Index: If you are using the WEP Encryption,
select the appropriate WEP Key Index.

[.ﬁ The wireless network security window appears when the

ad-hoc network has security setting.

The wireless network security window appears. Select Open

System or Shared Key for the authentication and click Next.

+ WEP (Wired Equivalent Privacy) is a security protocol
preventing unauthorized access to your wireless network.
WEP encrypts the data portion of each packet exchanged
on a wireless network using a 64-bit or 128-bit WEP
encryption key.

16. The window which shows the wireless network setting appears.
Check the settings and click Next.

Before entering the IP address for the machine, you must know
the computer’s network configuration information. If the
computer’s network configuration is set to DHCP, the wireless
network setting should also be DHCP. Likewise, if the
computer’s network configuration is set to Static, the wireless
network setting should also be Static.

If your computer is set to DHCP and you want to use Static
wireless network setting, you must contact the network
administrator to get the static IP address.
*  For the DHCP method
If the IP address assignment method is DHCP, check if
DHCP is shown in the Wireless Network Setting Confirm
window. However, if it shows Static, click Change TCP/IP
to change the assignment method to Receive IP address
automatically (DHCP).
* For the Static method
If the IP address assignment method is Static, check if
Static is shown in the Wireless Network Setting Confirm
window. However, if it shows DHCP, click Change TCP/IP
to enter the IP address and other network configuration
values for the machine.
Example)
If computer’s network information is as below:
- |P address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Machine’s network information should be as below:
- IP address: 169.254.133. 43 (Use computer’s IP
address, with changed last three digits.)
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet
mask.)
- Gateway: 169.254.133.1 (Change the last three digits
from IP address of your machine to 1.)
17. The wireless network is connecting according to the network
configuration.

18. When the wireless network setting is completed, disconnect the USB
cable between the computer and machine.

19. After the installation is finished, click Quit.

SETTING A WIRELESS NETWORK WITH
NETWORK CABLE

Your machine is a network compatible machine. To enable your machine to
work with your network you will need to perform some configuration
procedures.

',g Refer to your network administrator, or the person that set up your
wireless network, for information about your network configuration.

Preparing items

Ensure you have next items ready.

* Access point

* Networked computer

» Software CD-ROM that provided with your machine
*  Wireless network printer (your machine)

* Network cable

Setting IP address

Firstly, you have to set up an IP address for network printing and
managements. In most cases a new IP address will be automatically
assigned by a DHCP (Dynamic Host Configuration Protocol) server located
on the network.

In a few situations the IP address must be set manually. This is called a
static IP and is often required in corporate Intranets for security reasons.

* DHCP IP assignment: Connect your machine to the network, and wait a
few minutes for the DHCP server to assign an IP address to the
machine. Then, print the Network Configuration Report as explained
above. If the report shows that the IP address has changed, the
assignment was successful. You will see the new IP address in the
report (See "Printing a machine report" on page 101).

» Static IP assignment: Use SetlP program to change the IP address
from your computer.

In an office environment, we recommend that you contact a network
administrator to set this address for you.

IP setting using SetIlP Program (Windows)

This program is for manually setting the network IP address of your
machine using its MAC address to communicate with the machine. A
MAC address is the hardware serial number of the network interface and
can be found in the Network Configuration Report.

For using SetlP program, disable the computer firewall before continuing
by performing the following:

1. Open Start > All programs > Control Panel.

2. Double click Security Center.

3. Click Windows Firewall.

4. Disable the firewall.

Installing the program

1. Insert the Printer Software CD-ROM provided with your machine.
When the driver CD runs automatically, close that window.

2. Start Windows Explorer and open the X drive. (X represents your
CD-ROM drive.)

3. Double-click Application > SetIP.
4. Double-click Setup.exe to install this program.
5. Click OK. If necessary, select a language from the drop-down list.
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6.

Follow the instructions in the window and complete the installation.

Starting the program

1.
2.
3.

7.
8.

Connect your machine to the network with a network cable.

Turned on the machine.

From the Windows Start menu, select All Programs > Samsung
Printers > SetIP > SetIP.

Click on the #% icon (third from left) in the SetIP window to open the
TCP/IP configuration window.

Enter the machine’s new information into the configuration window
as follows. In a corporate intranet, you may need to have this
information assigned by a network manager before proceeding.

TCP/IP Configuration X
TERAP |
Mac Address I
IP Address : —
Subnet Mask : —
Default Gateway : [ R . R
Apply Cancel Reset

*« MAC Address: Find the machine’s MAC address from the
Network Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

« IP Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150,
enter 192.168.1.X. (X is number between 1 and 254 other than
the computer’s address.)

* Subnet Mask: Enter a Subnet Mask.
+ Default Gateway: Enter a Default Gateway.

Click Apply, and then click OK. The machine will automatically print
the Network Configuration Report. Confirm that all the settings are
correct.

Click Exit to close the SetIP program.
If necessary, restart the computer’s firewall.

IP setting using SetlP Program (Macintosh)

For using SetlP program, disable the computer firewall before continuing
by performing the following:

14

hobdb-=

The path and Uls may differ by Mac OS version. Refer to the Mac
OS manual.

Open System Preferences.
Click Security.

Click the Firewall menu.
Turn firewall off.

',g The following instructions may vary for your model.

1.
2.

Connect your machine to the network with a network cable.

Insert the Installation CD-ROM, and open the disk window, select
MAC_Installer > MAC_Printer > SetIP > SetIPApplet.html.

3. Double click the file and Safari will automatically open, then select
Trust. The browser will open the SetIPApplet.html page that shows
the printer’'s name and IP address information.

4. Click on the % icon (third from left) in the SetlP window to open the
TCP/IP configuration window.

5. Enter the machine’s new information into the configuration window
as follows. In a corporate intranet, you may need to have this
information assigned by a network manager before proceeding.

* MAC Address: Find the machine’s MAC address from the
Network Configuration Report and enter it without the colons.
For example, 00:15:99:29:51:A8 becomes 0015992951A8.

« [P Address: Enter a new IP address for your printer.

For example, if your computer’s IP address is 192.168.1.150,
enter 192.168.1.X. (X is number between 1 and 254 other than
the computer’s address.)

« Subnet Mask: Enter a Subnet Mask.

+ Default Gateway: Enter a Default Gateway.

6. Select Apply, then OK, and OK again. The printer will automatically
print the configuration report. Confirm that all the settings are correct.
Quit Safari. You may close and eject the installation CD-ROM. If
necessary, restart the computer’s firewall. You have successfully
changed the IP address, subnet mask, and gateway.

Configuring the machine’s wireless network

Before starting you will need to know the network name(SSID) of your
wireless network and the network key if it is encrypted. This information was
set when the access point (or wireless router) was installed. If you do not
know about your wireless environment, please ask the person who has set
up your network.

To configure wireless parameters, you can use SyncThru™ Web Service.

Using SyncThru™ Web Service

Before starting wireless parameter configuration, make sure cable

connection status.

1. Check whether the network cable is connected to the machine. If not,
connect the manchine with a standard network cable.

2. Start a web browser such as Internet Explorer, Safari or Firefox and
enter your machine’s new IP address in the browser window.
For example,

(€] htip://192.168,1,13%/

3. When the SyncThru™ Web Service window opens, click Network
Settings.

4. Click Wireless and select Wizard. Then, click Next.

Wizard will help you setup the wireless network configuration.
However, if you want to set the wireless network directly, select
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« SSID: SSID (Service Set Identifier) is a name that identifies a
wireless network. access points and wireless devices attempting
to connect to a specific wireless network must use the same
SSID. The SSID is case-sensitive.

« Operation Mode: Operation Mode refers to the type of wireless
connections (See "Wireless network name and network key" on
page 46).

@

Ad-hoc: allows wireless devices to communicate directly
with each other in a peer-to-peer environment.
Infrastructure: allows wireless devices to communicate with
each other through an access point.

If your network’s Operation Mode is Infrastructure, select the
SSID of the access point. If the Operation Mode is Ad-hoc,
select the machine’s SSID. Note that “airportthru” is the default
SSID of your machine.

6. Click Next.
If wireless security setting window appears, enter the registered

password (network key) and click Next.
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7. The confirmation window appears, please check your wireless setup.
If the setup is right, click Apply.

8. Click OK.
Disconnect the network cable (standard or crossover). Your
machine should then start communicating wirelessly with the
network. In case of Ad-hoc mode, you can use a wireless LAN
and wired LAN simultaneously.

Now go to "Installing network connected machine’s driver" on
page 31.

COMPLETING THE INSTALLATION

After you have installed your Samsung wireless network printer, print
another copy of the Network Configuration Report and keep it for future
reference. You are now ready to use your new Samsung wireless printer on
your network.

TROUBLESHOOTING

Solving problems that might occur during wireless
setting and installing the machine driver

Printers Not Found
* Your machine may not be turned on. Turn on your computer and the
machine.

» USB cable is not connected between your computer and machine.
Connect machine to your computer using the USB cable.

» The machine does not support wireless network. Check the
machine's user's guide included on the software CD supplied with
your machine and prepare a wireless network machine.

Connecting Failure - Not Found SSID

* The machine is unable to search network name (SSID) which you
have selected or typed in. Check the network name (SSID) on your
access point and try connecting again.

*  Your access point is not turned on. Turn on your access point.

Connecting Failure - Invalid Security

* You configured security incorrectly. Check the configured security on
your access point and machine.
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Connecting Failure - General Connection Error

* Your computer is not receiving a signal form your machine. Check
the USB cable and your machine power.

Connecting Failure - Connected Wired Network

*  Your machine is connected with wired network cable. Remove the
wired network cable from your machine.

PC Connection Error

* The configured network address is unable to connect between your
computer and machine.
- For DHCP network environment

The print receives the IP address automatically (DHCP) when
computer is configured to DHCP.

- For Static network environment
The machine uses the static address when computer is
configured to static address.
If you computer has following addresses,
- IP address: 192.168.1.100
- Subnet address: 255.255.255.0
- Gateway address: 192.168.1.1
Type in the following address for your machine,
- |P address: 192.168.1.101
- Subnet address: 255.255.255.0
- Gateway address: 192.168.1.1

Solving other problems

If problems occur while using the machine on a network, check the
followings.

w For information on access point (or wireless router), refer to its own
user's guide.

* Your computer, access point or machine may not be turned on.

* Check the wireless reception around the machine. If the reception is far
from the machine or there is an obstacle, you might have difficulty
receiving the signal.

* Cycle the power for access point (or wireless router), machine and
computer. Sometimes cycling the power can recover network
communication.

« Check whether firewall software (V3 or Norton) is blocking the
communication.

If the computer and the machine is connected on a same network it
cannot be searched, firewall software might be blocking the
communication. Refer to the user's guide for the software to turn it off
and try searching the machine again.

« Check whether the machine's IP address is allocated correctly. You can
check the IP address by printing the network configuration report.

* Check whether access point (or wireless router) has a configured
security (password). If it has a password, refer to the access point (or
wireless router) administrator.

* Check whether the machine's IP address. Reinstall the machine driver
and change the settings to connect to the machine on the network. Due
to the characteristics of DHCP, the allocated IP address could change if
the machine is not used for a long time or if the access point has been
reset.

« Check the wireless environment. You might not be able to connect to the
network in the infrastructure environment where you need to type in a

user's information before connecting to access point (or wireless router).

« This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless

communication (Bluetooth) is not supported.

When using the Ad-hoc mode, for operating systems such as Windows
Vista, you might need to set the wireless connection setting every time
you use the wireless machine.

You cannot use infrastructure mode and Ad-hoc mode at the same time
for Samsung wireless network machine.

The machine is within the range of the wireless network.

For most networks, the machine should be within 30 meters (100 feet) of
the wireless access point (or wireless router).

The machine is located away from obstacles that could block the
wireless signal.

Remove any large metal objects between the access point (or wireless
router) and the machine.

Make sure the machine and wireless access point (or wireless router)
are not separated by poles, walls, or support columns containing metal
or concrete.

The machine is located away from other electronic devices that may
interfere with the wireless signal.

Many devices can interfere with the wireless signal, including baby
monitors, motors, cordless phones, security sytem cameras, other
wireless networks, and some Bluetooth devices.
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pasic setup

After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.

This chapter includes:

« Altitude adjustment

« Changing the display language
« Setting the date and time

« Changing the clock mode

« Changing the default mode

ALTITUDE ADJUSTMENT

The print quality is affected by atmospheric pressure, which is determined
by the height of the machine above sea level. The following information will
guide you on how to set your machine to the best print quality or best quality
of print.

Before you set the altitude value, determine the altitude where you are.

3,000 Mcccccmmma e e il
(9,842 ft)
2010 0y VPRI S . VA
(6,561 ft)
1 High 1
A N 2 High 2
3 High3
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4 Normal

1. Double-click the Smart Panel icon on the Windows task bar (or
Notification Area in Linux). You can also click Smart Panel on the status
bar in Mac OS X.

Or, if you are a Windows user, you can launch it from the Start menu,
select Programs or All Programs > Samsung Printers > your printer
driver name > Smart Panel.

2. Click Printer Setting.

3. Click Setting > Altitude Adjustment. Select the appropriate value from
the dropdown list, and then click Apply.

',g + If your machine is connected to a network, SyncThru™ Web
Service screen appears automatically. Click Machine Settings >
System Setup > Machine Setup > Altitude Adj. Select the
appropriate altitude value, and then click Apply.
» If your machine is connected via a USB cable, set the altitude in
Altitude Adj. option on the machine’s display.

CHANGING THE DISPLAY LANGUAGE

To change the language that appears on the display, follow the steps below:

1. Press Menu on the control panel.
2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Machine Setup appears and press OK.

» Setting sounds

« Entering characters using the number keypad
* Using the save modes

« Setting the default tray and paper

»  Setting job timeout

Press the left/right arrow until Language appears and press OK.
Press the left/right arrow to display the language you want.
Press OK to save the selection.

Press Stop/Clear to return to ready mode.

No oM

SETTING THE DATE AND TIME

When you set the time and date, they are used in delay fax and delay print.
They are printed on reports. If, however, they are not correct, you need to
change it for the correct time being.

"ﬁ If the machine’s power is cut off, you need to reset the correct time
and date once the power has been restored.

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Machine Setup appears and press OK.
Press the left/right arrow until Date & Time appears and press OK.
Enter the correct time and date using left/right arrow or numeric keypad.
Month =01 to 12,

Day = 01 to 31,

Year = requires four digits,

Hour =01 to 12,

Minute = 00 to 59,

and you can also select AM or PM.

6. Press OK to save the selection.

7. Press Stop/Clear to return to ready mode.

ahON=

CHANGING THE CLOCK MODE

You can set your machine to display the current time using either a 12-hour
or 24-hour format.

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Machine Setup appears and press OK.
Press the left/right arrow until Clock Mode appears and press OK.
Press the left/right arrow to select the other mode and press OK.
Press Stop/Clear to return to ready mode.

o9k N2
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CHANGING THE DEFAULT MODE

Your machine is preset to Copy mode. You can switch this default mode
between Fax mode and Copy mode.

1. Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Machine Setup appears and press OK.
Press the left/right arrow until Default Mode appears and press OK.
Press the left/right arrow to select the mode you want.

Press OK to save the selection.

Press Stop/Clear to return to ready mode.

Nooapwbd

SETTING SOUNDS

You can control the following sounds:

« Key sound: Turns the key sound On or Off. With this option set to On, a
tone sounds each time a key is pressed.

« Alarm Sound: Turns the alarm sound On or Off. With this option set to
On, an alarm tone sounds when an error occurs or fax communication
ends.

+ Speaker: Turns On or Off the sounds from the telephone line through
the speaker, such as a dial tone or a fax tone. With this option set to
Comm. which means “Common”, the speaker is on until the remote
machine answers.

’Q You can adjust the volume level using On Hook Dial. If your
machine has a handset, you can adjust the volume level using the
handset.

« Ringer: Adjusts the ringer volume. For the ringer volume, you can select
Off, Low, Mid, and High.

Speaker, ringer, key sound, and alarm sound

1. Press Menu on the control panel.

2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Sound/Volume appears and press OK.
4

. Press the left/right arrow until the sound option you want appear and
press OK.

5. Press the left/right arrow until the desired status or volume for the sound
you have selected appears and press OK.

6. If necessary, repeat steps 4 through 5 to set other sounds.
7. Press Stop/Clear to return to ready mode.

Speaker volume
To adjust the volume using On Hook Dial:

1. Press ég\_(Fax) on the control panel.

2. Press On Hook Dial. A dial tone sounds from the speaker.

3. Press the left/right arrow until you hear the volume you want.

4. Press On Hook Dial to save the change and return to ready mode.
If your machine has a handset:

1. Pick up the handset. A dial tone sounds from the earpiece.

2. Press the left/right arrow until you hear the volume you want.

3. Press OK to save the change and replace the handset.

',g You can adjust the speaker volume only when the telephone line is
connected.

ENTERING CHARACTERS USING THE NUMBER
KEYPAD

As you perform various tasks, you may need to enter names and numbers.
For example, when you set up your machine, you enter your name or your
company’s name, and the fax number.

Entering alphanumeric characters

1. When you are prompted to enter a letter, locate the button labeled with
the character you want. Press the button until the correct letter appears
on the display.

For example, to enter the letter O, press 6, labeled with MNO.

Each time you press 6, the display shows a different letter, M, N, O, m,
n, o and finally 6.

You can enter special characters, such as space, plus sign, and etc. For
details, see the below section.

2. To enter additional letters, repeat step 1.

If the next letter is printed on the same button, move the cursor by
pressing the left/right arrow button and then press the button labeled
with the letter you want. The cursor will move to the right and the next
letter will appear on the display.

You can enter a space by pressing 1 twice.
3. When you have finished entering letters, press OK.

Keypad letters and numbers

KEY ASSIGNED NUMBERS, LETTERS, OR CHARACTERS
@/.'1
ABCabc2
DEFdef3
GHlIghi4
JKLjkI5
MNOmMno6
PQRSpqrs7
TUVtuv8
WXYZwxyz9
&+-,0

*

O|lOW| | N OO | W N~

*

# #

Correcting numbers or names

If you make a mistake while entering a number or name, press the left/right
arrow button to delete the last digit or character. Then enter the correct
number or character.

Inserting a pause

With some telephone systems, you must dial an access code (9, for
example) and listen for a second dial tone. In such cases, you must insert a
pause in the telephone number. You can insert a pause while you are
setting up speed dial numbers.

To insert a pause, press Redial/Pause at the appropriate place while
entering the telephone number. A - appears on the display at the
corresponding location.

Basic setup_ 56



USING THE SAVE MODES

Using the toner saving feature

Toner save mode allows your machine to use less toner on each page.
Activating this mode extends the life of the toner cartridge beyond what one
would experience in the normal mode, but it reduces print quality.

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Machine Setup appears and press OK.
Press the left/right arrow until Toner Save appears and press OK.
Press the left/right arrow until On appears and press OK.

Press Stop/Clear to return to ready mode.
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When PC-printing, you can also turn on or off toner save mode in
the printer properties.

Using the power saving feature

When you are not using the machine for a while, use this feature to save
power.

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Machine Setup appears and press OK.
Press the left/right arrow until Power Save appears and press OK.
Press the left/right arrow to select the time you want.

Press OK to save the selection.

Press Stop/Clear to return to ready mode.

Nooprwb=

SETTING THE DEFAULT TRAY AND PAPER

You can select the tray and paper you would like to keep using for printing
job.

In the control panel

Setting the paper size
Press Menu on the control panel.

Press the left/right arrow until Paper Setup appears and press OK.
Press the left/right arrow until Paper Size appears and press OK.

Press the left/right arrow to select the paper tray you want and press
OK.

6. Press the left/right arrow to select the paper size you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

Qo hON=

Setting the paper type

. Press Menu on the control panel.

Press the left/right arrow until Paper Setup appears and press OK.
Press the left/right arrow until Paper Type appears and press OK.

Press the left/right arrow to select the paper tray you want and press
OK.

Press the left/right arrow to select the paper type you want.
Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

oswN o
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Press the left/right arrow until System Setup appears and press OK.

Press the left/right arrow until System Setup appears and press OK.

Setting the paper source

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Paper Setup appears and press OK.
Press the left/right arrow until Paper Source appears and press OK.
Press the left/right arrow until Copy Tray or Fax Tray appears and
press OK.

Press the left/right arrow to select the paper tray you want.

7. Press OK to save the selection.

8. Press Stop/Clear to return to ready mode.

o=
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In the computer

Windows
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.
*  For Windows XP/2003, select Printers and Faxes.

* For Windows 2008/Vista, select Control Panel > Hardware and
Sound > Printers.

* For Windows 7, select Control Panel > Hardware and Sound >
Devices and Printers.

« For Windows Server 2008 R2, select Control Panel > Hardware
> Devices and Printers.
3. Right-click your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.
For Windows 7 and Windows Server 2008 R2, from context menus,
select the Printing Preferences.

(Q If Printing Preferences item has » mark, you can select other
printer drivers connected with selected printer.

5. Click Paper tab.

6. Select tray and its options, such as paper size and type.

7. Press OK.

'ﬁ If you want to use special-sized paper such as a billing paper,

select Paper tab > Size > Edit... in the Printing Preferences (See
"Opening printing preferences" on page 67).

Macintosh

Macintosh users need to change the default setting manually each time
they want to print using other settings.

1. Open a Macintosh application and select the file you want to print.
Open the File menu and click Print.

Go to Paper Feed pane.

Open the File menu and click Print.

Go to Paper Feed.

Set appropriate tray from which you want to print.

Go to Paper pane.

Set paper type to correspond to the paper loaded in the tray from
which you want to print.

9. Click Print to print.

O NOoOORODN

Linux
1. Open Terminal Program

2. When the Terminal screen appears, type in the following:
[root@localhost root}# Ipr <FileName>

3. Select Printer and click Properties...
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4. Click Advanced tab.
5. Select tray (source) and its options, such as paper size and type.
6. Press OK.

SETTING JOB TIMEOUT

When there is no input for a certain period of time, the machine exits the
current menu and goes in to the default settings. You can set the amount of
time the machine will wait.

1. Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Machine Setup appears and press OK.
Press the left/right arrow until Job Timeout appears and press OK.
Enter the time using left/right arrow or numeric keypad.

Press OK to save the selection.

Press Stop/Clear to return to ready mode.

NouswN
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media and tray

This chapter provides information on how to load originals and print media into your machine.

This chapter includes:

* Preparing originals

« Loading originals

« Selecting print media
« Changing the tray size

@ Supported optional devices and features may differ according to your
model. Please check your model name.

(See "Features by Models" on page 25).

PREPARING ORIGINALS

* Do not load paper smaller than 142 x 148 mm (5.6 x 5.8 inches) or
larger than 216 x 356 mm (8.5 x 14 inches).

» Do not attempt to load the following types of paper, in order to prevent
paper jam, low print quality and machine damage.
- Carbon-paper or carbon-backed paper
- Coated paper
- Onion skin or thin paper
- Wrinkled or creased paper
- Curled or rolled paper
- Torn paper
* Remove all staples and paper clips before loading.

« Make sure any glue, ink, or correction fluid on the paper is completely
dry before loading.

« Do not load originals that include different sizes or weights of paper.

« Do not load booklets, pamphlets, transparencies, or documents with
other unusual characteristics.

LOADING ORIGINALS

You can use the scanner glass or the automatic document feeder to load an
original for copying, scanning, and sending a fax.

On the scanner glass

Make sure that no originals are in the document feeder. If an original is
detected in the document feeder, the machine gives it priority over the
original on the scanner glass. To get the best scan quality, especially for
colored or gray-scaled images, use the scanner glass.

* Loading paper in the tray
» Printing on special media
« Setting the paper size and type
* Using the output support

1. Lift and open the scanner lid.

2. Place the original face down on the scanner glass. And align it with the
registration guide at the top left corner of the glass.

3. Close the scanner lid.

'g . Lea\{ing the scanner lid open while copying may affect copy

quality and toner consumption.

» Dust on the scanner glass may cause black spots on the
printout. Always keep it clean (See "Cleaning the scan unit" on
page 102).

« If you are copying a page from a book or magazine, lift the
scanner lid until its hinges are caught by the stopper and then
close the lid. If the book or magazine is thicker than 30 mm,
start copying with the lid open.

A * Be careful not to break the scanner glass. You may get hurt.

* Do not put hands while closing the scanner lid. The scanner lid
may fall on your hands and get hurt.
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» Do not look the light from inside of the scanner while copying or
scanning. It is harmful to eyes.

In the document feeder

Using the document feeder, you can load up to 40 sheets of paper (75 g/m?,
20 Ib bond) for one job.

1. Flex or fan the edge of the paper stack to separate the pages before
loading originals.

2. Load the original face up into the document feeder. Make sure that the
bottom of the original stack matches the paper size marked on the
document input tray.

w Dust on the document feeder glass may cause black lines on the
printout. Always keep the glass clean (See "Cleaning the scan
unit" on page 102).

SELECTING PRINT MEDIA

You can print on a variety of print media, such as plain paper, envelopes,
labels, and transparencies. Always use print media that meet the guidelines
for use with your machine.

Guidelines to select the print media

Print media that does not meet the guidelines outlined in this user’s guide
may cause the following problems:

« Poor print quality

* Increased paper jams

* Premature wear on the machine.

Properties, such as weight, composition, grain, and moisture content, are

important factors that affect the machine’s performance and the output

quality. When you choose print materials, consider the following:

* The type, size and weight of the print media for your machine are
described in print media specifications (See "Print media specifications"
on page 124).

» Desired outcome: The print media you choose should be appropriate for
your project.

* Brightness: Some print media are whiter than others and produce
sharper, more vibrant images.

« Surface smoothness: The smoothness of the print media affects how
crisp the printing looks on the paper.

',g « Some print media may meet all of the guidelines in this section and
still not produce satisfactory results. This may be the result of
improper handling, unacceptable temperature and humidity levels,
or other variables over which cannot be controled.

« Before purchasing large quantities of print media, ensure that it
meets the requirements specified in this user’s guide.

A Using print media that does not meet these specifications may cause
problems, requiring repairs. Such repairs are not covered by the
warranty or service agreements.
The amount of paper put into the tray may differ according to media
type used (See "Print media specifications" on page 124).

Media sizes supported in each mode

MODE SIZE SOURCE
Copy mode Letter, A4, Legal, « tray1
Oficio, Folio, «  manual tray
Executive, ISO B5, JIS
B5, A5, A6
Print mode All sizes supported by |+ tray 1
the machine. . manual tray
Fax mode Letter, A4, Legal + tray1

CHANGING THE TRAY SIZE

The tray is preset to Letter or A4 size, depending on your country. To
change the size, you need to adjust the paper guides.
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1 Support guide

2 Paper length guide

3 Guide lock

4 Paper width guide

1. With one hand press and hold the guide lock, and with the other hand,
hold the paper length guide and support guide together. Slide the paper
length guide and support guide to locate them in the correct paper size
slot.

2. Flex or fan the edge of the paper stack to separate the pages before
loading papers. Insert the paper into the tray.

3. After inserting paper into the tray, adjust the support guide so that it
lightly touches the paper stack.

4. Squeeze the paper width guides and slide them to the desired paper
size marked at the bottom of the tray.

"ﬁ * Do not push the paper width guide too far causing the media to
warp.

* If you do not adjust the paper width guide, it may cause paper
jams.

In &] In

* Do not use a paper with more than 6 mm curl.

LOADING PAPER IN THE TRAY

Tray 1

1. Pull out the paper tray. And adjust the tray size to the media size you are
loading (See "Changing the tray size" on page 60).

2. Flex or fan the edge of the paper stack to separate the pages before
loading paper.

4. Insert the tray back into the machine.
5. When you print a document, set the paper type and size for the tray.

For information about setting the paper type and size (See "Setting the
default tray and paper" on page 57).
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'g If you experience problems with paper feeding, check whether the
paper meets the media specification. Then try placing one sheet at
a time in the manual tray (See "Print media specifications" on
page 124).

Manual tray

The manual tray can hold special sizes and types of print material, such as
postcards, note cards, and envelopes. It is useful for single page printing on
letterhead or colored paper.

Tips on using the manual tray

» If you select Manual Feeder for Source from your software
application, you need to press OK each time you print a page and
load only one type, size and weight of print media at a time in the
manual tray.

» To prevent paper jams, do not add paper while printing when there is
still paper in the manual tray. This also applies to other types of print
media.

» Print media should be loaded face up with the top edge going into
the manual tray first and be placed in the center of the tray.

» Always load the specified print media only to avoid paper jams and
print quality problems (See "Print media specifications" on
page 124).

» Flatten any curl on postcards, envelopes, and labels before loading
them into the manual tray.

1. Load the paper in the manual tray.

7
m » Do not force the paper beyond the surface with = mark
when loading.

* When printing the special media, you must follow the
loading guideline (See "Printing on special media" on
page 62).

* When papers overlap when printing using manual tray,
open tray 1 and remove overlapping papers then try
printing again.

* When paper does not feed well while printing, push the
paper in manually until it starts feeding automatically.

2. Squeeze the manual tray paper width guides and adjust them to the
width of the paper. Do not force them too much, or the paper will
bent resulting in a paper jam or skew.

3. To printin application, open an application and start the print menu.

4. Open Printing Preferences (See "Opening printing preferences" on
page 67).

5. Press the Paper tab in Printing Preferences, and select an
appropriate paper type.

For example, if you want to use a label, set the paper type to
Label.
6. Select Manual Feeder in paper source, then press OK.
7. Start printing in application.
w If you are printing multiple pages, load the next sheet after the first

page prints out, and press the OK. Repeat this step for every page
to be printed.

PRINTING ON SPECIAL MEDIA

The table below shows the available special media for each tray.

When using special media, we recommend you feed one paper at a
time. Check the maximum input number of media for each tray (See
"Print media specifications" on page 124).

TYPES TRAY 1 MANUAL TRAY
Plain o °
Thick ° .
Thin . .
Bond °
Color °
CardStock °
Labels °
Transparency °
Envelope °
Preprinted °
Cotton °
Recycled . °
Archive . °

(e: supported, Blank: not supported)

The media types are shown in the Printing Preferences. This paper type
option allows you to set the type of paper to be loaded in the tray. This
setting appears in the list, so that you can select it. This will let you get the
best quality printout. If not, the desired print quality may not be achieved.

+  Plain: 60 to 90 g/m? (16 to 24 Ib) normal plain paper.

+  Thick: 90 to 105 g/m? (24 to 28 Ib) thick paper.

+  Thin: 60 to 70 g/m? (16 to 19 Ib) thin paper.

+ Bond: 105 to 120 g/m? (28 to 32 Ib) bond.

+ Color: 75 to 90 g/m? (20 to 24 Ib) color-backgrounded paper.

« CardStock: 90 to 163 g/m? (24 to 43 Ib) cardstock.

« Labels: 120 to 150 g/m? (32 to 40 Ib) labels.

«  Transparency: 138 to 146 g/m? (37 to 39 Ib) transparency paper.
« Envelope: 75 to 90 g/m? (20 to 24 Ib) envelope.

«  Preprinted: 75 to 90 g/m? (20 to 24 Ib) preprinted/letterhead paper.
«  Cotton: 75 to 90 g/m? (20 to 24 Ib) cotton paper.

+ Recycled: 75 to 90 g/m? (20 to 24 Ib) recycled paper.

When you use recycled paper as a used paper, printouts might be
wrinkled.
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+ Archive: 70to 90 g/m? (19 to 24 Ib). If you need to keep the print-out for
a long period time, such as archives, select this option.

Envelope

Successful printing on envelopes depends upon the quality of the
envelopes.

To print an envelope, the stamp area is on the left side and the end of the
envelope with the stamp area enters the printer first and center of the
manual tray.

If envelopes are printed out with wrinkles, crease or black bold lines, open
the rear cover and pull down the pressure lever and try printing again. Keep
the rear cover opened during printing.

* When selecting envelopes, consider the following factors:
- Weight: The weight of the envelope paper should not exceed
90 g/m? otherwise, jam may occur.

- Construction: Prior to printing, envelopes should lie flat with less
than 6 mm curl, and should not contain air.

- Condition: Envelopes should not be wrinkled, nicked, nor
damaged.

- Temperature: Use envelopes that are compatible with the heat and
pressure of the machine during operation.

« Use only well-constructed envelopes with sharp-and well-creased folds.
« Do not use stamped envelopes.

« Do not use envelopes with clasps, snaps, windows, coated lining,
self-adhesive seals, or other synthetic materials.

« Do not use damaged or poorly made envelopes.

« Be sure the seam at both ends of the envelope extends all the way to
the corner of the envelope.

—’

1 Acceptable
2 Unacceptable

1 Pressure lever

» Envelopes with a peel-off adhesive strip or with more than one flap that
folds over to seal must use adhesives compatible with the machine’s
fusing temperature about 170 °C (338 °F) for 0.1 second. The extra flaps
and strips might cause wrinkling, creasing, or jams, and may even
damage the fuser.

» For the best print quality, position margins no closer than 15 mm (0.59
inches) from the edges of the envelope.

* Avoid printing over the area where the envelope’s seams meet.

Transparency

To avoid damaging the machine, use only transparencies designed for use
in laser printers.

* Transparencies used in the machine must be able to withstand
machine’s fusing temperature.

* Place them on a flat surface after removing them from the machine.

* Do not leave unused transparencies in the paper tray for long periods of
time. Dust and dirt may accumulate on them, resulting in spotty printing.

* To avoid smudging caused by fingerprints, handle them carefully.

* To avoid fading, do not expose printed transparencies to prolonged
sunlight.

« Ensure that transparencies are not wrinkled, curled, or have any torn
edges.

« Do not use transparencies that separates from the backing sheet.

« To prevent transparencies from sticking to each other, do not let the
printed sheets stack up as they are begin printed out.

Labels

To avoid damaging the machine, use only labels designed for use in laser
machines.

* When selecting labels, consider the following factors:

- Adhesives: The adhesive material should be stable at your
machine’s fusing temperature about 170 °C (338 °F).

- Arrangement: Only use labels with no exposed backing between
them. Labels can peel off sheets that have spaces between the
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with no more than 13 mm
of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other
indications of separation.

* Make sure that there is no exposed adhesive material between labels.

Media and tray_ 63



Exposed areas can cause labels to peel off during printing, which can
cause paper jams. Exposed adhesive can also cause damage to
machine components.

+ Do not run a sheet of labels through the machine more than once. The
adhesive backing is designed for only a single pass through the
machine.

« Do not use labels that are separating from the backing sheet or are
wrinkled, bubbled, or otherwise damaged.

Card stock/Custom-sized paper

Postcards, cards and other custom-sized materials can be printed with this
machine.

* Do not print on media smaller than 76 mm (3.00 inches) wide or 127 mm
(5.00 inches) long.

* In the software application, set margins at least 6.4 mm (0.25 inches)
away from the edges of the material.

+  If media weight is over 160 g/m? (43 Ib), try printing in the rear cover
(face up).

Letterhead/ Preprinted paper

SINGLE-SIDED DOUBLE-SIDED

Tray1 Face down Face up

Manual tray | Face up Face down

) TN

« Letterhead/ Preprinted paper must be printed with heat-resistant ink that
will not melt, vaporize, or release hazardous emissions when subjected
to the machine’s fusing temperature for 0.1 second. Check your
machine’s specification to view the fusing temperature about 170 °C
(338 °F).

« Letterhead/ Preprinted paper ink must be non-flammable and should not
adversely affect machine rollers.

* Forms and letterhead should be sealed in a moisture-proof wrapping to
prevent changes during storage.

« Before you load letterhead/preprinted paper, verify that the ink on the
paper is dry. During the fusing process, wet ink can come off preprinted

paper, reducing print quality.

Photo

* Make sure not to use the inkjet photo paper with this machine. It could
cause damage to the machine.

Glossy

',g Load one paper to the manual tray at a time, glossy side facing up.

* Recommended media: Glossy paper (Letter) for this machine by HP
Brochure Paper (Product: Q6611A) only.

* Recommended media: Glossy paper (A4) for this machine by HP
Superior Paper 160 glossy (Product: Q6616A).

SETTING THE PAPER SIZE AND TYPE

After loading paper in the paper tray, set the paper size and type using the

control panel. These settings will apply to copy and fax modes. For

computer printing, select the paper size and type in the application program

you use on your computer (See "Opening printing preferences" on

page 67).

'g The settings made from the machine driver override the settings on
the control panel.

Setting the paper size

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Paper Setup appears and press OK.
Press the left/right arrow until Paper Size appears and press OK.

Press the left/right arrow to select the paper tray you want and press
OK.

Press the left/right arrow to select the paper size you want.
Press OK to save the selection.
Press Stop/Clear to return to ready mode.

g ON=
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',g If you want to use special-sized paper-such as a billing paper, select
Edit... in the Paper tab in the Printing Preferences (See "Opening
printing preferences" on page 67).

Setting the paper type

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Paper Setup appears and press OK.
Press the left/right arrow until Paper Type appears and press OK.

Press the left/right arrow to select the paper tray you want and press
OK.

Press the left/right arrow to select the paper type you want.
Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

oD =
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Setting the paper source

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Paper Setup appears and press OK.
Press the left/right arrow until Paper Source appears and press OK.

Press the left/right arrow until Copy Tray or Fax Tray appears and
press OK.

ahN=
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6. Press the left/right arrow to select the paper tray you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

USING THE OUTPUT SUPPORT

w The surface of the output tray may become hot if you print a large
number of pages at once. Make sure that you do not touch the
surface, and do not allow children near it.

The printed pages stack on the output support, and the output support will
help the printed pages to align. The printer sends output to the output tray
by default. To use the output tray, make sure that the rear cover is closed.

'g If you are using A5 paper, fold the output tray. Otherwise, printed
pages might be mis-aligned or jammed.

Stacking papers firmly

If you use a machine in a humid area, or you are using the damp print media
caused by a high humidity, the print-outs on the output tray may be curled
and may not be stacked properly. In this case, you can set the machine to
use the Paper Stacking function to let print-outs stacked firmly. But, using
this function will make the print speed slow.

1. Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Maintenance appears and press OK.
Press the left/right arrow until Paper Stacking appears and press OK.
Press the left/right arrow until On appears and press OK.

Press Stop/Clear to return to ready mode.

o0l wN

Getting the small sized printout

When you have printed a small sized printout like an envelop or a custom
sized printout, it may not be placed on the output support, due to its small
size.

In this case, get the printout pulling up the scan unit and close it again for
the future use.

After getting a printout, close the scan unit by pressing the scan unit close
button.
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ornting

This chapter explains common printing tasks.

This chapter includes:

« Introducing useful software programs
* Printer driver features

« Basic printing

« Opening printing preferences

« Using help

« Using special print features

',g The procedures in this chapter are mainly based on Windows XP.

INTRODUCING USEFUL SOFTWARE
PROGRAMS

Samsung AnyWeb Print

This tool helps you to screen-capture, preview, scrap and print the screen of
Windows Internet Explorer more easily, than when you use the ordinary
program. Click Start > All programs > Samsung Printers > Samsung
AnyWeb Print > Download the lastest version to link the website where
the tool is available for the download. This tool is available only for Windows
operating systems.

PRINTER DRIVER FEATURES

Your printer drivers support the following standard features:
« Paper orientation, size, source, and media type selection
*  Number of copies

In addition, you can use various special printing features. The following
table shows a general overview of features supported by your printer
drivers:

Some models or operating system may not support the certain
feature(s) in the following table.

» Changing the default print settings

» Setting your machine as a default machine
* Printing to a file (PRN)

* Macintosh printing

* Linux printing

Printer driver

FEATURE WINDOWS
Print quality option °
Booklet printing °
Poster printing °
Multiple pages per sheet °
Fit to page printing °
Reduce and enlarge printing °
Different source for first page °
Watermark °
Overlay °
Double-sided printing (manual) .

(e: supported, Blank: not supported)

BASIC PRINTING

Your machine allows you to print from various Windows, Macintosh, or
Linux applications. The exact steps for printing a document may vary
depending on the application you use.

@ * Your Printing Preferences window that appears in this user’s
guide may differ depending on the machine in use. However, the
composition of the Printing Preferences window is similar. Check
the operating system(s) that are compatible with your machine.
Refer to the OS compatibility section of Printer Specifications (See
"System requirements" on page 32).

* When you select an option in Printing Preferences, you may see

a warning mark (@ or _1 ). An exclamation mark ( 1 ) means
you can select that certain option but it is not recommended, and X

mark (§3) means you cannot select that option due to the
machine’s setting or environment.

The following procedure describes the general steps required for printing
from various Windows applications.

'g Macintosh basic printing (See "Macintosh printing" on page 71).
Linux basic printing (See "Linux printing" on page 72).
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The following Printing Preferences window is for Notepad in Windows XP.

Your Printing Preferences window may differ, depending on your
operating system or the application you are using.

1. Open the document you want to print.

2. Select Print from the File menu. The Print window appears.
3. Select your machine from the Select Printer list.

General

Select Printer

Staus:  Fleady Pt to fie
Location:
Conenert
Page Range
@a Mumber of gopies: [1 &
| :
[

The basic print settings including the number of copies and print range
are selected within the Print window.

',g To take advantage of the printer features provided by your printer
driver, click Properties or Preferences in the application’s Print
window to change the print setting (See "Opening printing
preferences" on page 67).

. To start the print job, click OK or Print in the Print window.

4

',g If you are using Windows Internet Explorer, the Samsung AnyWeb
Print too will save your time for screen-captured images or printing
the image. Click Start > All programs > Samsung Printers >
Samsung AnyWeb Print > Download the latest version to link the
website where the tool is available for the download.

Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as
follows:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.
*  For Windows XP/2003, select Printer and Faxes.

« For Windows 2008/Vista, select Control Panel > Hardware and
Sound > Printers.

* For Windows 7, select Control Panel > Hardware and Sound >
Devices and Printers.

» For Windows Server 2008 R2, select Control Panel > Hardware >
Devices and Printers.

3. For Windows 2000, XP, 2003, Vista and 2008, double-click your
machine.

For Windows 7 and Windows Server 2008 R2, right click your printer
icon > context menus > See what’s printing.

'g If See what’s printing item has » mark, you can select other
printer drivers connected with selected printer.

4. From the Document menu, select Cancel.
[g You can also access this window by simply double-clicking the
machine icon ( @ ) in the Windows task bar.

You can also cancel the current job by pressing Stop/Clear on the
control panel.

OPENING PRINTING PREFERENCES

You can preview the settings you selected on the upper right of the Printing
Preferences.

1. Open the document you want to print.

2. Select Print from the file menu. The Print window appears.
3. Select your machine from the Select Printer.

4. Click Properties or Preferences.

& Printing Preferences
Basic | Paper || Graphics | Advanced | Samsung |

Qrientation | Letter ~ Omm |

= @ Portrait 8.50 % 11.00 inches (2 inch
OlLandscape
[Irotate 180 egrees
Quality
- Ogest
@ Normal
Layouk Options
Trpe _ SogePagePersce v

SAMSUNG

Using a favorite setting

The Presets option, which is visible on each preferences tab except for
Samsung tab, allows you to save the current preferences settings for future
use.

To save a Presets item:
1. Change the settings as needed on each tab.
2. Enter a name for the item in the Presets input box.

Presets

Untitled v
Crigntation: X
Size: x
-4
Al Text Black: X
- Turned On

Printing_ 67



3. Click Add. When you save Presets, all current driver settings are saved.

If you click Add, the Add button changes to Update button. Select more
options and click Update, settings will be added to the Presets you made.

To use a saved setting, select it from the Presets drop down list. The
machine is now set to print according to the setting you selected.

To delete saved setting, select it from the Presets drop down list and click
Delete.

You can also restore the printer driver’s default settings by selecting Default
Preset from the Presets drop down list.

USING HELP

Click the question mark from the upper-right corner of the window and click
on any option you want to know about. Then a pop up window appears with
information about that option's feature which is provided from the driver.

If you want to search information via a keyword, click the Samsung tab in
the Printing Preferences window, and enter a keyword in the input line of
the Help option. To get information about supplies, driver update or
registration and so on, click appropriate buttons.

USING SPECIAL PRINT FEATURES

Special print features include:

« "Printing multiple pages on one sheet of paper" on page 68.
* "Printing posters" on page 68.

* "Printing booklets (Manual)" on page 68.

* "Printing on both sides of paper (Manual)" on page 69.

* "Change percentage of your document" on page 69.

« "Fitting your document to a selected paper size" on page 69.
« "Using watermarks" on page 69.

« "Using overlay" on page 70.

« "Advanced Options" on page 70.

Printing multiple pages on one sheet of paper

You can select the number of pages to print on a single sheet of paper. To
print more than one page per sheet, the pages will be reduced in size and
arranged in the order you specify. You can print up to 16 pages on one
sheet.

1. To change the print settings from your software application, access

Printing Preferences (See "Opening printing preferences" on page 67).

2. Click the Basic tab, select Multiple Pages per Side in the Type
drop-down list.

3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16)
in the Pages per Side drop-down list.

4. Select the page order from the Page Order drop-down list, if necessary.

5. Check Print Page Border to print a border around each page on the
sheet.

6. Click the Paper tab, select the Size, Source, and Type.
7. Click OK or Print until you exit the Print window.

Printing posters

This feature allows you to print a single-page document onto 4, 9, or 16
sheets of paper, for the purpose of pasting the sheets together to form one
poster-size document.

ald
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— A 3x3
1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on page 67).
2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.
Specification of the page layout:
* Poster 2x2: Document will be enlarged and be divided into 4 pages.
» Poster 3x3: Document will be enlarged and be divided into 9 pages.
» Poster 4x4: Document will be enlarged and be divided into 16
pages.
4. Select the Poster Overlap value. Specify Poster Overlap in millimeters
or inches by selecting the radio button on the upper right of Basic tab to
make it easier to paste the sheets together.

<10 mm

10 mm

5. Click the Paper tab, select the Size, Source, and Type.
6. Click OK or Print until you exit the Print window.
7. You can complete the poster by pasting the sheets together.

Printing booklets (Manual)

This feature prints your document on both sides of a paper and arranges the
pages so that the paper can be folded in half after printing to produce a
booklet.

',ﬁ If you want to make a booklet, you need to print on Letter, Legal, A4,
Us Folio, or Oficio sized print media.

1. To change the print settings from your software application, access the
Printing Preferences (See "Opening printing preferences” on page 67).

2. Click the Basic tab, select Booklet Printing from the Type drop-down
list.

3. Click the Paper tab, select the Size, Source, and Type.
[,g The Booklet Printing option is not available for all paper sizes. In

order to find out the available paper size for this feature, select the
available paper size in the Size option on the Paper tab.

If you select an unavailable paper size, this option can be
automatically canceled. Select only available paper (paper without

1. Or g3 mark).
4. Click OK or Print until you exit the Print window.
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5. After printing, fold and staple the pages.

Printing on both sides of paper (Manual)

You can print on both sides of a paper; duplex. Before printing, decide how

you want your document oriented. You can use this feature with Letter,

Legal, A4, US Folio, or Oficio sized paper (See "Print media specifications"

on page 124).

We recommend not to print on both sides of a special media, such as
labels, envelopes, or thick paper to print on both sides of paper. It may
cause a paper jam or damage the machine.

1. To change the print settings from your software application, access

Printing Preferences (See "Opening printing preferences" on page 67).

2. Click the Advance tab.

3. From the Double-Sided Printing (Manual) section, select the binding
option you want.

* None
+ Long Edge: This option is the conventional layout used in
bookbinding.

» Short Edge: This option is the conventional layout used in
calendars.

4. Click the Paper tab, select the Size, Source, and Type.
5. Click OK or Print until you exit the Print window.

w If your machine does not have a duplex unit, you should complete the
printing job manually. The machine prints every other page of the
document first. After that, a message appears on your computer.
Follow the on-screen instructions to complete the printing job.

Change percentage of your document

You can change the size of a document to appear larger or smaller on the
printed page by typing in a percentage you want.

gfd o

1. To change the print settings from your software application, access

Printing Preferences (See "Opening printing preferences" on page 67).

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.
You can also click the up/down arrows to select the scaling rate.
4. Select the Size, Source, and Type in Paper Options.
5. Click OK or Print until you exit the Print window.

Fitting your document to a selected paper size

This printer feature allows you to scale your print job to any selected paper
size regardless of the document size. This can be useful when you want to
check fine details on a small document.

f
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To change the print settings from your software application, access

1.
Printing Preferences (See "Opening printing preferences" on page 67).
2. Click the Paper tab.
3. Select the paper size you want from the Fit to page.
4. Select the Size, Source, and Type in Paper Options.

5. Click OK or Print until you exit the Print window.

Using watermarks

The watermark option allows you to print text over an existing document.
For example, you use it when you want to have large gray letters reading
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all
pages of a document.

Al>LA

There are several predefined watermarks that come with the machine. They
can be modified, or you can add new ones to the list.

Using an existing watermark

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 67).

2. Click the Advanced tab, and select the desired watermark from the
Watermark drop-down list. You will see the selected watermark in
the preview image.

3. Click OK or Print until you exit the print window.

Creating a watermark

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 67).

2. From the Advanced tab, select Edit from the Watermark drop-down
list. The Edit Watermarks window appears.

3. Enter a text message in the Watermark Message box. You can
enter up to 256 characters. The message displays in the preview
window.

When the First Page Only box is checked, the watermark prints on
the first page only.

4. Select watermark options.

You can select the font name, style, size, and shade from the Font
Attributes section, as well as set the angle of the watermark from
the Message Angle section.

5. Click Add to add a new watermark to the Current Watermarks list.
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6. When you have finished editing, click OK or Print until you exit the
Print window.

To stop printing the watermark, select None from the Watermark

drop-down list.

Editing a watermark

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 67).

2. Click the Advanced tab, select Edit from the Watermark drop-down
list. The Edit Watermarks window appears.

3. Select the watermark you want to edit from the Current Watermarks
list and change the watermark message and options.

4. Click Update to save the changes.
5. Click OK or Print until you exit the Print window.

Deleting a watermark

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 67).

2. Click the Advanced tab, select Edit from the Watermark drop-down
list. The Edit Watermarks window appears.

3. Select the watermark you want to delete from the Current
Watermarks list and click Delete.

4. Click OK or Print until you exit the Print window.

Using overlay

An overlay is text and/or images stored in the computer hard disk drive
(HDD) as a special file format that can be printed on any document.
Overlays are often used to take the place of letterhead paper. Rather than
using preprinted letterhead, you can create an overlay containing exactly
the same information that is currently on your letterhead. To print a letter
with your company’s letterhead, you do not need to load preprinted
letterhead paper in the machine just print the letterhead overlay on your
document.

AA
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Creating a new page overlay
To use a page overlay, you must create a new page overlay containing
your logo or image.

1. Create or open a document containing text or an image for use in a
new page overlay. Position the items exactly as you wish them to
appear when printed as an overlay.

2. To save the document as an overlay, access Printing Preferences
(See "Opening printing preferences" on page 67).

3. Click the Advanced tab, and select Edit from the Text drop-down
list. Edit Overlay window appears.

4. In the Edit Overlay window, click Create.

5. Inthe Save As window, type a name of up to eight characters in the
File name box. Select the destination path, if necessary (The default
is C:\Formover).

6. Click Save. The name appears on the Overlay List.
7. Click OK or Print until you exit the Print window.

8. Thefile is not printed. Instead, it is stored on your computer hard disk
drive.

The overlay document size must be the same as the document
you print with the overlay. Do not create an overlay with a
watermark.

Using a page overlay

After an overlay has been created, it is ready to be printed with your

document. To print an overlay with a document:

1. Create or open the document you want to print.

2. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on
page 67).

3. Click the Advanced tab.

Select the desired overlay from the Text drop-down list.

5. If the overlay file you want does not appear in theText drop-down
list, select Edit from the list and click Load. Select the overlay file
you want to use.

If you have stored the overlay file you want to use in an external
source, you can also load the file when you access the Open
window.

After you select the file, click Open. The file appears in the Overlay
List box and is available for printing. Select the overlay from the
Overlay List box.

6. If necessary, check Confirm Page Overlay When Printing box. If
this box is checked, a message window appears each time you
submit a document for printing, asking you to confirm your wish to
print an overlay on your document.

If this box is not checked and an overlay has been selected, the
overlay automatically prints with your document.

7. Click OK or Print until you exit the Print window.
The selected overlay prints on your document.

>

w The resolution of the overlay document must be the same as that
of the document you will print with the overlay.

Deleting a page overlay

You can delete page overlays that you no longer use.

In the Printing Preferences window, click the Advanced tab.
Select Edit in the Overlay drop down list.

Select the overlay you want to delete from the Overlay List box.
Click Delete.

When a confirming message window appears, click Yes.

Click OK or Print until you exit the Print window.

o hON =2

Advanced Options
Use the following Graphics options to adjust the print quality for your
specific printing needs.

',g If the option is grayed out or not shown, that option is not applicable
with the printer language you are using.

1. To change the print settings from your software application, access
Printing Preferences (See "Opening printing preferences" on page 67).
2. Click the Graphics tab.

'g Refer to the online help for each option’s information provided from
the Printing Preferences.

* Font/Text: Select Darken Text to print texts darker than on a
normal document. Use All Text Black to prints solid black,
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regardless of the color it appears on the screen.

» Graphic Controller: Fine Edge allows user to emphasize edges of
texts and fine lines for improving readability.

» Toner Save Mode: Selecting this option extends the life of your
toner cartridge and reduces your cost per page without a significant
reduction in print quality.

- On: Select this option to allow the printer to use less toner on
each page.
- Off: If you do not need to save toner when printing a document,
select this option.
3. Click OK or Print until you exit the Print window.

CHANGING THE DEFAULT PRINT SETTINGS

1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.
« For Windows XP/2003, select Printer and Faxes.

«  For Windows 2008/Vista, select Control Panel > Hardware and
Sound > Printers.

*  For Windows 7, select Control Panel > Hardware and Sound >
Devices and Printers.

*  For Windows Server 2008 R2, select Control Panel > Hardware >
Devices and Printers.
3. Right-click your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.
For Windows 7 and Windows Server 2008 R2, from context menus,
select the Printing preferences.

',g If Printing preferences item has » mark, you can select other
printer drivers connected with selected printer.

5. Change the settings on each tab.
6. Click OK.

'g If you want to change the settings for each print job, change it in
Printing Preferences.

SETTING YOUR MACHINE AS A DEFAULT
MACHINE

1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.
« For Windows XP/2003, select Printer and Faxes.

« For Windows 2008/Vista, select Control Panel > Hardware and
Sound > Printers.

« For Windows 7, select Control Panel > Hardware and Sound >
Devices and Printers.

« For Windows Server 2008 R2, select Control Panel > Hardware >
Devices and Printers.

3. Select your machine.
4. Right-click your machine and select Set as Default Printer.
For Windows 7 and Windows Server 2008 R2

If Set as default printer item has » mark, you can select other
printer drivers connected with selected printer.

PRINTING TO A FILE (PRN)

You will sometimes need to save the print data as a file.

To create a file:
1. Check the Print to file box at the Print window.
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2. Click Print.

3. Type in the destination path and the file name, and then click OK. For
example c:\Templ\file name.

w If you type in only the file name, the file is automatically saved in
My Documents.

MACINTOSH PRINTING

This section explains how to print using Macintosh. You need to set the print
environment before printing.

* USB connected (See "Macintosh" on page 34).

* Network connected (See "Macintosh" on page 40).

Printing a document

When you print with a Macintosh, you need to check the printer driver
setting in each application you use. Follow the steps below to print from a
Macintosh:

1. Open the document you want to print.

2. Open the File menu and click Page Setup.

3. Choose your paper size, orientation, scaling, other options, and make
sure that your machine is selected. Click OK.

Settings: [ Page Attributes H-‘
Format for: [ H
Paper Size: A4 H-‘

20.99 by 28.70 cm

Orientation: @

Scale: | 100 %

@ (Conee) @06

4. Open the File menu and click Print.

5. Choose the number of copies you want and indicate which pages you
want to print.

6. Click Print.

Printing_ 71



Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine
name, which appears in the printer properties pane may differ depending on
the machine in use. Except for the name, the composition of the printer
properties pane is similar to the following.
'g + The §etting options may differ depending on printers and Mac OS
version.
* The following pane may differ, depending on your operating
system or the application you are using.

The following pane is the first pane you will see when you open the printer
properties pane. Select other advanced features from the drop down list.

Prinner: ZIC]
resets: | Standard ]
Copies: [I____| W Collated [ Two-Sded

Pages: @ All
OFrom: 1 w01

Paper Size: | A4 E 2099 by 29.70om
Oriantation: (11 [0
:
1 Print header and footer

Lofl [Coren)

@ (CPoFr) (Supplies) (Cancel ) (Shrime=)

Layout

The Layout tab provides options to adjust how the document appears

on the printed page. You can print multiple pages on one sheet of paper.

Select Layout from the drop-down list under Orientation to access the

following features.

* Pages per Sheet: This option determines how many pages to be
printed on one page (See "Printing multiple pages on one sheet of
paper" on page 72).

» Layout Direction: This option allows you to select the printing
direction on a page similar to the examples on Ul.

» Border: This option allows you to print a border around each page
on the sheet.

» Reverse Page Orientation: This option allows you to rotate paper
180 degrees.

Graphics

The Graphics tab provides options for selecting Resolution. Select

Graphics from the drop-down list under Orientation to access the

graphic features.

* Resolution (Quality): This option allows you to select the printing
resolution. The higher the setting, the sharper the clarity of printed
characters and graphics. The higher setting also may increase the
time it takes to print a document.

Paper

Set Paper Type to correspond to the paper loaded in the tray from
which you want to print. This will let you get the best quality printout. If
you load a different type of print material, select the corresponding paper
type.

Printer Settings

Printer Settings tab provides Toner Save Mode options. Select Printer
Settings from the drop-down list under Orientation to access the
following features:

*  Toner Save Mode: Selecting this option extends the life of your
toner cartridge and reduces your cost per page without a significant
reduction in print quality.

- On: Select this option to allow the printer to use less toner on
each page.

- Off: If you do not need to save toner when printing a document,
select this option.

Printing multiple pages on one sheet of paper

You can print more than one page on a single sheet of paper. This feature

provides a cost-effective way to print draft pages.

1. Open an application, and select Print from the File menu.

2. Select Layout from the drop-down list under Orientation. In the Pages
per Sheet drop-down list, select the number of pages you want to print
on one sheet of paper.

vt @

Presets: [Standard ]
Copies: [1___] ©f Collated () Two-Sided
Pages: @Al &
Orom: 1 o1
Paper Size: | A4 8] 2o sroem
Orentation: E 1s
[arour 2]

Pages par Shaat: | 6 E
wreneoneann [2] 5] (a0
sorder: (bone =
Two-Sided: u

" Raverse Page Orientasion

® Crorr) Gosin) () (@)

3. Select the other options you want to use.
4. Click Print, then the machine prints the selected number of pages you
want to print on one sheet of paper.

LINUX PRINTING

Printing from applications

There are a lot of Linux applications that allow you to print using Common
UNIX Printing System (CUPS). You can print on your machine from any
such application.

1. Open an application, and select Print from the File menu.
2. Select Print directly using Ipr.
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3. Inthe LPR GUI window, select the model name of your machine from
the printer list and click Properties.

~Printer
Properies...

Status: idle, accepting jobs
Start

Location:

Description; Setas User Default
—Page Selecti opl

4 Allpages Coples (1-100) [ 3]
~ Evenpages M Collate coples

~ Odd pages _| Raverse All Pages (32,1)

Entar page numbers and‘or groups of pages to print separated
by commas (1,2-5,10-12,17).

e ‘
7

L EE e

4. Change the print job properties using the following four tabs displayed at
the top of the window.

» General: This option allows you to change the paper size, the paper
type, and the orientation of the documents. It enables the duplex
feature, adds start and end banners, and changes the number of
pages per sheet.

» Text: This option allows you to specify the page margins and set the
text options, such as spacing or columns.

» Graphics: This option allows you to set image options that are used
when printing image files, such as color options, image size, or
image position.

» Advanced: This option allows you to set the print resolution, paper,
source and special print features.

',g If an option is grayed out, it means that the grayed out option is not
supported.

5. Click Apply to apply the changes and close the Properties window.

6. Click OK in the LPR GUI window to start printing.

7. The Printing window appears, allowing you to monitor the status of your
print job.
To abort the current job, click Cancel.

Printing files

You can print many different types of files on your machine using the
standard CUPS way, directly from the command line interface. The CUPS
Ipr utility allows you to do that. But the drivers package replaces the
standard Ipr tool by a much more user-friendly LPR GUI program.

To print any document file:

1. Type Ipr <file_name> from the Linux shell command line and press
Enter. The LPR GUI window appears.
When you type only Ipr and press Enter, the Select file(s) to print
window appears first. Just select any files you want to print and click
Open.

2. In the LPR GUI window, select your machine from the list, and change
the print job properties.

3. Click OK to start printing.

Configuring Printer Properties
Using the Printer Properties window provided by the Printers
configuration, you can change the various properties for your machine as
a printer.
1. Open the Unified Driver Configurator.
If necessary, switch to Printers configuration.

2. Select your machine on the available printers list and click Properties.
3. The Printer Properties window opens.
- Printer Properties x

General | Connecton | Drver | Jobs | Classes |

Nama:

Locason

Dascription:

Help sy |[ v | camat |

The following five tabs display at the top of the window:

» General: This option allows you to change the printer location and
name. The name entered in this tab displays on the printer list in
Printers configuration.

+ Connection: This option allows you to view or select another port. If
you change the machine port from USB to parallel or vice versa
while in use, you must re-configure the machine port in this tab.

* Driver: This option allows you to view or select another machine
driver. By clicking Options, you can set the default device options.

» Jobs: This option shows the list of print jobs. Click Cancel job to
cancel the selected job and select the Show completed jobs check
box to see previous jobs on the job list.

+ Classes: This option shows the class that your machine is in. Click
Add to Class to add your machine to a specific class or click
Remove from Class to remove the machine from the selected
class.

4. Click OK to apply the changes and close the Printer Properties
window.
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copying

This chapter gives you step-by-step instructions for copying documents.

This chapter includes:

« Basic copy
« Changing the settings for each copy
« Changing the default copy settings

Supported optional devices and features may differ according to your
model. Please check your model name.

(See "Features by Models" on page 25).

BASIC COPY

This is the normal and usual procedure for copying your originals.

1. Press (Copy) on the control panel.

2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

(See "On the scanner glass" on page 59 or "In the document feeder" on
page 60).

3. If necessary, adjust the settings for each copy such as Reduce/Enlarge,
Darkness, Original Type and more (See "Changing the settings for
each copy" on page 74).

4. Enter the number of copies using the arrow or number keypad, if
necessary.

5. Press Start on the control panel to begin copying.
'g To cancel the current copy job, press Stop/Clear on the control panel.

CHANGING THE SETTINGS FOR EACH COPY

Your machine provides default settings for copying so that you can quickly
and easily make a copy. However, if you want to change the options for
each copy, use the copy function buttons on the control panel.

[g If you press Stop/Clear while setting the copy options, all of the
options you have set for the current copy job will be canceled and
return to their default status after the machine completes the copy in
progress.

Changing the darkness
If you have an original containing faint marking and dark images, you can
adjust the brightness to make a copy that is easier to read.

Press (Copy) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Copy Feature appears and press OK.
Press the left/right arrow until Darkness appears and press OK.

Press the left/right arrow until the contrast mode you want appears and
press OK.

* Light: Works well with dark print.

* Lightest: Works well with darker print.

* Normal: Works well with standard typed or printed originals.
* Dark: Works well with light print.

apON =

» Using special copy features
» Deciding the form of copy output
» Setting copy timeout

+ Darkest: Works well with lighter print or faint pencil markings.
6. Press Stop/Clear to return to ready mode.

Selecting the type of originals
The original type setting is used to improve the copy quality by selecting the
document type for the current copy job.

1. Press (Copy) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Copy Feature appears and press OK.
Press the left/right arrow until Original Type appears and press OK.

Press the left/right arrow until the image mode you want appears and
press OK.

+ Text: Use for originals containing mostly text.
+ Text/Photo: Use for originals with mixed text and photographs.
* Photo: Use when the originals are photographs.

6. Press Stop/Clear to return to ready mode.

ok oN

Reducing or enlarging copies
You can reduce or enlarge the size of a copied image from 25% to 400%

when you copy original documents from the scanner glass, or from 25% to
100% from the ADF.

To select from the predefined copy sizes:

1. Press (Copy) on the control panel.

2. Press Menu on the control panel.

3. Press the left/right arrow until Copy Feature appears and press OK.
4

. Press the left/right arrow until Reduce/Enlarge appears and press
OK.

5. Press the left/right arrow until the size setting you want appears and
press OK.

6. Press Stop/Clear to return to ready mode.

To scale the copy by directly entering the scale rate:
1. Press (Copy) on the control panel.
. Press Menu on the control panel.

2
3. Press the left/right arrow until Copy Feature appears and press OK.
4

. Press the left/right arrow until Reduce/Enlarge appears and press
OK.

Press the left/right arrow until Custom appears and press OK.

Press the left/right arrow or numeric keypad to enter the copy size
you want. Pressing and holding the left/right arrow allows you to
quickly scroll to the number you want.

7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

o a
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When you make a reduced copy, black lines may appear at the
bottom of your copy.

CHANGING THE DEFAULT COPY SETTINGS

The copy options, including darkness, original type, copy size, collation and
number of copies, can be set to those most frequently used. When you copy
a document, the default settings are used unless they have been changed
by using the corresponding buttons on the control panel.

1. Press (Copy) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Copy Setup appears and press OK.
Press the left/right arrow until Change Default appears and press OK.

Press the left/right arrow until the setup option you want appears and
press OK.

Press the left/right arrow until the setting you want appears and press
OK.

7. Repeat steps 5 through 6, as needed.
Press Stop/Clear to return to ready mode.

o poON

o

8.
While you are setting copy options, pressing Stop/Clear cancels the
changed settings and restores the defaults.

USING SPECIAL COPY FEATURES

You can use the following copy features:

ID card copying

Your machine can print 2-sided originals on one sheet of A4-, Letter-,
Legal-, Folio-, Executive-, B5, A5, or A6-sized paper.

The machine prints one side of the original on the upper half of the paper
and the other side on the lower half without reducing the size of the original.
This feature is helpful for copying a small-sized item, such as a business

card.
C
=

w » This copy feature is available only when you place originals on the
scanner glass.

* The size of the 2-sided originals should be smaller than A5, if not,
some of it won’t be copied.
1. Press ID Copy on the control panel.
2. Place Front Side and Press [Start] appears on the display.

3. Place the front side of an original facing down on the scanner glass
where arrows indicate as shown, and close the scanner lid.

N

4. Press OK on the control panel.

Your machine begins scanning the front side and shows Place Back
Side and Press [Start].

5. Turn the original over and place it on the scanner glass, where arrows
indicate as shown then, close the scanner lid.

N

« L4

L L

6. Press OK on the control panel to begin copying.
Fﬁ « If the original is larger than the printable area, some portions may
not be printed.
« If you don't press the OK button, only the front side will be copied.

< If you press Stop/Clear, the machine cancles the copy job and
returns to ready mode.

2-up or 4-up copying (N-up)
The machine reduces the size of the original images and prints 2 or 4 pages
onto one sheet of paper.

i
1

Press (Copy) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Copy Feature appears and press OK.
Press the left/right arrow until Layout appears and press OK.

Press the left/right arrow until 2-Up or 4-Up appears and press OK.
When Yes appears, press OK.

. Press Start on the control panel to begin copying.

Nooahrob =

',g You cannot adjust the copy size using Reduce/Enlarge for the N-Up
feature.

Poster copying
Your original will be divided into 9 portions. You can paste the printed pages
together to make one poster-sized document.

This copy feature is available only when you place originals on the scanner
glass.

PIVN

)
A4

A 3x3
Press (Copy) on the control panel.
Press Menu on the control panel.
Press the left/right arrow until Copy Feature appears and press OK.
Press the left/right arrow until Layout appears and press OK.
Press the left/right arrow until Poster Copy appears and press OK.
Press Stop/Clear to return to ready mode.
Press Start on the control panel to begin copying.

Noahrob =

@ Your original is divided into 9 portions. Each portion is scanned and
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printed one by one in the following order:

1 2 3
4 5 6
7 8 9

Clone copying

The machine prints multiple original images on a single page. The number

of images is automatically determined by the original image and the paper

size.

This copy feature is available only when you place originals on the scanner
glass.

£ L

9 ﬁ £ X

Press (Copy) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Copy Feature appears and press OK.
Press the left/right arrow until Layout appears and press OK.

Press the left/right arrow until Clone Copy appears and press OK.
When Yes appears, press OK.

Press Start on the control panel to begin copying.

Nooapwd =

'g You cannot adjust the copy size using Reduce/Enlarge for the Clone
Copy feature.

Erasing background images

This feature is helpful when copying originals containing color in the
background, as in newspapers or catalogs.

1. Press (Copy) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Copy Feature appears and press OK.
Press the left/right arrow until Adjust Bkgd. appears and press OK.
Press the left/right arrow until the binding option you want appears.
+ Off: Disables this feature.

+ Auto: Optimizes the background.

* Enhance: The higher the number is, the more vivid the background
is.

» Erase: The higher the number is, the lighter the background is.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

apoeN

DECIDING THE FORM OF COPY OUTPUT

You can set the machine to sort the copy job. For example, if you make 2
copies of a 3 page original, one complete 3 page document will print
followed by a second complete document.

1. Press (Copy) on the control panel.

2. Place originals, face up, in the document feeder. Or you can use the
scanner glass with a single original document face down and closed the
scanner lid.

3. Press OK and enter the number of copies using the left/right arrow or
numeric keypad.

Press Menu on the control panel.

Press the left/right arrow until Copy Setup appears and press OK.
Press the left/right arrow until Change Default appears and press OK.
Press the left/right arrow until Copy Collation appears and press OK.
Press the left/right arrow until On appears and press OK.

* On: Prints output in sets to match the sequence of originals.

©No oA

« Off: Prints output sorted into stacks of individual pages.
3 5

9. Press Stop/Clear to return to ready mode.

10. Press Start to begin copying.

One complete document will print followed by the second complete
document.

SETTING COPY TIMEOUT

You can set the time the machine waits before it restores the default copy
settings, if you do not start copying after changing them on the control
panel.

1. Press Menu on the control panel.

2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Machine Setup appears and press OK.
4. Press the left/right arrow until Timeout appears and press OK.
5. Press the left/right arrow until the time setting you want appears.

Selecting Off means that the machine does not restore the default
settings until you press Start to begin copying, or Stop/Clear to cancel.

6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.
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scanning

Scanning with your machine lets you turn pictures and text into digital files that can be stored on your computer.

This chapter includes:

« Basic scanning method .

« Scanning originals and sending to your computer (Scan to PC) .

« Using Samsung Scan Manager .

« Scanning with TWAIN-enabled software

w The ma)gimum resolution that can be aghieved_ depends upon various 1.
factors, including computer speed, available disk space, memory, the

size of the image being scanned, and bit depth settings. Thus, 2.
depending on your system and what you are scanning, you may not
be able to scan at certain resolutions, especially using enhanced

resolution.
3.
',g Supported optional devices and features may differ according to your 4
model. Please check your model name. '
(See "Features by Models" on page 25). 5.
BASIC SCANNING METHOD 6.

You can scan the originals with your machine via an USB cable or the

network.

« Samsung Scan and Fax Manager: Scan the originals from the control
panel. Then, the scanned data will be stored in the connected
computers My Documents folder. When you install all the software in
the supplied CD, the Samsung Scan Manager is also automatically 7.
installed on your computer. This feature can be used via the local
connection or the network connection (See "Using Samsung Scan
Manager" on page 78).

«  TWAIN: TWAIN is the one of a preset imaging applications. Scanning
an image launches the selected application, enabling you to control the
scanning process. This feature can be used via the local connection or
the network connection (See "Scanning with TWAIN-enabled software"
on page 79).

¢ SmarThru: This program is the accompanying software for your
machine. You can use this program to scan images or documents. This
feature can be used via the local connection or the network connection 8
(See "Smarthru" on page 97).

«  WIA: WIA stands for Windows Images Acquisition. To use this feature,
your computer must be connected directly with the machine via an USB
cable (See "Scanning using the WIA driver" on page 79).

SCANNING ORIGINALS AND SENDING TO
YOUR COMPUTER (SCAN TO PC)

Scanning using the WIA driver
Macintosh scanning
Linux Scanning

Make sure that the machine is connected to your computer and powered
on.

Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

(See "Loading originals" on page 59).

Press @(Scan) on the control panel.

Press the left/right arrow until Scan To PC appears and press OK.
Press the left/right arrow until Local PC appears and press OK.

w If you see Not Available message, check the port connection.

Press the left/right arrow until the application program you want appears
and press OK.

Default setting is My Documents.
'g To add or delete the folder where the scanned file is saved, add or

delete the application program in Samsung Scan and Fax
Manager > Properties > Set Scan Button.

Press the left/right arrow until the setting you want appears and press
OK.

* Resolution: Sets the image resolution.

* Scan Color: Sets the color mode.

* Scan Format: Sets the file format in which the image is to be saved.
* Scan Size: Sets the image size.

w * Scan Format appears only when you selected the Scan
destination to My Documents.

* If you want to scan from the default setting, press Start.

. Scanning begins.

w * Scanned image is saved in computer's My Documents > My
Pictures > Samsung folder.

* You can use Twain driver to scan quickly in Samsung Scan
and Fax Manager program.

* You can also scan by pressing Window’s Start > Control
Panel > Samsung Scan and Fax Manager > Quick Scan.

You can scan an image on the machine via the Samsung Scan Manager For network connected machine

program that is installed in your networked computer. Make sure the printer driver is installed on your computer using the software
. CD, since the printer driver includes the scan program (See "Installing wired

For USB connected machine network connected machine’s driver" on page 39).

This is a basic scanning method for usb connected machine. 1. Make sure that your machine and the computer are connected to a

2.
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3. Press @(Scan) on the control panel.

Press the left/right arrow until Scan To PC appears and press OK.
5. Press the left/right arrow until Network PC appears and press OK.

>

’Q If you see Not Available message, check the port connection.

6. Select your registered computer ID, and enter the Password if
necessary.

',g * IDis the same ID as the registered Computer ID for Samsung
Scan and Fax Manager.

* Password is the 4 digit number registered Password for
Samsung Scan Manager.

7. Press the left/right arrow until the application program you want appears
and press OK.

Default setting is My Documents.
'Q To add or delete the folder where the scanned file is saved, add or

delete the application program in Samsung Scan and Fax
Manager > Properties > Set Scan Button.

8. Press the left/right arrow until the setting you want appears and press
OK.
* Resolution: Sets the image resolution.
* Scan Color: Sets the color mode.

» Scan Format: Sets the file format in which the image is to be saved.

+ Scan Size: Sets the image size.

’Q » Scan Format appears only when you selected the Scan
destination to My Documents.

* If you want to scan from the default setting, press Start.

9. Scanning begins.

',g « Scanned image is saved in computer's My Documents > My
Pictures > Samsung folder.

* You can use Twain driver to scan quickly in Samsung Scan
and Fax Manager program.

* You can also scan by pressing Window’s Start > Control
Panel > Samsung Scan and Fax Manager > Quick Scan.

USING SAMSUNG SCAN MANAGER

If you have installed the printer driver, the Samsung Scan Manager program
is installed too. Start Samsung Scan Manager program to find out about this
program information and the installed scan driver's condition. Through this
program, you can change scan settings and add or delete the folders where
scanned documents are saved in your computer.

[,g The Samsung Scan Manager program can only be used in the
Windows and Mac OS system. If you use the Macintosh, See "Setting
scan information in Scan Manager" on page 80.

1. From the Start menu, click Control Panel > Samsung Scan and Fax
Manager.

'Q You can open Samsung Scan Manager by right clicking the Smart
Panel icon in the Windows task bar and selecting Scan Manager.

2. Select the appropriate machine from the Samsung Scan Manager
window.

3. Press Properties.

4. The Set Scan Button tab allows you to change the saving destination
and scan settings, add or delete application program, and format files.

You can change the scanning machine by using the Change Port tab
(Local or Network).

5. When setting is done, press OK.

Set Scan Button tab
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Scan Destination

+ Available Destination List: Shows the list of applications currently
linked to scanned images in the PC’s registry. Select the program
you want to use and click the right arrow and add to Front Panel
Destination List.

* Front Panel Destination List: Shows the list of applications to
open scanned image.

* Add Application: Allows you to add application you want to use to
Available Destination List,

» Remove Application: Allows you to remove an item added by the
user in the Available Destination List.

» File Format: Allows you to select the form of scanned data to be
saved. You can choose among BMP, JPEG, PDF, and TIFF.

Scan Property

+ Computer ID: Shows the ID of your computer.

+ Save Location: Allows you to choose the location of the default
saving folder.

* Resolution: Allows you to choose the scan resolution.

* Scan Color: Allows you to choose the scan color.

» Scan Size: Allows you to choose the scan size.

» ADF Duplex: Automatically scans both sides. If your model does
not support this option, it will be grayed out.

» Show Preview: Checking this box allows you to preview applied
scan options. You can modify the options before scanning.

» Default: Allows you to go back to default options.
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Local Scanner
Select when your machine is connected via USB or LPT port.

Network Scanner
Select when your machine is connected via network port.

» Auto detection on the network: Automatically detects your
machine.

» |IP address: Enterin your machine’s IP address to detect your
machine.

SCANNING WITH TWAIN-ENABLED SOFTWARE

If you want to scan documents using other software, you will need to use

TWAIN-compliant software, such as Adobe Photoshop.

Follow the steps below to scan with TWAIN-compliant software:

1. Make sure that the machine is connected to your computer and powered
on.

2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

(See "Loading originals" on page 59).
3. Open an application, such as Adobe Photoshop.
Open the TWAIN window and set the scan options.
5. Scan and save your scanned image.

>

SCANNING USING THE WIA DRIVER

Your machine also supports the Windows Image Acquisition (WIA) driver for
scanning images. WIA is one of the standard components provided by
Microsoft Windows XP and works with digital cameras and scanners. Unlike
the TWAIN driver, the WIA driver allows you to scan and easily adjust
images without using additional software.

',g The WIA driver works only on Windows XP/Vista with a USB port.

Windows XP

1. Make sure that the machine is connected to your computer and powered
on.

2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

(See "Loading originals" on page 59).

3. From the Start menu, select Control Panel, > Scanners and Cameras.

4. Double click your scanner driver icon. The Scanner and Camera
wizard appears.

5. Click Next.

6. Set the option in Choose scanning preferences window and click
Preview to see how your options affect the picture.

7. Click Next.

8. Enter a picture name, and select a file format and destination to save the
picture.

9. Your picture has been successfully copied to your computer. Choose
one of the options on screen.

10. Click Next.

11. Click Finish.

Windows Vista
1. Make sure that the machine is connected to your computer and powered
on.

2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.
(See "Loading originals" on page 59).
3. From the Start menu select Control Panel > Hardware and Sound >
Scanners and Cameras.
4. Double click Scan a document or picture. Windows Fax and Scan
application appears.
@ * You can click on View scanners and cameras to view
scanners,
» If there is no Scan a document or picture, open the MS paint
program and from the File click From Scanner or Camera...
5. Click New Scan. Scan driver appears.

6. Choose your scanning preferences and click Preview to see your
preferences affect the picture.

7. Click Scan.

'g If you want to cancel the scan job, press the Cancel button on the
Scanner and Camera wizard.

Windows 7

1. Make sure that the machine is connected to your computer and powered
on.

2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass
(See "Loading originals" on page 59).

3. From the Start menu select Control Panel > Hardware and Sound >
Devices and Printers.

4. Click right button of mouse on device driver icon in Printers and Faxes
> Start Scan. New Scan application appears.

5. Choose your scanning preferences and click Preview to see your
preferences affect the picture.

6. Click Scan.

MACINTOSH SCANNING

You can scan documents using Image Capture program. Mac OS offers
Image Capture program.
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Scanning with USB

1.

2.

Make sure that the machine is connected to your computer and powered
on.

Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

(See "Loading originals" on page 59).
Start Applications and click Image Capture.
m If No Image Capture device connected message appears,

disconnect the USB cable and reconnect it. If the problem
continues, refer to the Image Capture’s help.

Set the scan options on this program.

. Scan and save your scanned image.

’,ﬁ » For more information about using Image Capture, refer to the

Image Capture’s help.

« Use TWAIN-compliant software to apply more scan options.

* You can also scan using TWAIN-compliant software, such as
Adobe Photoshop.

» Scan process differ according to TWAIN-compliant software.
Please refer to the user’s guide of the software.

+ If scanning does not operate in Image Capture, update Mac OS to
the latest version. Image Capture operates properly in Mac OS X
10.3.9 or higher and Mac OS X 10.4.7 or higher.

Scanning with network

1.

2.

o

Make sure that the machine is connected to your computer and powered
on.

Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

(See "Loading originals" on page 59).

Start Applications and click Image Capture.

For Mac OS X 10.4 ~ 10.5

Click Devices and click Browse Devices.

For Mac OS X 10.6

Select your device below SHARED. Skip to step 7.

. ForMac OS X 10.4:

Select your machine in TWAIN devices option. Make sure that Use

TWAIN software checkbox is checked, and click Connect.

» If awarning message appears, click Change Port.. to select port.

» If TWAIN Ul appears, from the Preference tab, click Change Port..
to select port.

(g Refer to scan manager for Change port.. use (See "Setting
scan information in Scan Manager" on page 80).

For Mac OS X 10.5:

Make sure that Connected checkbox is checked beside your machine in
Bonjour Devices.

If you want to scan using TWAIN, refer to the Mac OS X 10.4 steps
above.

Set the scan options on this program.
Scan and save your scanned image.

[,g *  For Mac OS X 10.3, use TWAIN-compliant software.

» For more information about using Image Capture, refer to the
Image Capture’s help.

* Use TWAIN-compliant software to apply more scan options.

* You can also scan using TWAIN-compliant software, such as
Adobe Photoshop.

« Scan process differ according to TWAIN-compliant software.
Please refer to the user’s guide of the software.

* If scanning does not operate in Image Capture, update Mac OS to
the latest version. Image Capture operates properly in Mac OS X
10.4.7 or higher.

Setting scan information in Scan Manager

To find out about Scan Manager program information, to check the
installed scan driver's condition, to change scan settings. and to add or
delete the folders where scanned documents to computer are saved in
Scan Manager program, follow these instructions:

1. From the Smart Panel menu on Status bar, click Scan Manager.

2. Select the appropriate machine from the scan manager.

3. Press Properties.
4

. Use Set Scan Button to change the file destination or scan settings,
to add or delete application programs, and to format files. You can
change the scanning machine by using Change Port (Local or
Network).

5. When done, press OK.

LINUX SCANNING

You can scan a document using the Unified Driver Configurator window.
Scanning
1. Double-click the Unified Driver Configurator on your desktop.

2. Click the %= button to switch to Scanners configuration.
3. Select the scanner on the list.

=
h =
&

erek.
Mod!
Troe:

L

If you use only one machine device and it is connected to the computer
and turned on, your scanner appears on the list and is automatically
selected.
If you have two or more scanners connected to your computer, you can
select any scanner to work at any time. For example, while acquisition is
in progress on the first scanner, you may select the second scanner, set
the device options and start the image acquisition simultaneously.
4. Click Properties.
5. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.
(See "Loading originals" on page 59).
6. From the Scanner Properties window, click Preview.
The document is scanned and the image preview appears in the
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Preview Pane.

5 Scanner Properties

7. Drag the pointer to set the image area to be scanned in the Preview
Pane.

8. Change the scan options in the Image Quality and Scan Area sections.

+ Image Quality: This option allows you to select the color
composition and the scan resolution for the image.

+ Scan Area: This option allows you to select the page size. The
Advanced button enables you to set the page size manually.

If you want to use one of the preset scan option settings, select the
option from the Job Type drop-down list (See "Adding Job Type
Settings" on page 81).
Click Default to restore the default setting for the scan options.

9. When you have finished, click Scan to start scanning.

The status bar appears on the bottom left of the window to show you the
progress of the scan. To cancel scanning, click Cancel.

10. The scanned image appears.
If you want to edit the scanned image, use the toolbar (See "Using the
Image Manager" on page 81).

11. When you are finished, click Save on the toolbar.

12. Select the file directory where you want to save the image and enter the
file name.

13. Click Save.

Adding Job Type Settings

You can save your scan option settings for later use.

To save a new Job Type setting:
1. Change the options from the Scanner Properties window.
2. Click Save As.
3. Enter the name for your setting.
4. Click OK.
Your setting is added to the Saved Settings drop-down list.

To save a Job Type setting for the next scan job:

1. Select the setting you want to use from the Job Type drop-down list.

2. The next time you open the Scanner Properties window, the saved
setting is automatically selected for the scan job.

To delete a Job Type setting

1. Select the setting you want to delete from the Job Type drop-down
list.

2. Click Delete.
The setting is deleted from the list.

Using the Image Manager
The Image Manager application provides you with menu commands and
tools to edit your scanned image.

Eie Edt View Joom |mage Jook
on.[w = fﬂﬂu,ﬂu,&,,a,
Crop | Scale ' Rolale ' Fip

Bightuss

Unds Fedo | ZoomOut Zoomin

Use the following tools to edit the image:
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TOOLS NAME FUNCTION

E Save Saves the image.

@ Undo Cancels your last action.

@ Redo Restores the action you canceled.

= Scroll Allows you to scroll through the image.
% Crop Crops the selected image area.

Eﬂ Zoom Out | Zooms the image out.

p—— Zoom In Zooms the image in.
L=y
| Scale Allows you to scale the image size; you can
Lo enter the size manually, or set the rate to scale
proportionally, vertically, or horizontally.
=il Rotate Allows you to rotate the image; you can select
Ll the number of degrees from the drop-down list.
4 Flip Allows you to flip the image vertically or
Mgy horizontally.
A ec ows you to adjust the brightness or contrast o
Effect All to adjust the bright trast of
@ the image, or to invert the image.

Properties | Shows the properties of the image.
|
For further details about the Image Manager application, refer to the on

screen help.
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faxing

This chapter gives you information about using your machine as a fax machine.

This chapter includes:

* Preparing to fax

« Using a fax in your computer

« Sending a fax in your machine

« Receiving a fax in your machine

w * You cannot use this machine as a fax via the internet phone. For
more information ask your internet service provider.

*  We recommend using traditional analog phone services (PSTN:
public switched telephone network) when connecting telephone
lines to use the Fax. If you use other Internet services (DSL, ISDN,
VolP), you can improve the connection quality by using the
Micro-filter. The Micro-filter eliminates unnecessary noise signals
and improves connection quality or Internet quality. Since the DSL
Micro-filter is not provided with the machine, contact your Internet
Service provider for use on DSL Micro-filter.

LINE EXT

O—8 O
{
\ﬂm@c%_——;&

1 Line port
2 Micro filter
3 DSL modem / Telephone line

Supported optional devices and features may differ according to your
model. Please check your model name.

(See "Features by Models" on page 25).

PREPARING TO FAX

Before you send or receive a fax, you need to connect the supplied line cord
to the wall jack. Refer to the Quick Install Guide how to make a connection.
The method of making a telephone connection is varies from one country to
another.

USING A FAX IN YOUR COMPUTER

You can send and receive a fax from your computer without going to the
machine.

Sending a fax
To send a fax from your computer, the Samsung Network PC Fax program
must be installed. This program will be installed when you installed the
printer driver.
1. Open the document to be sent.
2. Select Print from the File menu.

The Print window will be displayed. It may look slightly different

* Adjusting the document settings

» Forwarding a fax to another destination
» Setting up address book

* Printing sent fax report automatically

depending on your application.
3. Select Samsung Network PC Fax from the Print window
Click Print or OK.
5. Enter the recipients’ numbers and select the option.

&

Faz Hachien:
I Acadrnss or ame : UISH
Purmtk. —
2 M Fon Hosrdee E Fa ruanber
]
Fae Cualiy
) o Cifne
Cirves Page:
[0k e g
Ta: Faimn
bt Date:
Hinsgm:
Erlmwcey e oo debvry
(o= ]

If you want to use a cover page, check Use cover page.
Check Notify me on delivery, when the fax delivered to the recipients
successfully.

6. Click Send.

'g For more information about Samsung Network PC Fax, click Help.

Checking a sent fax list

You can check a sent fax list on your computer.

From the Start menu, click Programs or All Programs > Samsung
Printers > Network PC Fax > Fax Journal. Then, the Fax Journal
appears with the fax list you have sent.

Receiving a fax

If you have installed the printer driver, the Samsung Scan & Fax Manager
program is also installed. Start Samsung Scan & Fax Manager program to
find out about this program information and the installed driver's condition.
Through this program, you can change fax settings and add or delete the
folders where faxed documents are saved in your computer.

"ﬁ The Samsung Scan & Fax Manager program can only be used with
the Windows and Macintosh systems. Check if the forwarding a fax to
PC is set to On:
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Press <¢§\_(Fax) on the control panel.
Press Menu on the control panel.

Press the left/right arrow until Forward appears and press OK.
e) Press the left/right arrow until PC appears and press OK.

. Open the Samsung Scan & Fax Manager.

*  For Windows, from the Start menu, click Control Panel > Samsung
Scan & Fax Manager.

Or you can open this program by right clicking the Smart Panel icon
in the Windows task bar and selecting the Samsung Scan & Fax
Manager.

* For Macintosh, from the Smart Panel menu on status bar, click
Samsung Scan & Fax Manager.

Select the appropriate machine from the Samsung Scan & Fax
Manager.

Click Properties.
Use Set Fax Receiving to change the fax settings.
When setting is done, press OK.

Set Fax Receiving tab

Change Pet Set Scan Button Set Fa Recehing
[ Enstle Fan Receiing
Filé Famnat POF -
Save Location CADacuments and Settingsi-LIHNey Documerdsiy Picares ==
Prefic
= Prafic + Date + Time
 DatePrefu + Date + Tims
 t3ender Fax NumbeoFrefx « Date + Time
CADacuments and SottingsHHMY Documentsidy
Fichurns)Samaungh 10067 _05M_T40_18n_00m_50s pdf
[ Motity me when fax received
[ Frint racaived fax
0K Cancal Appiy

» Enable Fax Receiving: You can select whether to use or not.

» File Format: You can convert the received faxes to PDF or TIFF.

» Save Location: Selects location to save the converted faxes.

» Prefix: Selects file or folder scheme as prefix.

» Print received fax: After receiving the fax, set prints information for

the received fax.

* Notify me when fax received: Shows popup window to notify

receiving a fax.

)
)

c) Press the left/right arrow until Fax Feature appears and press OK.
)

Change Port tab
| Changepsn |

Set Scan Button St Fare Receming

@ Local Scannar

) Niatwork Seanner

(=]
[+]

1P Acdripst ! Location ) Fax

oK T R

Local Scanner
Select when your machine is connected via USB or LPT port.

Network Scanner
Select when your machine is connected via network port.

* Auto detection on the network: Automatically detects your
machine.

* IP address: Enter in your machine’s IP address to detect your
machine.

SENDING A FAX IN YOUR MACHINE

This part explains how to send a fax and the special methods of
transmission.

When you place the originals, you can use either the document feeder

or the scanner glass (See "Loading originals" on page 59). If the
originals are placed on both the document feeder and the scanner
glass, the machine will read the originals on the document feeder first,
which has higher priority in scanning.

Setting the fax header

In some countries, you are required by law to indicate your fax number on
any fax you send.

1.

ahoeN

©® N
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Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Machine Setup appears and press OK.
Press the left/right arrow until Machine ID appears and press OK.
Enter your name or the company name using the number keypad. You
can enter alphanumeric characters using the number keypad, and
include special symbols by pressing the 1 button. For details on how to
enter alphanumeric characters, see "Entering characters using the
number keypad" on page 56.

Press OK to save the ID.

Press the left/right arrow until Machine Fax No. appears and press OK.
Enter your fax number using the number keypad and press OK.

Press Stop/Clear to return to ready mode.



Sending a fax

1. Press &(Fax) on the control panel.

2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.
(See "On the scanner glass" on page 59 or "In the document feeder" on
page 60).

3. Adjust the resolution and the darkness to suit your fax needs (See
"Adjusting the document settings" on page 88).

4. Enter the receiving fax machine’s number.

You can use speed dial numbers, or group dial numbers. For details
about storing and searching for a number, see "Setting up address
book" on page 89.

5. Press Start on the control panel. The machine starts to scan and send a
fax to destinations.
w » If you want to send fax directly from your computer, use Samsung
Network PC Fax (See "Sending a fax" on page 83).

*  When you want to cancel a fax job, press Stop/Clear before the
machine start transmission.

» If you used the scanner glass, the machine shows the message
asking to place another page.

Sending a fax manually
This method is sending a fax using On Hook Dial on the control panel.

1. Press ég}(Fax) on the control panel.

2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See
"Adjusting the document settings" on page 88).

4. Press On Hook Dial on the control panel or lift the handset.

5. Enter a fax number using the number keypad on the control panel.

6. Press Start when you hear a high-pitched fax signal from the remote fax
machine.

When you want to cancel a fax job, press Stop/Clear at any time while
sending.

Confirming a transmission

When the last page of your original has been sent successfully, the machine
beeps and returns to ready mode.

When something goes wrong while sending your fax, an error message
appears on the display. For a list of error messages and their meanings, see
"Understanding display messages" on page 108. If you receive an error
message, press Stop/Clear to clear the message and try to send the fax
again.

You can set your machine to print a confirmation report automatically each
time sending a fax is completed. For further details, see "Printing sent fax
report automatically" on page 90.

Automatic redialing

When the number you have dialed is busy or there is no answer when you
send a fax, the machine automatically redials the number every three
minutes, up to seven times according to the factory default settings.
When the display shows Retry Redial?, press OK to redial the number
without waiting. To cancel the automatic redialing, press Stop/Clear.

To change the time interval between redials and the number of redial
attempts (See "Changing the fax setup options" on page 91).

Redialing the last number
To redial the number you called last:
1. Press Redial/Pause on the control panel.

2. When an original is loaded in the document feeder, the machine
automatically begins to send.

If an original is placed on the scanner glass, select Yes to add another
page. Load another original and press OK. When you have finished,
select No at the Another Page? prompt.

Sending a fax to multiple destinations

You can use the Multiple Send feature, which allows you to send a fax to
multiple locations. Originals are automatically stored in memory and sent to
a remote station. After transmission, the originals are automatically erased
from memory. You cannot send a color fax using this feature.

1. Press ég\_(Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See
"Adjusting the document settings" on page 88).

Press Menu on the control panel.

Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Multi Send appears and press OK.

Enter the number of the first receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using
Address book button. For details, see "Setting up address book" on
page 89.

8. Enter the second fax number and press OK.

The display asks you to enter another fax number to send the document.

9. To enter more fax numbers, press OK when Yes appears and repeat
steps 7 and 8. You can add up to 10 destinations.

10. Press OK to start storing the scanned original data into memory.

No oM

',g Once you entered a group dial number, you cannot enter another
group dial numbers anymore.

1

-

. When you have finished entering fax numbers, press the left/right arrow
to select No at the Another No.? prompt and press OK.

12. If an original is placed on the scanner glass, select Yes to add another
pages. Load another original and press OK.

When you have finished, select No at the Another Page? prompt.

The machine begins sending the fax to the numbers you entered in the
order in which you entered them.

Delaying a fax transmission

You can set your machine to send a fax at a later time when you will not be
present. You cannot send a color fax using this feature.

1. Press ég}(Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See
"Adjusting the document settings" on page 88).

Press Menu on the control panel.

Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Delay Send appears and press OK.
Enter the number of the receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using
Address book button. For details, see "Setting up address book" on

No oM
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page 89.

8. The display asks you to enter another fax number to send the document.

9. To enter more fax numbers, press OK when Yes appears and repeat
steps 7. You can add up to 10 destinations.

@ Once you entered a group dial number, you cannot enter another
group dial numbers anymore.

10. When you have finished entering fax numbers, press the left/right arrow
to select No at the Another No.? prompt and press OK.

. Enter the job name you want and press OK.

For details on how to enter alphanumeric characters, see "Entering
characters using the number keypad" on page 56.

If you do not want to assign a name, skip this step.
12. Enter the time using the number keypad and press OK.

1

-

@ If you set a time earlier than the current time, the fax will be sent at
that time on the following day.

The original is scanned into memory before transmission.

13.If an original is placed on the scanner glass, select Yes to add another
pages. Load another original and press OK.

When you have finished, select No at the Another Page? prompt.

The machine returns to ready mode. The display reminds you that you
are in ready mode and that a delayed fax is set.

Adding documents to a reserved delay fax job

You can add additional documents to the delayed fax job which is saved
in memory.

1. Load the originals to be added and adjust document settings.

Press Menu on the control panel.

Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Add pages appears and press OK.

Press the left/right arrow until the fax job you want appears and
press OK.

When you have finished, select No at the Another Page? prompt.
The machine scans the original into memory.

6. Press Stop/Clear to return to ready mode.

ok owN

Canceling a reserved delay fax job
You can cancel the delayed fax job which is saved in memory.
1. Press Menu on the control panel.
2. Press the left/right arrow until Fax Feature appears and press OK.
3. Press the left/right arrow until Cancel Job appears and press OK.
4. Press the left/right arrow until the fax job you want appears and
press OK.
5. Press OK when Yes appears.
The selected fax is deleted from memory.
6. Press Stop/Clear to return to ready mode.

Sending a priority fax

This function is used when a high priority fax need to be sent ahead of
reserved operations. The original is scanned into memory and immediately
transmitted when the current operation is finished. In addition, priority
transmission will interrupt a sending to multiple destinations between
stations (example, when the transmission to station A ends, before
transmission to station B begins) or between redial attempts.

1. Press & (Fax) on the control panel.
2. Load originals face up into the document feeder, or place a single
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See
"Adjusting the document settings" on page 88).

Press Menu on the control panel.

Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Priority Send appears and press OK.
Enter the number of the receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using
Address book button. For details, see "Setting up address book" on
page 89.

8. Enter the job name you want and press OK.

The original is scanned into memory before transmission.

9. If an original is placed on the scanner glass, select Yes to add another
pages. Load another original and press OK.

When you have finished, select No at the Another Page? prompt.
The machine starts to scan and send a fax to destinations.

No oM

RECEIVING A FAX IN YOUR MACHINE

This part explains how to receive a fax, and the special receiving methods
available.

Changing the receive modes

Your machine is preset to Fax mode at the factory. When you receive a fax,
the machine answers the call on a specified number of rings and
automatically receives the fax. But if you want to change the Fax mode to
another mode, follow the steps below:

1. Press ég\_(Fax) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Fax Setup appears and press OK.

Press the left/right arrow until Receiving appears and press OK.

Press the left/right arrow until Receive Mode appears and press OK.

Press the left/right arrow until the fax reception mode you want appears.

» Fax: Answers an incoming fax call and immediately goes into the
fax reception mode.

+ Tel: Receives a fax by pressing On Hook Dial and then Start. If
your machine has a handset, you can receive a fax by picking up the
handset.

* Ans/Fax: Is for when an answering machine attached to your
machine. Your machine answers an incoming call, and the caller can
leave a message on the answering machine. If the fax machine
senses a fax tone on the line, the machine automatically switches to
Fax mode to receive the fax.

» DRPD: you can receive a call using the Distinctive Ring Pattern
Detection (DRPD) feature. Distinctive Ring is a telephone company
service which enables an user to use a single telephone line to
answer several different telephone numbers. For further details, see
"Receiving faxes using DRPD mode" on page 87.

7. Press OK to save your selection.

8. Press Stop/Clear to return to ready mode.

[

@ » Touse the Ans/Fax mode, attach an answering machine to the
EXT socket on the back of your machine.
» If you do not want other people to view your received
documents, you can use secure receiving mode. In this mode,
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all of the received faxes are stored in memory. For further
details, see "Receiving in secure receiving mode" on page 87.

Receiving manually in Tel mode

You can receive a fax call by pressing On Hook Dial and then pressing
Start when you hear a fax tone from the remote machine. The machine
begins receiving a fax. If your machine has a handset, you can answer calls
using the handset.

To change the number of rings, see "Changing the fax setup options" on
page 91.

Receiving automatically in Answering Machine/Fax
mode

To use this mode, you must attach an answering machine to the EXT socket
on the back of your machine (See "Rear view" on page 27).

If the caller leaves a message, the answering machine stores the message
as it would normally. If your machine detects a fax tone on the line, it
automatically starts to receive the fax.

[,g » If you have set your machine to this mode and your answering
machine is switched off, or no answering machine is connected to
EXT socket, your machine automatically goes into Fax mode after
a predefined number of rings.

+ If your answering machine has a user-selectable ring counter, set
the machine to answer incoming calls within 1 ring.

+ If you are in Tel mode when the answering machine is connected
to your machine, you must switch off the answering machine.
otherwise, the outgoing message from the answering machine will
interrupt your phone conversation.

Receiving faxes manually using an extension
telephone

This feature works best when you are using an extension telephone
connected to the EXT socket on the back of your machine. You can receive
a fax from someone you are talking to on the extension telephone, without
going to the fax machine.

When you receive a call on the extension phone and hear fax tones, press
the keys *9* on the extension phone. The machine receives the fax.

Press the buttons slowly in sequence. If you still hear the fax tone from the
remote machine, try pressing *9* once again.

*9* is the remote receive code preset at the factory. The first and the last
asterisks are fixed, but you can change the middle number to whatever you
wish. For details about changing the code, see "Changing the fax setup
options" on page 91

Receiving faxes using DRPD mode

Distinctive Ring is a telephone company service which enables an user to
use a single telephone line to answer several different telephone numbers.
The particular number someone uses to call you is identified by different
ringing patterns, which consist of various combinations of long and short
ringing sounds. This feature is often used by answering services who
answer telephones for many different clients and need to know which
number someone is calling in on to properly answer the phone.

Using the Distinctive Ring Pattern Detection (DRPD) feature, your fax
machine can learn the ring pattern you designate to be answered. Unless
you change it, this ringing pattern will continue to be recognized and

answered as a fax call, and all other ringing patterns will be forwarded to the
extension telephone or answering machine plugged into the EXT socket.
You can easily suspend or change DRPD at any time.

Before using the DRPD option, Distinctive Ring service must be installed on
your telephone line by the telephone company. To set up DRPD, you will
need another telephone line at your location, or someone available to dial
your fax number from outside.

To set up the DRPD mode:

1. Press ég\.(Fax) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Fax Setup appears and press OK.

Press the left/right arrow until Receiving appears and press OK.

Press the left/right arrow until Receive Mode appears and press OK.

Press the left/right arrow until DRPD appears and press OK.

Waiting Ring appears on the display.

7. Call your fax number from another telephone. It is not necessary to
place the call from a fax machine.

8. When your machine begins to ring, do not answer the call. The machine
requires several rings to learn the pattern.

When the machine completes learning, the display shows Completed
DRPD Setup. If the DRPD setup fails, Error DRPD Ring appears.

Press OK when DRPD appears and start over from step 6.

o0k N

',g » DRPD must be set up again if you re-assign your fax number,
or connect the machine to another telephone line.

» After DRPD has been set up, call your fax number again to
verify that the machine answers with a fax tone. Then have a
call placed to a different number assigned to that same line to
be sure the call is forwarded to the extension telephone or
answering machine plugged into the EXT socket.

Receiving in secure receiving mode

You may need to prevent your received faxes from being accessed by
unauthorized people. You can turn on secure receiving mode to restrict
printing of received faxes when the machine is unattended. In secure
receiving mode, all incoming faxes go into memory. When the mode is
deactivated, any stored faxes are printed.

Activating secure receiving mode

Press Q&}(Fax) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Secure Receive appears and press OK.
Press the left/right arrow until On appears and press OK.

Enter a four-digit password you want to use and press OK.

ok ON =

w You can activate secure receiving mode without setting a
password, but cannot protect your faxes.

7. Re-enter the password to confirm it and press OK.
8. Press Stop/Clear to return to ready mode.

When a fax is received in secure receiving mode, your machine stores it in
memory and shows Secure Receive to let you know that there is a fax
received.

Printing received faxes

1. Access the Secure Receive menu by following steps 1 through 4 in
“Activating secure receiving mode.”

2. Press the left/right arrow until Print appears and press OK.
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3. Enter the four-digit password and press OK.
The machine prints all of the faxes stored in memory.

Deactivating secure receiving mode

1. Access the Secure Receive menu by following steps 1 through 4 in
“Activating secure receiving mode.”

2. Press the left/right arrow until Off appears and press OK.

3. Enter the four-digit password and press OK.

The mode is deactivated and the machine prints all faxes stored in
memory.

4. Press Stop/Clear to return to ready mode.

Receiving faxes in memory

Since your machine is a multi-tasking device, it can receive faxes while you
are making copies or printing. If you receive a fax while you are copying or
printing, your machine stores incoming faxes in its memory. Then, as soon
as you finish copying or printing, the machine automatically prints the fax.

ADJUSTING THE DOCUMENT SETTINGS

Before starting a fax, change the following settings according to your
original’s status to get the best quality.

Resolution

The default document settings produces good results when using typical
text-based originals. However, if you send originals that are of poor quality,
or contain photographs, you can adjust the resolution to produce a higher
quality fax.

1. Press <¢§\_(Fax) on the control panel.

Press Menu on the control panel.
Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Resolution appears and press OK.

Press the left/right arrow until the option you want appears and press
OK.

6. Press Stop/Clear to return to ready mode.

Recommended resolution settings for different original document types are
described in the table below:

o eDd

MODE RECOMMENDED FOR:
Standard Originals with normal sized characters.
Fine Originals containing small characters or thin lines or
originals printed using a dot-matrix printer.

MODE RECOMMENDED FOR:

Super Fine Originals containing extremely fine detail. Super Fine
mode is enabled only if the machine with which you
are communicating also supports the Super Fine
resolution.

',g « For memory transmission, Super Fine
mode is not available. The resolution setting
is automatically changed to Fine

*  When your machine is set to Super Fine
resolution and the fax machine with which
you are communicating does not support
Super Fine resolution, the machine
transmits using the highest resolution mode
supported by the other fax machine.

Photo Fax Originals containing shades of gray or photographs.

Color Fax Originals with colors. Sending a color fax is enabled
only if the machine with which you are
communicating supports color fax reception and you
send the fax manually. In this mode, memory
transmission is not available.

@ The resolution setting is applied to the current fax job. To change the
default setting, see "Change Default" on page 92.

Darkness
You can select the degree of darkness of the original document.

Press ég}(Fax) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Darkness appears and press OK.

Press the left/right arrow until the option you want appears and press
OK.

6. Press Stop/Clear to return to ready mode.

abhoDdN =

',g The darkness setting is applied to the current fax job. To change the
default setting, see "Change Default" on page 92.

FORWARDING A FAX TO ANOTHER
DESTINATION

You can set the machine to forward the received or sent fax to other
destination by a fax. If you are out of office but have to receive the fax, this
feature may be useful.

Forwarding a sent fax to another destination

You can set the machine to forward every fax you sent to another
destination.

1. Press ég\.(Fax) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Forward appears and press OK.
Press the left/right arrow until Fax appears and press OK.

Press the left/right arrow until Send Forward appears and press OK.
Press the left/right arrow until On appears and press OK.

Enter the number of the fax machine to which faxes are to be sent and
press OK.

®Noahs®N
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9. Press Stop/Clear to return to ready mode.
Subsequent sent faxes will be forwarded to the specified fax machine.

Forwarding a received fax to another destination

With this feature, you can forward every fax you received to another
destination. When the machine receives a fax, a fax is stored in the memory
then, the machine sends it to the destination you have set.

1. Press <¢g\.(Fax) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Fax Feature appears and press OK.
Press the left/right arrow until Forward appears and press OK.

Press the left/right arrow until Fax appears and press OK.

Press the left/right arrow until Rcv. Forward appears and press OK.
Press the left/right arrow until Forward appears and press OK.

To set the machine to print out a fax when fax forwarding has been
completed, select Forward & Print.

8. Enter the number of the fax machine to which faxes are to be sent and
press OK.

9. Enter the starting time using left/right arrow or numeric keypad and
press OK.

10. Enter the ending time using left/right arrow or numeric keypad and press
OK.

11. Press Stop/Clear to return to ready mode.

Subsequent received faxes will be forwarded to the specified fax
machine.

NooapwDd

SETTING UP ADDRESS BOOK

You can set up Address Book with the fax numbers you use most
frequently. Your machine provides you with the following features for setting
up Address Book:

Before beginning to store fax numbers, make sure that your machine
is in Fax mode.

Speed dial numbers

You can store up to 200 frequently-used fax numbers in speed dial
numbers.

Registering a speed dial number

Press &(Fax) on the control panel.

Press Address Book on the control panel.

Press the left/right arrow until New & Edit appears and press OK.
Press the left/right arrow until Speed Dial appears and press OK.
Enter a speed dial number between 0 and 199 and press OK.

If an entry is already stored in the number you choose, the display
shows the message to allow you to change it. To start over with
another speed dial number, press Back.

6. Enter the name you want and press OK.

For details on how to enter alphanumeric characters (See "Entering
characters using the number keypad" on page 56).

7. Enter the fax number you want and press OK.
8. Press Stop/Clear to return to ready mode.

apODN =

Editing speed dial numbers

Press <¢§\.(Fax) on the control panel.

Press Address Book on the control panel.

Press the left/right arrow until New & Edit appears and press OK.
Press the left/right arrow until Speed Dial appears and press OK.
Enter the speed dial number you want to edit and press OK.
Change the name and press OK.

Change the fax number and press OK.

Press Stop/Clear to return to ready mode.

OGN RWON =

Using speed dial numbers

When you are prompted to enter a destination number while sending a
fax, enter the speed dial number at which you stored the number you
want.

» For a one-digit (0-9) speed dial number, press and hold the
corresponding digit button on the number keypad.

» For a two- or three-digit speed dial number, press the first digit
button(s) and then hold down the last digit button.

You can also search through memory for an entry by pressing Address
Book (See "Searching Address Book for an entry" on page 90).

Group dial numbers

If you frequently send the same document to several destinations, you can
group these destinations and set them under a group dial number. You can
then use a group dial number to send a document to all of the destinations
within the group. You can set up to 100 (0 through 99) group dial numbers
using the destination’s existing speed dial numbers.

Registering a group dial number

Press ég\_(Fax) on the control panel.

Press Address Book on the control panel.

Press the left/right arrow until New & Edit appears and press OK.
Press the left/right arrow until Group Dial appears and press OK.
Enter a group dial number between 0 and 99 and press OK.

If an entry is already stored in the number you choose, the display
shows the message to allow you to change it.

6. Enter the name you want and press OK.

For details on how to enter alphanumeric characters (See "Entering
characters using the number keypad" on page 56).

7. Enter the first few letters of the speed dial’s name you want.

8. Press the left/right arrow until the name and number you want
appears and press OK.

9. Press OK when Yes appears at the Another No.? prompt.
Repeat step 7 to include other speed dial numbers into the group.

10. When you have finished, press the left/right arrow to select No at the
Another No.? prompt and press OK.

11. Press Stop/Clear to return to ready mode.

apON =

Editing a group dial number

Press ég}(Fax) on the control panel.

Press Address Book on the control panel.

Press the left/right arrow until New & Edit appears and press OK.
Press the left/right arrow until Group Dial appears and press OK.
Enter the group dial number you want to edit and press OK.
Enter the name you want to edit and press OK.

oapODN =
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7. Enter the first few letters of the speed dial’s name you want to add or
delete.

8. Press the left/right arrow until the name and number you want
appears and press OK.

If you entered a new speed dial number, Add? appears.

If you enter a speed dial number stored in the group, Delete?
appears.

9. Press OK to add or delete the number.

10. Press OK when Yes appears to add or delete more numbers and
repeat steps 7 and 8.

11. When you have finished, press the left/right arrow to select No at the
Another No.? and press OK.

12. Press Stop/Clear to return to ready mode.

Using group dial numbers
To use a group dial entry, you need to search for and select it from

name.

6. Press the left/right arrow until the name you want appears and press
OK.

Or, enter the first letters. Press the left/right arrow until the name you
want appears and press OK.

7. Press OK when Yes appears to confirm the deletion.
8. Press Stop/Clear to return to ready mode.

Printing Address Book
You can check your Address Book settings by printing a list.

1. Press ég}(Fax) on the control panel.

2. Press Address Book on the control panel.
3. Press the left/right arrow until Print appears and press OK.
The machine begins printing.

\Tvir::%u are prompted to enter a fax number while sending a fax, KEI-INO-I-I!,INAQHSCEANL-II-_$AX REPORT

press Address Book. See below.

searching Address Book for an entry You can set the machine to print a report with detailed information about the

There are two ways to search for a number in memory. You can either scan
from A to Z sequentially, or you can search by entering the first letters of the
name associated with the number.

Searching sequentially through the memory

Press ég}(Fax) on the control panel.

Press Address Book on the control panel.

Press the left/right arrow until Search & Dial appears and press OK.
Press the left/right arrow until Group Dial appears and press OK.
Press the left/right arrow until All appears and press OK.

Press the left/right arrow until the name and number you want
appears. You can search upwards or downwards through the entire
memory in alphabetical order.

ok obd 2

Searching sequentially through the memory

Press <\&}(Fax) on the control panel.

Press Address Book on the control panel.

Press the left/right arrow until Search & Dial appears and press OK.
Press the left/right arrow until Group Dial appears and press OK.
Press the left/right arrow until ID appears and press OK.

Enter the first few letters of the name you want.

Press the left/right arrow until the group dial’'s name and number you
want appears.

Nooakrowd =

Deleting a Address Book for entry

1. Press <\.§\_(Fax) on the control panel.

2. Press Address Book on the control panel.

3. Press the left/right arrow until Delete appears and press OK.
4

. Press the left/right arrow until the deleting option you want appears
and press OK.

5. Press the left/right arrow until the searching method you want
appears and press OK.

Select Search All to search for an entry by scanning through all
entries in Address Book.

Select Search ID to search for an entry by the first few letters of the
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previous 50 communication operations, including time and dates.

Press ég}(Fax) on the control panel.

Press Menu on the control panel.

Press the left/right arrow until Fax Setup appears and press OK.
Press the left/right arrow until Auto Report appears and press OK.
Press the left/right arrow until On appears and press OK.

Press Stop/Clear to return to ready mode.



macnine status and advanced feature

This chapter explains how to browse the current status of your machine, and the method of setting for the advanced
machine setup. Read this chapter carefully in order to use your machine's diverse features.

This chapter includes:

Fax setup
Copy setup
Printing a report

Some menus may not appear in the display depend
models. If so, it is not applicable to your machine.

FAX SETUP
Changing the fax setup options

Your machine provides you with various user-selectable options for setting
up the fax system. You can change the default settings for your preferences

a
T

1.

2
3.
4. Press the left/right arrow until the fax setup item you want appears and

nd needs.
o change the fax setup options:

Press ég}(Fax) on the control panel.

. Press Menu on the control panel.
Press the left/right arrow until Fax Setup appears and

press OK.

Press the left/right arrow until the option you want app
OK.

. Press the left/right arrow until the desired status appears or enter the

value for the option you have selected, and press OK.
. If necessary, repeat steps 4 through 6.
. Press Stop/Clear to return to ready mode.

Sending

* Clearing memory

*  Network
* Menu overview

ing on options or OPTION

DESCRIPTION

Send Report

You can set your machine to print a confirmation
report showing whether a transmission was
successful, how many pages were sent, and
more. The available options are On, Off, and
On-Error, which prints only when a transmission
is not successful.

Image TCR

press OK.

ears and press

This function allows users to know what fax
messages have been sent by showing sent
messages in the transmission report.

The first page of the message is turned into an
image file than is printed on the transmission
report so the users can see what messages
have been sent.

However, you can not use this function when
sending fax without saving the data in the
memory.

Dial Mode

OPTION

DESCRIPTION

Redial Times

You can specify the number of redial attempts. If
you enter 0, the machine will not redial.

Redial Term
fax machine if it was busy. You
interval between attempts.

Your machine can automatically redial a remote

This setting may not be available depending on
your country. If you cannot reach this option,
your machine does not support this feature.
You can set the dial mode for your machine to
either tone dialling or pulse dialling. If you have a
public telephone system or a private branch
exchange (PBX) system, you may need to select
Pulse. Contact your local telephone company if
you are not sure which dial mode to use.

If you select Pulse, some phone system
features might not be available. It can also take
longer to dial a fax or phone number.

can set an Receiving

Prefix Dial
number dials before any autom

exchange.

You can set a prefix of up to five digits. This

is started. It is useful for accessing a PABX

OPTION

DESCRIPTION

atic dial number Receive Mode

ECM Mode This mode helps with poor line

more time.

makes sure any faxes you send are sent
smoothly to any other ECM-equipped fax
machine. Sending a fax using ECM may take

You can select the default fax receiving mode.
For details on receiving faxes in each mode, see
"Changing the receive modes" on page 86.

quality and Ring To Answer

You can specify the number of times the
machine rings before answering an incoming
call.

Stamp RCV Name

This option allows the machine to automatically
print the page number, and the date and time of
reception at the bottom of each page of a
received fax.
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OPTION

DESCRIPTION

RCV Start Code

This code allows you to initiate fax reception
from an extension phone plugged into the EXT
socket on the back of the machine. If you pick up
the extension phone and hear fax tones, enter
the code. It is preset to *9* at the factory.

Auto Reduction

When receiving a fax containing pages as long
as or longer than the paper loaded in the paper
tray, the machine can reduce the size of the
original to fit the size of the paper loaded in the
machine.

Turn on this feature if you want to automatically
reduce an incoming page.

With this feature set to Off, the machine cannot
reduce the original to fit onto one page. The
original will be divided and printed in actual size
on two or more pages.

Discard Size

When receiving a fax containing pages as long
as or longer than the paper in your machine, you
can set the machine to discard a specific length
from the end of the received fax. The machine
will print the received fax on one or more sheets
of paper, minus the data that would have been
on the specified discard segment.

When the received fax contains pages larger
than the paper in your machine, and Auto
Reduction has been turned on, the machine will
reduce the fax to fit on the existing paper, and
nothing will be discarded.

Junk Fax Setup

This setting may not be available depending on
your country. Using this feature, the system will
not accept faxes sent from remote stations
whose numbers are stored in the memory as
junk fax numbers. This feature is useful for
blocking any unwanted faxes.

When you turn on this feature, you can access
the following options to set junk fax numbers.

« Add: Allows you to set up to 10 fax numbers.

« Delete: Allows you to delete the desired junk
fax number. If you select Delete All, Allows
you to delete all junk fax numbers.

DRPD Mode

This setting may not be available depending on
your country. This mode enables a user to use a
single telephone line to answer several different
telephone numbers. In this menu, you can set
the machine to recognize which ring patterns to
answer. For details about this feature, see
"Receiving faxes using DRPD mode" on

page 87.

Change Default

OPTION

DESCRIPTION

Resolution

Changing the resolution setting affects the

appearance of the received document.

« Standard: Originals with normal sized
characters.

* Fine: Originals containing small characters
or thin lines or originals printed using a
dot-matrix printer.

« Super Fine: Originals containing extremely
fine detail. Super Fine mode is enabled only
if the machine with which you are
communicating also supports the Super
Fine resolution.

’Q « For memory transmission, Super
Fine mode is not available. The
resolution setting is automatically
changed to Fine.

*  When your machine is set to Super
Fine resolution and the fax
machine with which you are
communicating does not support
Super Fine resolution, the machine
transmits using the highest
resolution mode supported by the
other fax machine.

* Photo Fax: Originals containing shades of
gray or photographs.

« Color Fax: Originals with colors. Sending a
color fax is enabled only if the machine with
which you are communicating supports color
fax reception and you send the fax manually.
In this mode, memory transmission is not
available.

Darkness

You can select the default contrast mode to fax
your originals lighter or darker.

Auto Report

You can set the machine to print a report with detailed information about the
previous 50 communication operations, including time and dates.

For further details, see "Printing sent fax report automatically" on page 90.

COPY SETUP

Changing the copy setup options
For copy output, you can set up several options in advance.
1. Press (Copy) on the control panel.

2. Press Menu on the control panel.
3. Press the left/right arrow until Copy Setup appears and press OK.
4. Press the left/right arrow until the copy setup item you want appears and

press OK.

5. Press the left/right arrow until the setup option you want appears and

press OK.

6. Press the left/right arrow until the setting you want appears and press

OK.
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7. Repeat steps 4 through 6, as needed.
8. Press Stop/Clear to return to ready mode.

Change Default

OPTION

DESCRIPTION

Copies

You can enter the number of copies using the
number keypad.

Copy Collation

You can set the machine to sort the copy job.
For further details, see "Deciding the form of
copy output" on page 76.

Reduce/Enlarge

Reduces or enlarges the size of a copied image.

Darkness Adjusts the brightness level to make a copy that
is easier to read, when the original contains faint
markings and dark images.

Original Type Improves the copy quality by selecting the

document type for the current copy job.

PRINTING A REPORT

You can print a report on the machine's configuration or font list, etc.
1. Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Report appears and press OK.

OPTION

DESCRIPTION

Schedule Jobs

This list shows the documents currently stored
for delayed faxes along with the starting time
and type of each operation.

JunkFax Report

This list shows the fax numbers specified as junk
fax numbers. To add or delete numbers to or
from this list, access the Junk Fax Setup menu
(See "Receiving" on page 91).

Network Info.

This list shows information on your machine’s
network connection and configuration.

',g You can also print the machine's status information and browse status
with SyncThru™ Web Service. Open the Web browser on your
networked computer and type the IP address of your machine. When
SyncThru™ Web Service opens, click Information > Print

information.

CLEARING MEMORY

You can selectively clear information stored in your machine’s memory.
1. Press Menu on the control panel.

hpoON

press OK.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Clear Setting appears and press OK.
Press the left/right arrow until the item you want to clear appears and

2,
3.
4.

Press the left/right arrow until the report or list you want to print appears
and press OK.

To print all reports and lists, select All Report.
Press OK when Yes appears to confirm printing.
The selected information prints out.

No o

Press OK when Yes appears to confirm clearing.
Repeat steps 4 through 5 to clear another item.
. Press Stop/Clear to return to ready mode.

Some menus may not appear in the display depending on options or

models. If so, it is not applicable to your machine.

OPTION

DESCRIPTION

Configuration

This list shows the status of the user-selectable
options. You may print this list to confirm your
changes after changing settings.

Phone Book

This list shows all of the fax numbers currently
stored in the machine’s memory.

Send Report

This report shows the fax number, the number of
pages, the elapsed time of the job, the
communication mode, and the communication
results for a particular fax job.

You can set up your machine to automatically
print a transmission confirmation report after
each fax job (See "Sending" on page 91).

Sent Report

This report shows information on the faxes you
have recently sent.

You can set the machine to automatically print
this report every 50 communications (See
"Sending" on page 91).

Fax RCV Report

This report shows information on the faxes you
have recently received.

OPTION DESCRIPTION

All settings Clears all of the data stored in memory and
resets all of your settings to the factory default.

Fax Setup Restores all of the fax options to the factory
default.

Copy Setup Restores all of the copy options to the factory
default.

Scan Setup Restores all of the scan options to the factory

default.

System Setup

Restores all of the system options to the factory
default.

Network Setup

Restores all of the network options to the factory
default.

Phone Book Clears all of the fax numbers entries stored in
memory.

Sent Report Clears all records of sent faxes.

RCV Report Clears all records of received faxes.
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NETWORK MENU OVERVIEW
You may set up the network with the machine's display screen. Before doing The control panel provides access to various menus to set up the machine
that, you must have the relevant information concerning the type of network or use the machine’s functions. These menus can be accessed by pressing
protocols and computer system you use. If you are not sure which setting to Menu.
use, contact your network administrator to configure this machine to the Some menus may not appear in the display depending on options or
network. models. If so, it is not applicable to your machine.
1. Press Menu on the control panel.
2. Press the left/right arrow until Network appears and press OK.
3. Press the left/right arrow until the setup option you want appears and [TEMS OFTION
press OK. Fax Feature Darkness
4. Press the left/right arrow until the setting you want appears and press Resolution
OK. Multi Send
5. Repeat steps 3 through 4, as needed. Delay Send
6. Press Stop/Clear to return to ready mode. Priority Send
Forward
OPTION DESCRIPTION Secure Receive
TCP/IP (IPv4) Select appropriate protocol and configure ég::;?gib
parameters to use the network environment.
(Z) There are lots of parameters to be set; Fax Setup Sending
therefore, if you are not sure, leave as is, Redial Times
or consult the network administrator. Redial Term
- - Prefix Dial
TCPIIP (IPv6) Selects this option to use the network ECM Mode
environment through IPv6 (See "IPv6
Configuration" on page 41). Send Report
Image TCR
Ethernet Speed Configure the network transmission speed. Dial Mode
Wireless Configure the wireless network environments Receiving
(See "Using a wireless network from the control Receive Mode
panel" on page 44). Ring To Answer
Clear Setting Reverts the network settings to the default gtg‘rln gtzg\é::;ne
values. i
Auto Reduction
Network Info This list shows information on your machine’s Discard Size
network connection and configuration. Junk Fax Setup
DRPD Mode
Change Default
Resolution
Darkness
Auto Report
Copy Feature Reduce/Enlarge
Darkness
Original Type
Layout
Adjust Bkgd.
Copy Setup Scan Size
Change Default
Copies
Copy Collation
Reduce/Enlarge
Darkness
Original Type
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ITEMS

OPTION

ITEMS

OPTION

System Setup

Machine Setup
Machine ID
Machine Fax No
Date & Time
Clock Mode
Language
Default Mode
Power Save
Timeout
Job Timeout
Altitude Adj.
Toner Save

Paper Setup
Paper Size
Paper Type
Paper Source

Sound/Volume
Key Sound
Alarm Sound
Speaker
Ringer

Report
All Report
Configuration
Phone Book
Send Report
Sent Report
Fax RCV Report
Schedule Jobs
JunkFax Report
Network Info.

Maintenance
CLR Empty Msg
Supplies Life
TonerLow Alert
Serial Number
Paper Stacking

Clear Setting
All Settings
Fax Setup
Copy Setup
Scan Setup
System Setup
Network Setup
Phone Book
Sent Report
RCV Report

Network

TCP/IP (IPv4)
DHCP
BOOTP
Static
TCPI/IP (IPv6)
IPv6 Activate
DHCPv6 Config
Ethernet Speed
Wireless
WLAN Settings
PBC
PIN
Wizard
Custom
WLAN Default
WLAN Signal
Clear Setting
Network Info.
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management tools

This chapter introduces management tools provided to help you make full use of your machine.

This chapter includes:

* Introducing useful management tools
« Using SyncThru™ Web Service
« Using the Smart Panel program

INTRODUCING USEFUL MANAGEMENT TOOLS

The programs below help you to use your machine conveniently.
¢ "Using SyncThru™ Web Service" on page 96.

* "Using the Smart Panel program" on page 96.

* "Smarthru" on page 97.

« "Using the Linux Unified Driver Configurator" on page 98.

USING SYNCTHRU™ WEB SERVICE

'g Your SyncThru™ Web Service window that appears in this user’s
guide may differ depending on the machine in use.

If you have connected your machine to a network and set up TCP/IP
network parameters correctly, you can manage the machine via SyncThru™
Web Service, an embedded web server. Use SyncThru™ Web Service to:

« View the machine’s device information and check its current status.
* Change TCP/IP parameters and set up other network parameters.
* Change printer preference.

« Set the email notifications advising of the machine’s status.

* Get support for using the machine.

To access SyncThru™ Web Service:
1. Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

SyncThru™ Web Service overview

« Information tab: This tab gives you general information about your
machine. You can check things, such as the machine’s IP address,

*  Smarthru
* Using the Linux Unified Driver Configurator

remaining amount of toner, ethernet information, firmware version, and
so on. You can also print reports such as an error report and so on.

* Machine Settings tab: This tab allows you to set options provided by
your machine.

* Network Settings tab: This tab allows you to view and change the
network environment. You can set things, such as TCP/IP, enabling
Ether Talk and so on.

* Maintenance tab: This tab allows you to maintain your machine by
upgrading firmware and setting security information.

« Support tab: This tab allows you to set contact information for sending
email. You can also connect to samsung website or download drivers by
selecting Link.

Setting the contact information

Set the machine administrator information and this setting is necessary to
use E-mail notification option.

1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

Select Support.

4. Enter the name of machine administrator, phone number, location or
E-mail address.

5. Click Apply.

',g If the firewall is activated, the E-mail may not be sent successfully.
In that case, contact the a network administrator.

[ad

USING THE SMART PANEL PROGRAM

Smart Panel is a program that monitors and informs you of the machine
status, and allows you to customize the machine’s settings. For Winodws
and Macintosh, Smart Panel is installed automatically when you install the
machine software. For Linux, you can download Smart Panel from
Samsung website and install (See "Installing the Smart Panel" on page 35).

To use this program, you need the following system requirements:

Windows. Check for windows operating system(s) compatible with
your machine (See "System requirements" on page 32).

*  Mac OS X 10.3 or higher.

* Linux. Check for Linux systems that are compatible with your
machine (See "System requirements" on page 32).

« Internet Explorer version 5.0 or higher for flash animation in HTML
Help.

If you need to know the exact model name of your machine, you can

check the supplied software CD.
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Understanding Smart Panel

If an error occurs while printing, you can check the error from the Smart
Panel.

You can also launch Smart Panel manually. Double-click the Smart Panel
icon on the Windows task bar (in Windows), or Notification Area (in Linux).
You can also click it on the status bar (in Mac OS X).

Windows IE Double-click this icon in Windows.
Macintosh % Click this icon in Mac OS X.
Linux ! Click this icon in Linux.

Or, if you are a Windows user, you can launch it from the Start menu, select
Programs or All Programs > Samsung Printers > your printer driver
name > Smart Panel.

',g + If you have already installed more than one Samsung machine,
first select the correct machine model you want in order to access
the corresponding Smart Panel.

Right-click (in Windows or Linux) or click (in Mac OS X) the Smart
Panel icon and select your machine.

* The Smart Panel window and its contents shown in this user’s
guide may differ depending on the machine or operating system in
use.

The Smart Panel program displays the current status of the machine, the

estimated level of toner remaining in the toner cartridge(s), and various

other types of information. You can also change settings.

5|
Rty Q e @)
Lo 3)
[1]’*""!-—| .l.“nr srting
=
Toner Level View the level of toner remaining in the toner
cartridge(s). The machine and the number of toner
@ cartridge(s) shown in the above window may differ

depending on the machine in use. Some machines
do not have this feature.

Buy Now Order replacement toner cartridge(s) online.

User’s Guide | View User's Guide.

w This button changes to Troubleshooting
Guide when error occurs. You can directly
open troubleshooting section in the user’s

guide.
Printer Configure various machine settings in the Printer
Setting Settings Utility window. Some machines do not

have this feature.

@ 'g If you connect your machine to a network,

the SyncThru™ Web Service window
appears instead of the Printer Settings Utility
window.

Driver Setting | Set all of the machine options you need in the

Printing Preferences window. This feature is
@ available only for Windows (See "Opening printing
preferences" on page 67).

Changing the Smart Panel Program Settings
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel
icon and select Options. Select the settings you want from the Options
window.

SMARTHRU

The supplied software CD provides you with SmarThru. SmarThru offers
you convenient features to use with your machine.

Starting SmarThru
Follow the steps below to start SmarThru:

1. Make sure that your machine and computer are turned on and properly
connected to each other.

2. Once you have installed SmarThru, you will see the SmarThru icon on
your desktop.
3. Double-click the SmarThru icon.

£

SmarThi &

4. The SmarThru appears.

& ) @

Scan To Image Print

» Scan to: Allows you to scan an image and save it to an application
or folder, email it, or publish it on a web site.

» Image: Allows you to edit an image you have saved as a graphic file
and send it to a selected application or folder, email it, or publish it on
a web site.

» Print: Allows you to printimages you have saved. You can print
images in black and white or color mode if your machine supports it.

For more information about SmarThru, click ﬁ at the top right corner
of the window. The SmarThru help window appears; you can view on
screen help supplied on the SmarThru program.

'g Follow the steps below to uninstall SmarThru. Before you begin the
uninstall, ensure that all applications are closed on your computer.
a) From the Start menu, select Programs or All Programs.
b) Select Samsung Printers > SmarThru 4 > Uninstall SmarThru
4

¢) When your computer asks you to confirm your selection, read the
statement and click OK.

d) Click Finish.

Management tools_ 97



Using SmarThru USING THE LINUX UNIFIED DRIVER

Scanning CONFIGURATOR
1. Click Scan To. Unified Driver Configurator is a tool primarily intended for configuring
TS | machine devices. You need to install Unified Linux Driver to use Unified
‘ ] Driver Configurator (See "Installing the Unified Linux Driver" on page 35).
— After the driver is installed on your Linux system, the Unified Driver
y @ Configurator icon will automatically be created on your desktop.
Scan To I}nage Print . .- . .
Ewal  Foder  OCR Web  Sefinge Opening the Unified Driver Configurator
e }Appm,m 1. Double-click the Unified Driver Configurator on the desktop.
- You can also click the Startup Menu icon and select Samsung Unified
- Driver > Unified Driver Configurator.
it 2. Click each button on the left to switch to the corresponding configuration
a =, : window.
: < e )
& @ Prirters | Ciasses |
i = © —
RawTove Prinsar I
[ He | [ ooeel | [ Pessan ][ conime | Setas Detault
s |
« Application: Scanning an image and placing it in an image editor |
application, such as Paint or Adobe Photoshop. o ||
* E-mail: Scanning an image and emailing it. Allows you to scan swow |
an image, preview it, and email it. wep |
To send an image by e-mail, you must have a mail client 1 Printers
program, like Outlook Express, which has been set up with Configuration
your e-mail account. ",_:,J"‘;';:::‘;;.—‘ 2 Scanners
Vot Configuration
« Folder: Scanning an image and saving it to a folder. Allows you ] e p iguratl
to scan an image, preview it, and save it to the folder of your (o= 3 orts_ .
choice. L Configuration
* OCR: Scanning an image and performing text recognition. Allows '/, To use the on screen help, click Help.
you to scan an image, preview it, and send it to the OCR program d '
for text recognition. 3. After changing the configurations, click Exit to close the Unified Driver

- Recommended scan option for OCR. Configurator.
- Resolution: 200 or 300 dpi.
- Image type: grayscale or black & white.

* Web: Scanning an image, previewing it, and publishing it on a
web site, using the specified file format for the image you want to
publish.

« Settings: Customizing settings of Scan To basic functions.
Allows you to customize settings for Application, E-mail, OCR,
and Web functions.

2. Set scan settings and click Scan.

Printers configuration
Printers configuration has the two tabs: Printers and Classes.

Printing

1. Click Print.

2. Select the file you want to print.

3. Select the machine you want to use for printing.
4. Click Print to start the job.
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Printers tab

View the current system’s printer configuration by clicking on the
machine icon button on the left side of the Unified Driver Configurator
window.

Unified Driver Configurator 3
~Priniars configurabion —
Privtors | Ciassos |

31. Reren |

¢l B
|

3 Jseswcwd printer; -
Local printeridie)
Model:

URL:

Switches to Printers configuration.

Shows all of the installed machine.

©®&E

Shows the status, model name and URI of your machine.

The printer control buttons are, as follows:

Refresh: Renews the available machines list.
Add Printer: Allows you to add a new machines.
Remove Printer: Removes the selected machine.

Set as Default: Sets the current selected machine as a default
machine.

Stop/Start: Stops/starts the machine.

Test: Allows you to print a test page to ensure the machine is
working properly.
Properties: Allows you to view and change the printer properties.

Classes tab
The Classes tab shows a list of available machine classes.

- Unified Driver Configurater >
- Printers.
|@ Prinioes | Classes |
= 1‘ Retasn
EI Roa ciass.
| Ramove Class
Setas Detautt
= |
Properties...
o fmil |
o ey
o Selected ciass:
State: icle
Priners In class:
[ea |

Shows all of the machine classes.

Refresh: Renews the classes list.
Add Class: Allows you to add a new machine class.

@ Shows the status of the class and the number of machines in the class.
* Remove Class: Removes the selected machine class.

Scanners configuration

In this window, you can monitor the activity of scanner devices, view a list of installed
Samsung machine devices, change device properties, and scan images.

- Unifi ed Driver Configurator E3
Scareers configuration — -

€ s

Switches to Scanners configuration.

Shows all of the installed scanners.

Bjo)e

Shows the vendor, model name and type of your scanner.

* Properties: Allows you to change the scan properties and scan a document.
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Ports configuration

In this window, you can view the list of available ports, check the status of
each port and release a port that is stalled in a busy state when its owner
has terminated the job for any reason.

Unified Driver Configurator >

oo =
EI L2 B ey
=

[EEEEETE] cevmipS devimipd /evmin? Help |

Kovimips idowmipd Kovimipi0 dowmip11

Switches to Ports configuration.

Shows all of the available ports.

L

Shows the port type, device connected to the port, and status.

* Refresh: Renews the available ports list.
* Release port: Releases the selected port.

Sharing Ports Between Printers and Scanners

Your machine may be connected to a host computer via a parallel port
or USB port. Since the machine device contains more than one device
(printer and scanner), it is necessary to organize proper access of
“consumer” applications to these devices via the single I/O port.

The Unified Linux Driver package provides an appropriate port sharing
mechanism that is used by Samsung printer and scanner drivers. The
drivers talk to their devices via so-called machine ports. The current
status of any machine port can be viewed via the Ports configuration.
The port sharing prevents you from accessing one functional block of
the machine device, while another block is in use.

When you install a new machine device onto your system, it is strongly
recommended you do this with the assistance of an Unified Driver
Configurator. In this case you will be asked to choose 1/O port for the
new device. This choice will provide the most suitable configuration for
machine’s functionality. For machine scanners, 1/O ports are being
chosen by scanner drivers automatically, so proper settings are applied
by default.
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mMantenance

This chapter provides information for maintaining your machine and the toner cartridge.

This chapter includes:

« Printing a machine report
« Monitoring the supplies life
« Using toner low alert

« Finding the serial number

PRINTING A MACHINE REPORT

You can print the machine's information and job report.

1. Press Menu on the control panel.

2. Press the left/right arrow until System Setup appears and press OK.
3. Press the left/right arrow until Report appears and press OK.
4

. Press the left/right arrow until the report or list you want to print
appears.press OK.
To print all reports and lists, select All Report.
5. Press the left/right arrow to appears Yes at the Print? prompt and press
OK.

'g You can use SyncThru™ Web Service to print the machine's
configuration or browse the status. Open the web browser in the
networked computer and type the machine's IP address. When
SyncThru™ Web Service opens, click Information > Print
information.

MONITORING THE SUPPLIES LIFE

If you experience frequent paper jams or printing problems, check the
number of pages the machine has printed. Replace the corresponding
parts, if necessary.

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Maintenance appears and press OK.
Press the left/right arrow until Supplies Life appears and press OK.
Press the left/right arrow until the item you want appears and press OK.
» Supplies Info: Prints the supply information page.

* Total: Displays the total number of pages printed.

* ADF Scan: Displays the number of pages scanned using the ADF.

» Platen Scan: Displays the number of pages scanned using the
scanner glass.

6. Press Stop/Clear to return to ready mode.

Ll ol o

USING TONER LOW ALERT

If the amount of toner in the cartridge is low, a message informing user to
change the toner cartridge appears. You can set the option for this message
to appear or not.

* Cleaning the machine
« Storing the toner cartridge
» Tips for moving & storing your machine

In the control panel

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Maintenance appears and press OK.
Press the left/right arrow until TonerLow Alert appears and press OK.
Select the appropriate setting and then click OK.

Press Stop/Clear to return to ready mode.

In the Smart Panel

1. Double-click the Smart Panel icon on the Windows task bar (or
Notification Area in Linux). You can also click Smart Panel on the status
bar in Mac OS X.

Or, if you are a Windows user, you can launch it from the Start menu,
select Programs or All Programs > Samsung Printers > your printer
driver name > Smart Panel.

2. Click Printer Setting.

3. Click Setting > Toner Low Alert. Select the appropriate setting and
then click Apply.

ok ON =

FINDING THE SERIAL NUMBER

When you call for service or register as a user on the Samsung website, the
machine’s serial number by taking the following steps:

Press Menu on the control panel.

Press the left/right arrow until System Setup appears and press OK.
Press the left/right arrow until Maintenance appears and press OK.
Press the left/right arrow until Serial Number appears and press OK.
Check your machine’s serial number.

Press Stop/Clear to return to ready mode.

ok ON =

CLEANING THE MACHINE

If printing quality problems occur or if you use your machine in a dusty
environment, you need to clean your machine regularly to keep the best
printing condition and use your machine longer.

A + Cleaning the cabinet of the machine with cleaning materials
containing large amounts of alcohol, solvent, or other strong
substances can discolor or distort the cabinet.

« If your machine or the surrounding area is contaminated with
toner, we recommend you use cloth or tissue dampened with
water to clean it. If you use a vacuum cleaner, toner blows in the
air and might be harmful to you.
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Cleaning the outside

Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth
slightly with water, but be careful not to let any water drip onto or into the
machine.

Cleaning the inside

During the printing process, paper, toner, and dust particles can accumulate
inside the machine. This buildup can cause print quality problems, such as
toner specks or smearing. Cleaning the inside of the machine clears and
reduces these problems.

1. Turn the machine off and unplug the power cord. Wait for the machine to
cool down.

2. Open the front door and pull the toner cartridge out. Set it on a clean flat
surface

A * To prevent damage to the toner cartridge, do not expose it to
light for more than a few minutes. Cover it with a piece of
paper, if necessary.

* Do not touch the green surface underside of the toner
cartridge. Use the handle on the cartridge to avoid touching
this area.

3. With a dry, lint-free cloth, wipe away any dust and spilled toner from the
toner cartridge area.

While cleaning the inside of the machine, be careful not to damage
the transfer roller or any other inside parts. Do not use solvents
such as benzene or thinner to clean. Printing quality problems can
occur and cause damage to the machine.

4. Locate the long strip of glass (LSU) inside the top of the cartridge
compartment and gently clean the glass with a swab.

|
U

5. Reinsert the toner cartridge and close the front door.
6. Plug in the power cord and turn the machine on.

Cleaning the scan unit

Keeping the scan unit clean helps ensure the best possible copies. We

suggest that you clean the scan unit at the start of each day and during the

day, as needed.

1. Slightly dampen a soft, lint-free cloth or paper towel with water.

2. Open the scanner lid.

3. Wipe the surface of the scanner glass and the document feeder glass
until it is clean and dry.

1 Scanner lid

2 Scanner glass

3 Document feeder
glass

4 White bar

4. Wipe the underside of the scanner lid and white bar until it is clean and
dry.
5. Close the scanner lid.

STORING THE TONER CARTRIDGE

Toner cartridges contain components that are sensitive to light,
temperature, and humidity. Samsung suggests users follow the
recommendations to ensure the optimum performance, highest quality, and
longest life from your new Samsung toner cartridge.

Store this cartridge in the same environment as the printer it will be used in;
this should be in controlled office temperature and humidity conditions. The
toner cartridge should remain in its original, unopened package until
installation — If original packaging is not available, cover the top opening of
the cartridge with paper and store in a dark cabinet.
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Opening the cartridge package prior to use dramatically shortens its useful
shelf and operating life. Do not store on the floor. If the toner cartridge is
removed from the printer, always store the cartridge:

« Inside the protective bag from the original package.

« Store lying flat (not standing on end) with the same side facing up as if
they were installed in the machine.

* Do not store consumable in;
- Temperature greater than 40 °C (104 °F).
- Humidity range less than 20 % and not greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- Acar for along period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Handling instructions

« Do not touch the surface of the photosensitive drum in the cartridge.

« Do not expose the cartridge to unnecessary vibrations or shock.

* Never manually rotate the drum, especially in the reverse direction; this
can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of
non-Samsung brand toner cartridges in your printer including generic, store
brand, refilled, or remanufactured toner cartridges.

Samsung’s printer warranty does not cover damage to the machine
caused by the use of a refilled, remanufactured, or non-Samsung
brand toner cartridge.

Estimated cartridge life

Estimated cartridge life (the life of the toner cartridge yield) depends on the
amount of toner that print jobs require. The actual print-out number may
vary depending on the print density of the pages you print on, operating
environment, printing interval, media type, and/or media size. For example,
if you print a lot of graphics, the consumption of the toner is high and you
may need to change the cartridge more often.

TIPS FOR MOVING & STORING YOUR MACHINE

« When moving the machine, do not tilt or turn it upside down. Otherwise,
the inside of the machine may be contaminated by toner, which can
cause damage to the machine or bad print quality.

« When moving the machine, make sure at least two people are holding
the machine securely.
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tfroupleshooting

This chapter gives helpful information for what to do if you encounter an error.

This chapter includes:

« Redistributing toner

« Clearing original document jams
« Tips for avoiding paper curls

« Tips for avoiding paper jams

REDISTRIBUTING TONER

When the toner cartridge is near the end of its life:

*  White streaks or light printing occurs.

* Prepare new cartridge appears on the display.

* The Status LED blinks red.

If this happens, you can temporarily improve print quality by redistributing
the remaining toner in the cartridge. In some cases, white streaks or light
printing will still occur even after you have redistributed the toner.

1. Open the front door.

2. Pull the toner cartridge out.

3. Thoroughly roll the cartridge five or six times to distribute the toner
evenly inside the cartridge.

',g If toner gets on your clothing, wipe it off with a dry cloth and wash
clothing in cold water. Hot water sets toner into fabric.

Do not touch the green underside of the toner cartridge. Use the
handle on the cartridge to avoid touching this area.

4. Hold the toner cartridge by the handle and slowly insert the cartridge into

the opening in the machine.

» Clearing paper jams
» Understanding display messages
* Solving other problems

Tabs on the sides of the cartridge and corresponding grooves within the
machine will guide the cartridge into the correct position until it locks into
place completely.

5. Close the front door. Ensure that the cover is securely closed.

CLEARING ORIGINAL DOCUMENT JAMS

When an original jams while passing through the document feeder, a
warning message appears on the display screen.

To avoid tearing the document, remove the jammed document slowly
and gently.

',g To prevent document jams, use the scanner glass for thick, thin, or
mixed paper-type originals.
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1. Remove any remaining pages from the document feeder.
2. Open the document feeder cover.

’g If you see no paper in this area, go to step 5.

4. Close the document feeder cover. Reload the pages you removed, if
any, in the document feeder.

5. Open the scanner lid.

6. Seize the misfeed paper, and remove the paper from the feed area by
carefully pulling it to the right using both hands.

1 scanner lid

7. Close the scanner lid. Load the removed pages back into the document
feeder.

TIPS FOR AVOIDING PAPER CURLS

1. Open the rear door.
2. Pull down the pressure lever on each side.

1 Pressure lever

w Keep the rear cover opened during printing.
Only use when the printout has more than 20 mm curl.

_1—20 mm(7.87 in)

TIPS FOR AVOIDING PAPER JAMS

By selecting the correct media types, most paper jams can be avoided.

When a paper jam occurs, refer to the next guidelines.

* Ensure that the adjustable guides are positioned correctly (See "Loading
paper in the tray" on page 61).

» Do not overload the tray. Ensure that the paper level is below the paper
capacity mark on the inside of the tray.

* Do not remove paper from the tray while your machine is printing.

« Flex, fan, and straighten paper before loading.

* Do not use creased, damp, or highly curled paper.
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« Do not mix paper types in a tray.

« Use only recommended print media (See "Setting the paper size and
type" on page 64).

« Ensure that the recommended side of the print media is facing down in
the tray, or facing up in the manual tray.

CLEARING PAPER JAMS

When a paper jam occurs, a warning message appears on the display.

To resume printing after clearing paper jams, you must open and close the
front door.

To avoid tearing the paper, pull the jammed paper out slowly and
gently. Follow the instructions in the following sections to clear the
jam.

In tray 1

'g Click this link to open an animation about clearing a jam.

1. Open and close the front door. The jammed paper is automatically
ejected from the machine.

If the paper does not exit, go to the next step.
2. Pullouttray 1.

If the paper does not move when you pull, or if you do not see the paper
in this area, check the fuser area around the toner cartridge (See "Inside
the machine" on page 106).

4. Insert tray 1 back into the machine until it snaps into place. Printing
automatically resumes.

In the manual tray
'g Click this link to open an animation about clearing a jam.

1. If the paper is not feeding properly, pull the paper out of the machine.

2. Open and close the front door to resume printing.

Inside the machine
',g Click this link to open an animation about clearing a jam.

The fuser area is hot. Take care when removing paper from the
machine.

1. Open the front door and pull the toner cartridge out, lightly pushing it
down.
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2. Remove the jammed paper by gently pulling it straight out.

3. Replace the toner cartridge and close the front door. Printing
automatically resumes.

In exit area

',g Click this link to open an animation about clearing a jam.

1. Open and close the front door. The jammed paper is automatically
ejected from the machine.
If you do not see the jammed paper, go to next step.

2. Gently pull the paper out of the output tray.

If you do not see the jammed paper or if there is any resistance when
you pull, stop and go to the next step.

3. Open the rear door.
4. Pull the pressure levers down and remove the paper.

1 Pressure lever

If you do not see the jammed paper, go to next step.
5. Pull the fuser cover levers down and remove the paper.
Return the fuser cover levers to their original position.

',g The fuser area is hot. Take care when removing paper from the
machine.

6. Return the pressure levers to their original position.
7. Close the rear door.
8. Open and close front door, printing automatically resumes.
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UNDERSTANDING DISPLAY MESSAGES

Messages appear on the control panel display to indicate the machine’s
status or errors. Refer to the tables below to understand the messages’ and
their meaning, and correct the problem, if necessary.

Checking display messages
w + If amessage is not in the table, reboot the power and try the
printing job again. If the problem persists, call for service.

*  When you call for service, provide the service representative with
the contents of display message.

* Some messages may not appear in the display depending on the
options or models.

» [error number] indicates the error number.

» [tray type] indicates the tray number.

» [media type] indicates the media type.

» [media size] indicates the media size.

+ [color] indicates the color of toner or imaging unit.

MESSAGE

MEANING

SUGGESTED
SOLUTIONS

DHCP problem:

The IP address

Change the IP address

Auto IP Run assignment is failed. assignment method to
This happens, when BOOTP or Static. If you
Auto IP for DHCP is do not change this option,
set in SyncThru Web | the DHCP server
Service. continually asks to assign

the IP Address.

DHCP problem The IP address Change the IP address

Reconfigure assignment is failed. assignment method to

BOOTP This happens, when BOOTP or Static. If you

Auto IP for DHCP is
not set in SyncThru
Web Service.

do not change this option,
the DHCP server
continually asks to assign
the IP Address.

Document Jam.

Remove Jam

The loaded original
has jammed in the
ADF.

Clear the jam (See
"Clearing original
document jams" on
page 104).

Door Open.
Close it

The front cover is not
securely latched.

Close the cover until it
locks into place.

SUGGESTED
MESSAGE MEANING SOLUTIONS

[COMM. Error] The machine has a Ask the sender to try
communication again.
problem.

[Incompatible] The machine has The received fax data will
received a fax from be deleted. Reconfirm
which is registered as | junk fax setup. See page
a junk fax. 50

[Line Busy] The receiving fax Try again after a few
machine did not minutes.
answer or the line is
already engaged.

[Line Error] Your machine cannot | Try again. If the problem
connect with the persists, wait an hour or
receiving fax machine | so for the line to clear and
or has lost contact try again. Or, turn the

because of a problem | ECM mode on. See page
with the phone line. 50.

[Stop Pressed] Stop/Clear has been | Try again.

pressed during an

operation.
BOOTP problem The IP address Change the IP address
Auto IP Run assignment is failed. assignment method to

This happens, when DHCP or Static. If you do
Auto IP for BOOTP is | not change this option,
set in SyncThru Web | the BOOTP server

Service. continually asks to assign
the IP Address.
BOOTP problem The IP address Change the IP address
Reconfigure DHCP | assignment is failed. assignment method to

This happens, when DHCP or Static. If you do
Auto IP for BOOTP is | not change this option,
not set in SyncThru the BOOTP server

Web Service. continually asks to assign
the IP Address.
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MESSAGE

MEANING

SUGGESTED
SOLUTIONS

End of life
Replace new cart

The indicated toner
cartridge has reached
its estimated cartridge
life. The printer stops
printing.

',g Estimated
cartridge life
means the
expected or
estimated toner
cartridge life,
which indicates
the average
capacity of
print-outs and is
designed
pursuant to
ISO/IEC 19752
(See "Available
supplies" on
page 120).

The number of
pages may be
affected by
operating
environment,
printing interval,
media type, and
media size.
Some amount of
toner may
remain in the
cartridge even
when End of
life Replace
new cart
appears and the
printer stops
printing.

Replace the toner
cartridge (See "Replacing
the toner cartridge" on
page 120).

SUGGESTED
MESSAGE MEANING SOLUTIONS
Memory Full The memory is full. Press the left/right arrow
Remove Job to highlight Cancel or

Start, then press OK. If
you select Cancel, the
machine stops the fax
job. If you select Start,
the machine only sends
scanned documents of
the fax job.

Network Problem:
IP Conflict

The IP address is
used elsewhere.

Check the IP address or
obtain a new IP address.

No Answer

The receiving fax
machine has not
answered after
several redial
attempts.

Try again. Make sure that
the receiving machine is
operational.

Not Compatible
toner cartridge

The toner cartridge is
not suitable for your
machine.

Install the corresponding
toner cartridge with a
Samsung-genuine
cartridge (See "Replacing
the toner cartridge" on
page 120).

Output bin Full
Remove paper

The output tray is full.

Or the sensor is not
facing down.

Remove papers from the
output tray, the machine
resumes printing. Or
make sure the sensor is
facing down. If the
problem persists, call for
service.

Paper Empty
in [tray number]

There is no paper in
the indicated tray.

Load paper in the tray
(See "Loading paper in
the tray" on page 61).

Error [error number]

Turn off then on

A systematic error has
occurred

Reboot the power and try
the printing job again. If
the problem persists, call
for service.

Install Toner

The toner cartridge is
installed improperly,
or not installed.

Reinstall the toner
cartridge two or three
times to confirm it is
seated properly. If the
problem persists, the
toner cartridge is not
being detected. Contact
the service
representatives.

Pulled Out The indicated tray To close the tray, lower
[tray number] cassette is not the rear edge, align it with
Cassette inserted, or not the slot, and slide it into

properly closed. the printer.
Paper Jam Paper has jammed in | Clear the jam (See "In the
in MP Tray the manual tray area. | manual tray" on

page 106).

Paper Jam Paper has jammed in | Clear the jam (See "In
in Tray 1 the tray1 area. tray 1" on page 106).
Paper Jam Paper has jammed Clear the jam (See

inside machine

inside the machine.

"Inside the machine" on
page 106).

Load [media size] in

[tray number]

There is no
corresponding paper
in the corresponding
tray.

Load corresponding
paper in the
corresponding tray (See
"Loading paper in the
tray" on page 61).

Paper Jam
in exit area

Special print media
has jammed in the
paper exit area.

Clear the jam.

* See "In exit area" on
page 107.

* See "In the manual
tray" on page 106)
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MESSAGE

MEANING

SUGGESTED
SOLUTIONS

MESSAGE

MEANING

SUGGESTED
SOLUTIONS

Prepare new
cartridge

Small amount of toner
is left in the indicated
cartridge. The
estimated cartridge
life of toner is close.

Prepare a new cartridge
for a replacement. You
may temporarily increase
the printing quality by
redistributing the toner
(See "Redistributing
toner" on page 104).

Replace new
Fuser unit

The life of the fuser
unit has expired.

Replace the fuser unit
with a new one. Contact
the service
representatives.

Remove seal tape
&Install Toner

The machine cannot
detect a toner
cartridge.

Remove the sealing tape
from the toner cartridge.
Refer to Quick Install
Guide.

Self Diagnostics
Please wait

The engine in your
printer is checking
some problems
detected.

Please wait a few
minutes.

Too many Faxes
Remove Job

Too many faxes are
received.

Remove received fax.

Replace Toner

The toner cartridge
has almost reached its
estimated cartridge
life.

You can choose between
Stop or Continue as
shown on the control
panel. If you select Stop,
the printer stops printing
and you cannot print any
more without changing
the cartridge. If you select
Continue, the printer
keeps printing but the
printing quality cannot be
guaranteed.

Replace the toner
cartridge for the best print
quality when this
message appears. Using
a cartridge beyond this
stage can result in
printing quality issues
(See "Replacing the toner
cartridge" on page 120).

Samsung does not
recommend using
non-genuine
Samsung toner
cartridge such as
refilled or
remanufactured.
Samsung cannot
guarantee
non-genuine
Samsung toner
cartridge's quality.
Service or repair
required as a result
of using
non-genuine
Samsung toner
cartridges will not
be covered under
the machine
warranty.
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SOLVING OTHER PROBLEMS

The following chart lists some conditions that may occur and the
recommended solutions. Follow the suggested solutions until the problem is

corrected. If the problem persists, call for service.

Paper feeding problems

CONDITION

SUGGESTED SOLUTIONS

Paper jams during

Power problems

w Click this link to open an animation about solving power problems.

printing.

Clear the paper jam (See "Clearing paper jams"
on page 106).

CONDITION

SUGGESTED SOLUTIONS

The machine is
not receiving
power,

or the connection
cable between the
computer and the
machine is not
connected

properly.

¢ Plug in the power cord and press @ (power)
on the control panel.

« Disconnect the machine cable and reconnect
it.
- For Local Printing

only)

Paper sticks
together.

* Check the maximum paper capacity of the
tray (See "Print media specifications" on
page 124).

* Make sure that you are using the correct type
of paper (See "Print media specifications" on
page 124).

* Remove paper from the tray and flex or fan
the paper.

* Humid conditions may cause some paper to
stick together.

Multiple sheets of
paper do not feed.

Different types of paper may be stacked in the
tray. Load paper of only one type, size, and
weight.

Paper does not feed
into the machine.

* Remove any obstructions from inside the
machine.

* Paper has not been loaded correctly. Remove
paper from the tray and reload it correctly.

* There is too much paper in the tray. Remove
excess paper from the tray.

* The paper is too thick. Use only paper that
meets the specifications required by the
machine (See "Print media specifications" on
page 124).

< If an original does not feed into the machine,
the document feeder rubber pad may require
to be replaced. Contact a service
representative.

The paper keeps
jamming.

« There is too much paper in the tray. Remove
excess paper from the tray. If you are printing
on special materials, use the manual tray.

« Anincorrect type of paper is being used. Use
only paper that meets the specifications
required by the machine (See "Print media
specifications" on page 124).

* There may be debris inside the machine.
Open the front door and remove any debris.

» If an original does not feed into the machine,
the document feeder rubber pad may need to
be replaced. Contact a service representative.

Transparencies stick
together in the paper
exit.

Use only transparencies specifically designed
for laser printers. Remove each transparency as
it exits from the machine.

Envelopes skew or
fail to feed correctly.

Ensure that the paper guides are against both
sides of the envelopes.
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Printing problems

CONDITION

POSSIBLE
CAUSE

SUGGESTED
SOLUTIONS

CONDITION

POSSIBLE
CAUSE

SUGGESTED
SOLUTIONS

The machine
does not print.

The machine is not
receiving power.

Check the power cord
connections.

The machine is not
selected as the
default machine.

Select your machine as your
default machine in your
Windows.

Check the machine for the following:
« The front door is not closed. Close the front

door.

« Paper is jammed. Clear the paper jam (See
"Clearing paper jams" on page 106).

* No paper is loaded. Load paper (See "Loading
paper in the tray" on page 61).

* The toner cartridge is not installed. Install the

toner cartridge.

If a system error occurs, contact your service

representative.

The machine
does not print.

The document size
is so big that the
hard disk space of
the computer is
insufficient to

access the print job.

Get more hard disk space
and print the document
again.

The output tray is
full.

Once the paper is removed
from the output tray, the
machine resumes printing.

The connection
cable between the
computer and the
machine is not
connected properly.

Disconnect the machine
cable and reconnect it.

The machine
selects print
materials from
the wrong paper
source.

The paper option
that was selected in
the Printing
Preferences may
be incorrect.

For many software
applications, the paper
source selection is found
under the Paper tab within
the Printing Preferences.
Select the correct paper
source. See the printer
driver help screen (See
"Opening printing
preferences" on page 67).

A print job is
extremely slow.

The job may be
very complex.

Reduce the complexity of
the page or try adjusting the
print quality settings.

The connection
cable between the
computer and the
machine is
defective.

If possible, attach the cable
to another computer that is

working properly and print a
job. You can also try using a
different machine cable.

The port setting is
incorrect.

Check the Windows printer
setting to make sure that the
print job is sent to the correct
port. If the computer has
more than one port, make
sure that the machine is
attached to the correct one.

Half the page is
blank.

The page
orientation setting
may be incorrect.

Change the page orientation
in your application. See the
printer driver help screen.

The paper size and
the paper size
settings do not
match.

Ensure that the paper size in
the printer driver settings
matches the paper in the
tray.

Or, ensure that the paper
size in the printer driver
settings matches the paper
selection in the software
application settings you use.

The machine may
be configured
incorrectly.

Check the Printing
Preferences to ensure that
all of the print settings are
correct (See "Opening
printing preferences" on
page 67).

The printer driver
may be incorrectly
installed.

Repair the machine software
(See "Installing USB
connected machine’s driver”
on page 33, "Installing wired
network connected
machine’s driver" on

page 39).

The machine is
malfunctioning.

Check the display message
on the control panel to see if
the machine is indicating a
system error. Contact a
service representative.

The machine
prints, but the
text is wrong,
garbled, or
incomplete.

The machine cable
is loose or
defective.

Disconnect the machine
cable and reconnect. Try a
print job that you have
already printed successfully.
If possible, attach the cable
and the machine to another
computer that you know
works and try a print job.
Finally, try a new machine
cable.

The wrong printer

driver was selected.

Check the application’s
printer selection menu to
ensure that your machine is
selected.

The software
application is
malfunctioning.

Try printing a job from
another application.

The operating
system is
malfunctioning.

Exit Windows and reboot the
computer. Turn the machine
off and back on again.
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CONDITION

POSSIBLE
CAUSE

SUGGESTED
SOLUTIONS

CONDITION

SUGGESTED SOLUTIONS

Pages print, but
they are blank.

The toner cartridge
is defective or out of
toner.

Redistribute the toner, if
necessary.

If necessary, replace the
toner cartridge.

The file may have
blank pages.

Check the file to ensure that
it does not contain blank
pages.

Some parts, such
as the controller or
the board, may be
defective.

Contact a service
representative.

The machine
does not print

PDF file correctly.

Some parts of
graphics, text, or
illustrations are
missing.

Incompatibility
between the PDF
file and the Acrobat
products.

Printing the PDF file as an
image may enable the file to
print. Turn on Print As
Image from the Acrobat
printing options.

',g It will take longer to
print when you print a
PDF file as an image.

The print quality
of photos is not
good. Images are
not clear.

The resolution of
the photo is very
low.

Reduce the photo size. If
you increase the photo size
in the software application,
the resolution will be
reduced.

Light or faded print

AathbCc
AathCc
AathCc
AabhCc
AathCc

If a vertical white streak or faded area
appears on the page, the toner supply is low.
You may be able to temporarily extend the
toner cartridge life (See "Redistributing toner"
on page 104). If this does not improve the
print quality, install a new toner cartridge.
The paper may not meet paper specifications;
for example, the paper may be too moist or
rough (See "Print media specifications" on
page 124).

If the entire page is light, the print resolution
setting is too low or the toner save mode is
on. Adjust the print resolution and turn the
toner save mode off. See the help screen of
the printer driver.

A combination of faded or smeared defects
may indicate that the toner cartridge needs
cleaning (See "Cleaning the inside" on

page 102).

The surface of the LSU part inside the
machine may be dirty (See "Cleaning the
inside" on page 102).

Before printing,
the machine
emits vapor near
the output tray.

Using damp paper
can cause vapor
during printing.

This is not a problem. Just
keep printing.

The machine
does not print
special- sized
paper, such as
billing paper.

Paper size and
paper size setting
do not match.

Set the correct paper size in
the Custom Paper Size
Settings in the Paper tab in
the Printing Preferences
(See "Opening printing
preferences" on page 67).

Toner specks

Aa Cc
Aa:Cc
Aa Cc
A'a. Ce
Aa:Ckc

The paper may not meet specifications; for
example, the paper may be too moist or rough
(See "Print media specifications" on

page 124).

The transfer roller may be dirty. Clean the
inside of your machine. Contact a service
representative.

The paper path may need cleaning. Contact a
service representative.

Printing quality problems

If the inside of the machine is dirty or paper has been loaded improperly,
there might be a reduction in print quality. See the table below to clear the

problem.

Dropouts

AaB!
A a
A a
Aa
A a

O W wm
OO TUTO
eololeYale!

If faded areas, generally rounded, occur
randomly on the page:

A single sheet of paper may be defective.
Try reprinting the job.

The moisture content of the paper is uneven
or the paper has moist spots on its surface.
Try a different brand of paper (See "Print
media specifications" on page 124).

The paper lot is bad. The manufacturing
processes can cause some areas to reject
toner. Try a different kind or brand of paper.
Change the printer option and try again. Go
to Printing Preferences, click Paper tab,
and set type to Thick (See "Opening printing
preferences" on page 67).

If these steps do not correct the problem,
contact a service representative.
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CONDITION

SUGGESTED SOLUTIONS

White Spots

If white spots appear on the page:

» The paper is too rough and a lot of dirt from a
paper falls to the inner devices within the
machine, so the transfer roller may be dirty.
Clean the inside of your machine (See
"Cleaning the inside" on page 102).

* The paper path may need cleaning (See
"Cleaning the inside" on page 102).

Vertical lines

AaBhCq
AaBbCq
AaBbCq
AaBbCq
AaBbCc

@——600

If black vertical streaks appear on the page:

* The surface (drum part) of the toner
cartridge inside the machine has probably
been scratched. Remove the toner cartridge
and install a new one (See "Replacing the
toner cartridge" on page 120).

If white vertical streaks appear on the page:

» The surface of the LSU part inside the
machine may be dirty (See "Cleaning the
inside" on page 102).

CONDITION SUGGESTED SOLUTIONS
Background Background scatter results from bits of toner
scatter randomly distributed on the printed page.

* The paper may be too damp. Try printing
with a different batch of paper. Do not open
packages of paper until necessary so that
the paper does not absorb too much
moisture.

+ If background scatter occurs on an envelope,
change the printing layout to avoid printing
over areas that have overlapping seams on
the reverse side. Printing on seams can
cause problems.

+ If background scatter covers the entire
surface area of a printed page, adjust the
print resolution through your software
application or in Printing Preferences (See
"Opening printing preferences" on page 67).

Black background

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

If the amount of background shading becomes

unacceptable:

» Change to a lighter weight paper (See "Print
media specifications" on page 124).

» Check the environmental conditions: very
dry conditions or a high level of humidity
(higher than 80% RH) can increase the
amount of background shading.

* Remove the old toner cartridge and, install a
new one (See "Replacing the toner
cartridge" on page 120).

Toner smear

AaBbCc
AaBhCc
AaBhCc
AaBhCc
AaBbCc

If toner smears on the page:

* Clean the inside of the machine (See
"Cleaning the inside" on page 102).

» Check the paper type and quality (See "Print
media specifications" on page 124).

* Remove the toner cartridge and then, install
a new one (See "Replacing the toner
cartridge" on page 120).

Misformed » If characters are improperly formed and
characters producing hollow images, the paper stock
may be too slick. Try different paper (See
AaBbCc "Print media specifications" on page 124).
AaBbCc » If characters are improperly formed and
AaBbCc producing a wavy effect, the scanner unit may
need service (See "Cleaning the scan unit" on
fameos| | A
AaBbCc
Page skew » Ensure that the paper is loaded properly.

* Check the paper type and quality (See "Print
media specifications" on page 124).

» Ensure that the guides are not too tight or too
loose against the paper stack.

Vertical repetitive
defects

AaBbCc
AaBbCc_
AaBbCc
AaBbCc_
AaBbCc

If marks repeatedly appear on the printed side of

the page at even intervals:

* The toner cartridge may be damaged. If you
still have the same problem, remove the
toner cartridge and, install a new one (See
"Replacing the toner cartridge" on
page 120).

+ Parts of the machine may have toner on
them. If the defects occur on the back of the
page, the problem will likely correct itself
after a few more pages.

* The fusing assembly may be damaged.
Contact a service representative.

Curl or wave
~
AappCC
AappCC
AappGC
AappCC
AappCC

-~

» Ensure that the paper is loaded properly.

» Check the paper type and quality. Both high
temperature and humidity can cause paper
curl (See "Print media specifications" on
page 124).

» Turn the stack of paper over in the tray. Also
try rotating the paper 180° in the tray.
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CONDITION

SUGGESTED SOLUTIONS

Wrinkles or
creases

AaBbCc
AaBbCc

Ensure that the paper is loaded properly.
Check the paper type and quality (See "Print
media specifications" on page 124).

Turn the stack of paper over in the tray. Also
try rotating the paper 180° in the tray.

Back of printouts
are dirty

Check for leaking toner. Clean the inside of the
machine (See "Cleaning the inside" on
page 102).

Solid Color or
Black pages

The toner cartridge may not be installed

properly. Remove the cartridge and reinsert it.

The toner cartridge may be defective.
Remove the toner cartridge and install a new
one (See "Replacing the toner cartridge" on
page 120).

The machine may require repair. Contact a
service representative.

CONDITION

SUGGESTED SOLUTIONS

Horizontal stripes

A

A

n D Q
W w
(o 3leen
OO

A
A

%

I>
Q)

0J
T
(@)

If horizontally aligned black streaks or smears

appear:

* The toner cartridge may be installed
improperly. Remove the cartridge and
reinsert it.

* The toner cartridge may be defective.
Remove the toner cartridge and install a new
one (See "Replacing the toner cartridge" on
page 120).

+ If the problem persists, the machine may
require repair. Contact a service
representative.

Curl

AaBbCc
AaBbCc
AaBbCc

If the printed paper is curled or paper does not

feed into the machine:

* Turn the stack of paper over in the tray. Also
try rotating the paper 180° in the tray.

» Change the printer option and try again. Go
to Printing Preferences, click Paper tab,
and set type to Thin (See "Opening printing
preferences" on page 67).

An unknown image
repetitively
appears on a few
sheets or loose
toner, light print, or
contamination
occurs.

Your machine is probably being used at an
altitude of 1,000 m (3,281 ft.) or above.

The high altitude may affect the print quality,
such as loose toner or light imaging. Change the
correct altitude setting to your machine (See
"Altitude adjustment” on page 55).

Copying problems

CONDITION

SUGGESTED SOLUTION

Loose toner

AaBb(Cc
AaBbCc

Clean the inside of the machine (See
"Cleaning the inside" on page 102).

Check the paper type and quality (See "Print
media specifications" on page 124).

Remove the toner cartridge and then, install a
new one (See "Replacing the toner cartridge"
on page 120).

If the problem persists, the machine may
require repair. Contact a service
representative.

Copies are too light
or too dark.

Use Darkness in Copy feature to lighten or
darken the backgrounds of copies (See
"Changing the darkness" on page 74).

Character Voids

Character voids are white areas within parts of
characters that should be solid black:

If you are using transparencies, try another
type of transparency. Because of the
composition of transparencies, some
character voids are normal.

You may be printing on the wrong surface of
the paper. Remove the paper and turn it
around.

The paper may not meet paper
specifications (See "Print media
specifications” on page 124).

Smears, lines,
marks, or spots
appear on copies.

AaBbCc
AaBbCc
AaBbCc

AaBbCq
AaBb(Cq

» If the defects are on the original, use
Darkness in Copy feature to lighten the
background of your copies (See "Changing
the darkness" on page 74).

« If there are no defects on the original, clean
the scan unit (See "Cleaning the scan unit" on
page 102).

Copy image is
skewed.

* Ensure that the original is face down on the
scanner glass or face up in the document
feeder.

* Check that the copy paper is loaded correctly.

Blank copies print
out.

Ensure that the original is face down on the
scanner glass or face up in the document
feeder.
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CONDITION

SUGGESTED SOLUTIONS

Image rubs off the
copy easily.

Replace the paper in the tray with paper from
a new package.

In high humidity areas, do not leave paper in
the machine for extended periods of time.

Frequent copy paper
jams occur.

Fan the stack of paper, then turn it over in the
tray. Replace the paper in the tray with a fresh
supply. Check/adjust the paper guides, if
necessary.

Ensure that the paper is the proper paper
weight.

Check for copy paper or pieces of copy paper
remaining in the machine after a paper jam
has been cleared.

Toner cartridge
produces fewer
copies than
expected before
running out of toner.

Your originals may contain pictures, solids, or
heavy lines. For example, your originals may
be forms, newsletters, books, or other
documents that use more toner.

The scanner lid may be left open while copies
are being made.

Turn the machine off and back on.

Message appears on
your computer
screen:

* Device can’t be
set to the H/W
mode you want.

* Portis being used
by another
program.

* Portis Disabled.

+ Scanner is busy
receiving or
printing data.
When the current
job is completed.,
try again.

* Invalid handle.

* Scanning has
failed.

There may be a copying or printing job in

progress. Try your job again when that job is

finished.

« The selected port is currently being used.
Restart your computer and try again.

« The machine cable may be improperly
connected or the power may be off.

« The scanner driver is not installed or the
operating environment is not set up properly.

« Ensure that the machine is properly
connected and the power is on, then restart
your computer.

¢ The USB cable may be improperly

connected or the power may be off.

Scanning problems

Fax problems

CONDITION

SUGGESTED SOLUTIONS

CONDITION

SUGGESTED SOLUTIONS

The scanner does not
work.

Make sure that you place the original to be
scanned face down on the scanner glass, or
face up in the document feeder.

There may not be enough available memory
to hold the document you want to scan. Try
the Prescan function to see if that works.
Try lowering the scan resolution rate.
Check that the machine cable is connected
properly.

Make sure that the machine cable is not
defective. Switch the cable with a known
good cable. If necessary, replace the cable.
Check that the scanner is configured
correctly. Check scan setting in the
SmarThru or the application you want to use
to make certain that the scanner job is being
sent to the correct port (for example,
USBO001).

The machine is not
working, there is no
display, or the
buttons are not
working.

* Unplug the power cord and plug it in again.
« Ensure that there is power being supplied to
the electrical outlet.

No dial tone.

*  Check that the phone line is properly
connected.

* Check that the phone socket on the wall is
working by plugging in another phone.

The numbers stored
in memory do not
dial correctly.

Make sure that the numbers are stored in
memory correctly. Print an Address Book list
(See "Setting up address book" on page 89).

The unit scans very
slowly.

Check if the machine is printing received
data. If so, scan the document after the
received data has been printed.

Graphics are scanned more slowly than text.

Communication speed slows in scan mode
because of the large amount of memory
required to analyze and reproduce the
scanned image. Set your computer to the
ECP printer mode through BIOS setting. It
will help to increase the speed. For details
about how to set BIOS, refer to your
computer user’s guide.

The original does
not feed into the
machine.

Make sure that the paper is not wrinkled and
you are inserting it in correctly. Check that the
original is the right size, not too thick or thin.
« Make sure that the document feeder is firmly
closed.
« The document feeder rubber pad may need to
be replaced. Contact a service
representative.

Faxes are not
received
automatically.

« The receiving mode should be set to fax.
« Make sure that there is paper in the tray.

« Check to see if the display shows any error
message. If it does, clear the problem.

The machine does
not send.

* Make sure that the original is loaded in the
document feeder or on the scanner glass.

* Check the fax machine you are sending to, to
see if it can receive your fax.
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SUGGESTED SOLUTIONS

The incoming fax
has blank spaces or
is of poor-quality.

« The fax machine sending you the fax may be
faulty.

« A noisy phone line can cause line errors.

«  Check your machine by making a copy.

« Atoner cartridge has reached its estimated
cartridge life. Replace the toner cartridge
(See "Replacing the toner cartridge" on
page 120).

Some of the words
on an incoming fax
are stretched.

The fax machine sending the fax had a
temporary document jam.

There are lines on
the originals you
sent.

Check your scan unit for marks and clean it (See
"Cleaning the scan unit" on page 102).

The machine dials a
number, but the
connection with the
other fax machine
fails.

The other fax machine may be turned off, out of
paper, or cannot answer incoming calls. Speak
with the other machine operator and ask her/him
to solve out the problem.

Faxes do not store in
memory.

There may not be enough memory space to
store the fax. If the display indicating the
memory status shows, delete any faxes you no
longer need from the memory, and then try to
store the fax again. Call for service.

Blank areas appear
at the bottom of
each page or on
other pages, with a
small strip of text at
the top

You may have chosen the wrong paper settings
in the user option setting. For details about
paper settings, see "Setting the paper size and
type" on page 64.

Samsung Scan and Fax Manager Problem

CONDITION

SUGGESTED SOLUTION

Samsung Scan
Manager does not
work.

Check your system requirements. Samsung
Scan Manager works in Windows and Mac OS
(See "System requirements" on page 32).

Common Windows problems

CONDITION

SUGGESTED SOLUTIONS

“File in Use”
message appears
during installation.

Exit all software applications. Remove all
software from the printer’s startup group, then
restart Windows. Reinstall the printer driver.

“General Protection
Fault”, “Exception
OE”, “Spool 32”, or
“lllegal Operation”
messages appear.

Close all other applications, reboot Windows
and try printing again.

“Fail To Print”, “A
printer timeout error
occurred” messages
appear.

These messages may appear during printing.
Just keep waiting until the machine finishes
printing. If the message appears in standby
mode or after printing has been completed,
check the connection and/or whether an error
has occurred.

'g Refer to Microsoft Windows User’s Guide that came with your
computer for further information on Windows error messages.
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Common Linux problems

CONDITION

SUGGESTED SOLUTIONS

CONDITION

SUGGESTED SOLUTIONS

The machine does
not print.

Check if the printer driver is installed in your
system. Open Unified Driver Configurator and
switch to the Printers tab in Printers
configuration window to look at the list of
available machines. Make sure that your
machine is displayed on the list. If not, open
Add new printer wizard to set up your
device.

Check if the machine is started. Open
Printers configuration and select your
machine on the printers list. Look at the
description in the Selected printer pane. If its
status contains Stopped string, press the
Start button. After that normal operation of
the machine should be restored. The
“stopped” status might be activated when
some problems in printing occurred. For
instance, this could be an attempt to print a
document when the port is claimed by a
scanning application.

« Ensure the port is not busy. Since functional

components of machine (printer and scanner)
share the same /O interface (port), the
situation of simultaneous access of different
user applications to the same port is possible.
To avoid possible conflicts, only one of them
at a time is allowed to gain control over the
device. The other user will encounter “device
busy” response. You should open ports
configuration and select the port assigned to
your machine. In the Selected port pane you
can see if the port is occupied by some other
application. If this is the case, you should
either wait for completion of the current job or
press the Release port button, if you are sure
that the present application is not functioning
properly.

* Check if your application has special print

option such as “-oraw”. If “-oraw” is specified
in the command line parameter, then remove
it to print properly. For Gimp front-end, select
“print” -> “Setup printer” and edit command
line parameter in the command item.

* The CUPS (Common Unix Printing System)

version distributed with SUSE Linux 9.2
(cups-1.1.21) has a problem with ipp (Internet
Printing Protocol) printing.Use the socket
printing instead of ipp or install a later version
of CUPS (cups-1.1.22 or higher).

I cannot scan via
Gimp Front-end.

Check if Gimp Front-end has Xsane: Device
dialog. on the Acquire menu. If not, you should
install Xsane plug-in for Gimp on the your
computer. You can find Xsane plug-in package
for Gimp on Linux distribution CD or Gimp home
page. For the detailed information, refer to the
Help for Linux distribution CD or Gimp Front-end
application.

If you wish to use another kind of scan
application, refer to application’s Help.

| encounter error
“Cannot open port
device file” when
printing a document.

Avoid changing print job parameters (via LPR
GUI, for example) while a print job is in progress.
Known versions of CUPS server break the print
job whenever print options are changed and
then try to restart the job from the beginning.
Since Unified Linux Driver locks the port while
printing, the abrupt termination of the driver
keeps the port locked and unavailable for
subsequent print jobs. If this situation occurs, try
to release the port by selecting Release port in
Port configuration window.

The machine does
not print whole
pages, and output is
printed on half the
page.

It is a known problem that occurs when a color
machine is used on version 8.51 or earlier of
Ghostscript, 64-bit Linux OS, and has been
reported to bugs.ghostscript.com as Ghostscript
Bug 688252.The problem is solved in AFPL
Ghostscript v. 8.52 or above. Download the
latest version of AFPL Ghostscript from
http://sourceforge.net/projects/ghostscript/ and
install it to solve this problem.

The machine does
not appear on the
scanners list.

» Ensure your machine is attached to your
computer, connected properly via the USB
port, and is turned on.

* Ensure the scanner driver for your machine is
installed in your system. Open Unified Linux
Driver configurator, switch to Scanners
configuration, then press Drivers. Make
sure that driver with a name corresponding to
your machine's name is listed in the window.

« Ensure the port is not busy. Since functional
components of machine (printer and scanner)
share the same I/O interface (port), the
situation of simultaneous access of different
user applications to the same port is possible.
To avoid possible conflicts, only one of them
at a time is allowed to gain control over the
device. The other user will encounter “device
busy” response. This usually happens when
starting a scan procedure. An appropriate
message box appears.

To identify the source of the problem, open
the Ports configuration and select the port
assigned to your scanner, port's symbol
/dev/mfpO corresponds to LP:0 designation
displayed in the scanners’ options, /dev/mfp1
relates to LP:1, and so on. USB ports start at
/dev/imfp4, so scanner on USB:0 relates to
/dev/imfp4 respectively and so forth
sequentially. In the Selected port pane, you
can see if the port is occupied by another
application. If this is the case, you should
either wait for completion of the current job or
press the Release port button, if you are sure
that the present port application is not
functioning properly.
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CONDITION

SUGGESTED SOLUTIONS

The machine does
not scan.

« Ensure a document is loaded into the
machine, ensure your machine is connected
to the computer.

« Ifthere is an I/O error while scanning.

',g

Refer to Linux User’'s Guide that came with your computer for further
information on Linux error messages.

Common Macintosh problems

CONDITION

SUGGESTED SOLUTIONS

The machine does
not print PDF files
correctly. Some
parts of graphics,
text, or illustrations
are missing.

Printing the PDF file as an image may enable
the file to print. Turn on Print As Image from the
Acrobat printing options.

14

It will take longer to print when you print a
PDF file as an image.

The document has
printed, but the print
job has not
disappeared from
the spooler in Mac
0S X 10.3.2.

Update your Mac OS to Mac OS X 10.3.3. or
higher.

Some letters are not
displayed normally
during the cover
page printing.

Mac OS cannot create the font during the cover
page printing. The English alphabet and
numbers are displayed normally on the cover
page.

When printing a
document in Mac OS
with Acrobat
Reader 6.0 or higher,
colors print
incorrectly.

Make sure that the resolution setting in your
machine driver matches the one in Acrobat
Reader.

',g

Refer to Macintosh User’s Guide that came with your computer for
further information on Macintosh error messages.
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sUpplies and accessores

This chapter provides information on purchasing supplies, accessories and maintenance parts available for your machine.

This chapter includes:
« How to purchase
« Available supplies

[,g Available accessories may differ from country to country. Contact your
sales representatives to obtain the list of available accessories.

HOW TO PURCHASE

To order Samsung-authorized supplies, accessories and, maintenance
parts, contact your local Samsung dealer or the retailer where you
purchased your machine. You can also visit www.samsung.com/supplies,
select your country/region, and obtain information on calling for service.

AVAILABLE SUPPLIES

When supplies reach their lifespan, you can order the following types of
supplies for your machine:

* Maintenance parts
* Replacing the toner cartridge

MAINTENANCE PARTS

To avoid print quality and paper feed problems resulting from worn parts
and to maintain your machine in top working condition, the following parts
will need to be replaced after printing the specified number of pages or
when the life span of each item has expired.

TYPE AVERAGE YIELD? PART NAME

Standard yield | Approx. 1,500 pages 105 (MLT-D105S)
toner cartridge + Region A% 1052
(MLT-D1052S)

PARTS AVERAGE YIELD? PART NAME
Document feeder Approx. 20,000 pages RMO ADF
rubber pad RUBBER
Transfer roller Approx. 50,000 pages ESLLER-TRANSF
Fuser unit Approx. 50,000 pages FUSER
Pickup roller Approx. 50,000 pages ROLLER-PICK UP
Cassette unit Approx. 50,000 pages CASSETTE

High yield Approx. 2,500 pages 105L (MLT-D105L)
toner cartridge + Region A% 1052L
(MLT-D1052L)

a.Declared yield value in accordance with ISO/IEC 19752.

b.Region A: Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, Cyprus,
Czech Republic, Denmark, Finland, France, Germany, Greece,
Hungary, Italy, Macedonia, Netherlands, Norway, Poland, Portugal,
Romania, Serbia, Slovakia, Slovenia, Spain, Sweden, Switzerland, UK.

To replace a toner cartridge see "Replacing the toner cartridge" on
page 120.

',g Depending on the options and job mode used, the toner cartridge’s
lifespan may differ.

A You must purchase supplies, including toner cartridges, in the same
country where you purchased your machine. Otherwise, supplies will
be incompatible with your machine since the system configuration of
these vary from country to country.

A Samsung does not recommend using non-genuine Samsung toner

cartridge such as refilled or remanufactured. Samsung cannot
guarantee non-genuine Samsung toner cartridge's quality. Service or
repair required as a result of using non-genuine Samsung toner
cartridges will not be covered under the machine warranty.

a.lt will be affected by operating system used, computing performance,
application software, connecting method, media type, media size and
job complexity.

To purchase maintenance parts, contact the source where you bought the
machine.

Replacing maintenance parts can be performed only by an authorized
service provider, dealer, or the retailer where you bought the machine. The
warranty does not cover the replacement of any maintenance parts after
their lifespan.

REPLACING THE TONER CARTRIDGE

'g Click this link to open an animation about replacing a toner cartridge.

When a toner cartridge has reached its estimated cartridge life:
+ End of life Replace new cart appears on the display.
* The machine stops printing. Incoming faxes are saved in memory.

At this stage, the toner cartridge needs to be replaced. Check the type of the
toner cartridge for your machine (See "Available supplies" on page 120).
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. Open the front door.

2. Pull the toner cartridge out.

. Take a new toner cartridge out of its package.

. Remove the paper protecting the toner cartridge by pulling the packing
tape.

. Locate the sealing tape at the end of the toner cartridge. Carefully pull
the tape completely out of the cartridge and discard it.

'g * The sealing tape should be longer than 60 cm (23.6 inches)
when correctly removed.

« Holding the toner cartridge, pull the sealing tape straight to
remove it from the cartridge. Be careful not to cut the tape. If
this happens, you cannot use the toner cartridge.

» Refer to the helpful pictures on the cartridge wrapping paper.

. Slowly shake the cartridge five or six times to distribute the toner evenly
inside the cartridge. It will assure maximum copies per cartridge.

w If toner gets on your clothing, wipe it off with a dry cloth and wash
clothing in cold water. Hot water sets toner into fabric.

A Do not touch the green underside of the toner cartridge. Use the

handle on the cartridge to avoid touching this area.

7. Hold the toner cartridge by the handle and slowly insert the cartridge into
the opening in the machine.
Tabs on the sides of the cartridge and corresponding grooves within the
machine will guide the cartridge into the correct position until it locks into
place completely.

8. Close the front door. Make sure that the cover is securely closed.
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speciiications

This chapter guides you about this machine’s specifications such as various features.

This chapter include:

« Hardware specifications

« Environmental specifications
« Electrical specifications

« Print media specifications

w The specification values are listed below, specification are subject to change without notice: See www.samsung.com/printer for possible changes in

information.

HARDWARE SPECIFICATIONS

ITEM DESCRIPTION
Dimensions Height 318.9 mm (12.6 inches)
Depth 415.4 mm (16.4 inches)
Width 416 mm (16.4 inches)
Weight Machine with consumables 11.55 Kg (25.46 Ibs)
Package weight Paper 2.29 Kg (5.05 Ibs)
Plastic 0.49 Kg (1.07 Ibs)
ENVIRONMENTAL SPECIFICATIONS
ITEM DESCRIPTION
Noise Level® Ready mode 26 dB(A)
Printing mode 50 dB(A)
Copying mode (scanner glass) 50 dB(A)
Copying mode (document feeder) 52 dB(A)

Temperature Operation 10 to 32 °C (50 to 90 °F)
Storage (unpacked) 0to 40 °C (32 to 104 °F)
Humidity Operation 20 to 80% RH

Storage (unpacked)

10 to 80% RH

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.
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ELECTRICAL SPECIFICATIONS

A Po_wer requirements are based on the country/region where the device is sold. Do not convert operating voltages. Doing so might damage the device and

void the product warranty.
ITEM DESCRIPTION

Power rating® 110 volt models AC 110-127 V
220 volt models AC 220 -240V

Power consumption Average operating mode Less than 370 W
Ready mode Less than 45 W
Power save mode Less than 10 W
Power off mode Less than 1 W

a.See the rating label on the machine for the correct voltage, frequency (hertz) and type of current for your machine.
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PRINT MEDIA SPECIFICATIONS

PRINT MEDIA WEIGHT?/CAPACITY®

TYPE SIZE DIMENSIONS
TRAY1 MANUAL TRAY

Plain paper Letter 216 x 279 mm (8.50 x 11.00 inches) | 60 to 120 g/m? (16 to 32 Ib bond) 60 to 220 g/m? (16 to 43 Ib bond)
Legal 216 x 356 mm (8.50 x 14.00 inches) | * 250 sheets of 80g/m? (20 Ib * 1 sheet stacking
US Folio 216 x 330 mm (8.50 x 13.00 inches) bond)
A4 210 x 297 mm (8.27 x 11.69 inches)
Oficio 216 x 343 mm (8.50 x 13.50 inches)
JIS B5 182 x 257 mm (7.17 x 10.12 inches) 60 to 90 g/m? (16 to 24 Ib bond)
ISO B5 176 x 250 mm (6.93 x 9.84 inches) + 150 sheets of 80 g/m? (20 Ib
Executive 184 x 267 mm (7.25 x 10.50 inches) bond)
A5 148 x 210 mm (5.83 x 8.27 inches)
A6 105 x 148 mm (4.13 x 5.83 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.50 inches) Not available in tray1 75 to 90 g/m? (20 to 24 Ib bond)

Envelope No. 10

105 x 241 mm (4.12 x 9.50 inches)

» 1 sheet stacking

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)
Envelope C5 162 x 229 mm (6.38 x 9.02 inches)
Envelope C6 114 x 162 mm (4.49 x 6.38 inches)
Thick paper Refer to the Plain Refer to the Plain paper section 90 g/m? (24 Ib bond) 90 g/m? (24 Ib bond)
paper section + 1 sheet stacking
Thin paper Refer to the Plain Refer to the Plain paper section 60 to 70 g/m? (16 to 19 Ib bond) 60 to 70 g/m? (16 to 19 Ib bond)
paper section + 1 sheet stacking
Transparency Refer to the Plain Refer to the Plain paper section Not available in tray1 138 to 146 g/m2 (36.81 to 38.91
paper section Ib bond)
» 1 sheet stacking
Labels® Letter, Legal, US Refer to the Plain paper section Not available in tray1 120 to 150 g/m? (32 to 40 Ib
Folio, A4, JIS BS, ISO bond)
g?étsr):\ee%utuve’ A5, + 1 sheet stacking
Card stock Letter, Legal, US Refer to the Plain paper section Not available in tray1 105 to 163 g/m? (28 to 43 Ib

Folio, A4, JIS B5, ISO
B5, Executive, A5,
Statement, PostCard

4x6

bond)
* 1 sheet stacking

Minimum size (custom)

76 x 127 mm (3.00 x 5.00 inches)

Maximum size (custom)

216 x 356 mm (8.50 x 14.02 inches)

60 to 163 g/m? (16 to 43 Ib bond)

a.lf media weight is over 120 g/m? (32 Ib), load a paper into the tray one by one.
b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions.

¢. Smoothness: 100 to 250 (sheffield).
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contact samsung worldwide

If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

COUNTRY/REG CUSTOMER CARE WEB SITE COUNTRYIRES CUSTONER SARE WEB SITE
ION CENTER
ARGENTINE 0800-333-3733 www.samsung.com/ar HONGKONG | 3698-4698 www.samsuing.com/hk
www.samsung.com/hk_e
AUSTRALIA 1300 362 603 Wwww.samsung.com/au n/
AUSTRIA 0810-SAMSUNG (7267864, | www.samsung.com/at HUNGARY 06-80-SAMSUNG www.samsung.com/hu
€ 0.07/min) (726-7864)
BELARUS 810-800-500-55-500 www.samsung.ua INDIA 3030 8282 www.samsung.com/in
Www.samsung.com/ua_r 1800 110011
u 1800 3000 8282
BELGIUM 02 201 2418 www.samsung.com/be INDONESIA 0800-112-8888 www.samsung.com/id
(Dutch) X
www.samsung.com/be_fr ITALIA 800-SAMSUNG (726-7864) | www.samsung.com/it
(French) JAMAICA 1-800-234-7267 www.samsung.com/latin
BRAZIL 0800-124-421 www.samsung.com/br JAPAN 0120-327-527 www.samsung.com/jp
4004-0000
LATVIA 8000-7267 www.samsung.com/lv
CANADA 1-800-SAMSUNG www.samsung.com/ca
(726-7864) LITHUANIA 8-800-77777 www.samsung.com/It
CHILE 800-SAMSUNG (726-7864) | www.samsung.com/cl LUXEMBURG 0226103710 www.samsung.com/lu
CHINA 400-810-5858 www.samsung.com/cn MALAYSIA 1800-88-9999 www.samsung.com/my
010-6475 1880 MEXICO 01-800-SAMSUNG Www.samsung.com/mx
COLOMBIA 01-8000112112 WWW.Samsung.com.co (726-7864)
COSTA RICA 0-800-507-7267 www.samsung.com/latin MOLDOVA 00-800-500-55-500 www.samsung.ua
www.samsung.com/ua_r
CZECH 800-SAMSUNG www.samsung.com/cz u
REPUBLIC (800-726786)
NETHERLANDS | 0900-SAMSUNG www.samsung.com/nl
Samsung Zrt., €eska organizacni slozka, Oasis Florenc, (0900-7267864) (€
Sokolovska394/17, 180 00, Praha 8 0,10/min)
DENMARK 8-SAMSUNG (7267864) www.samsung.com/dk NEW ZEALAND | 0800 SAMSUNG (0800726 | www.samsung.com/nz
ECUADOR 1-800-10-7267 www.samsung.com/latin 786)
EL SALVADOR | 800-6225 www.samsung.com/latin NICARAGUA 00-1800-5077267 www.samsung.com/latin
ESTONIA 800-7267 WWw.samsung.com/ee NORWAY 3-SAMSUNG (7267864) www.samsung.com/no
KAZAKHSTAN | 8-10-800-500-55-500 www.samsung.com/kz_ru e 800-7267 www.samsung.com/latin
KYRGYZSTAN 00-800-500-55-500 PHILIPPINES (1782065)_-71&%AMSUNG www.samsung.com/ph
FINLAND 30-6227 515 www.samsung.com/fi 1-800-3-SAMSUNG
(726-7864)
FRANCE 01 4863 0000 www.samsung.com/fr 1-800-8-SAMSUNG
GERMANY 01805 - SAMSUNG www.samsung.de (726-7864)
(726-7864 € 0,14/min) 02-5805777
GUATEMALA 1-800-299-0013 www.samsung.com/latin POLAND 0801 1SAMSUNG www.samsung.com/pl
HONDURAS 800-7919267 www.samsung.com/latin (172678)

022-607-93-33
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COUNTRY/REG CUSTOMER CARE
ION CENTER e

PORTUGAL 80820-SAMSUNG www.samsung.com/pt
(726-7864)

PUERTO RICO 1-800-682-3180 www.samsung.com/latin

REP. DOMINICA | 1-800-751-2676 www.samsung.com/latin

EIRE 0818 717 100 www.samsung.com/ie

RUSSIA 8-800-555-55-55 Www.samsung.ru

SINGAPORE 1800-SAMSUNG www.samsung.com/sg
(726-7864)

SLOVAKIA 0800-SAMSUNG www.samsung.com/sk
(726-7864)

SOUTH AFRICA | 0860 SAMSUNG www.samsung.com/za
(726-7864)

SPAIN 902-1-SAMSUNG(902 172 | www.samsung.com/es
678)

SWEDEN 0771 726 7864 Www.samsung.com/se
(SAMSUNG)

SWITZERLAND | 0848-SAMSUNG (7267864, | www.samsung.com/ch
CHF 0.08/min)

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com/tw

THAILAND 1800-29-3232 www.samsung.com/th
02-689-3232

TRINIDAD & 1-800-SAMSUNG www.samsung.com/latin

TOBAGO (726-7864)

TURKEY 444 77 11 www.samsung.com/tr

U.A.E 800-SAMSUNG (726-7864) | www.samsung.com/ae
8000-4726

U.K 0845 SAMSUNG www.samsung.com/uk
(726-7864)

U.S.A 1-800-SAMSUNG WWww.samsung.com/us
(7267864)

UKRAINE 8-800-502-0000 www.samsung.ua

www.samsung.com/ua_r
u

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com/latin

VIETNAM 1800 588 889 www.samsung.com/vn
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glossary

The following glossary helps you get familiar with the product by
understanding the terminologies commonly used with printing as well
as mentioned in this user’s guide.

802.11

802.11 is a set of standards for wireless local area network (WLAN)
communication, developed by the IEEE LAN/MAN Standards
Committee (IEEE 802).

802.11blg

802.11b/g can share same hardware and use the 2.4 GHz band.
802.11b supports bandwidth up to 11 Mbps; 802.11g up to 54 Mbps.
802.11b/g devices may occasionally suffer interference from microwave
ovens, cordless telephones, and Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that
connects wireless communication devices together on wireless local
area networks (WLAN), and acts as a central transmitter and receiver of
WLAN radio signals.

ADF

An Automatic Document Feeder (ADF) is a mechanism that will
automatically feed an original sheet of paper so that the machine can
scan some amount of the paper at once.

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc for
computer networking. It was included in the original Macintosh (1984)
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth

A computer graphics term describing the number of bits used to
represent the color of a single pixel in a bitmapped image. Higher color
depth gives a broader range of distinct colors. As the number of bits
increases, the number of possible colors becomes impractically large for
a color map. 1-bit color is commonly called as monochrome or black and
white.

BMP

A bitmapped graphics format used internally by the Microsoft Windows
graphics subsystem (GDI), and used commonly as a simple graphics file
format on that platform.

BOOTP

Bootstrap Protocol. A network protocol used by a network client to
obtain its IP address automatically. This is usually done in the bootstrap
process of computers or operating systems running on them. The
BOOTP servers assign the IP address from a pool of addresses to each
client. BOOTP enables 'diskless workstation' computers to obtain an IP
address prior to loading any advanced operating system.
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CCD

Charge Coupled Device (CCD) is a hardware which enables the scan
job. CCD Locking mechanism is also used to hold the CCD module to
prevent any damage when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When
collation is selected, the device prints an entire set before printing
additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or
monitoring instruments are displayed. They are typically found in front of
the machine.

Coverage

It is the printing term used for a toner usage measurement on printing.
For example, 5% coverage means that an A4 sided paper has about 5%
image or text on it. So, if the paper or original has complicated images or
lots of text on it, the coverage will be higher and at the same time, a
toner usage will be as much as the coverage.

csv

Comma Separated Values (CSV). A type of file format, CSV is used to
exchange data between disparate applications. The file format, as it is
used in Microsoft Excel, has become a de facto standard throughout the
industry, even among non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a mechanism that will
automatically feed and turn over an original sheet of paper so that the
machine can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its box
state, reset, or initialized.

DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server
networking protocol. A DHCP server provides configuration parameters
specific to the DHCP client host requesting, generally, information
required by the client host to participate on an IP network. DHCP also
provides a mechanism for allocation of IP addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds
memory. DIMM stores all the data within the machine like printing data,
received fax data.



DNS

The Domain Name Server (DNS) is a system that stores information
associated with domain names in a distributed database on networks,
such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print head
that runs back and forth on the page and prints by impact, striking an
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for
scanning and printing. Generally, higher DPI results in a higher
resolution, more visible detail in the image, and a larger file size.

DRPD

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone
company service which enables a user to use a single telephone line to
answer several different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so that
the machine can print (or scan) on both sides of the paper. A printer
equipped with a Duplex Unit can print on both sides of paper during one
print cycle.

Duty Cycle

Duty cycle is the page quantity which does not affect printer
performance for a month. Generally the printer has the lifespan limitation
such as pages per year. The lifespan means the average capacity of
print-outs, usually within the warranty period. For example, if the duty
cycle is 48,000 pages per month assuming 20 working days, a printer
limits 2,400 pages a day.

ECM

Error Correction Mode (ECM) is an optional transmission mode built into
Class 1 fax machines or fax modems. It automatically detects and
corrects errors in the fax transmission process that are sometimes
caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results as
another.

An emulator duplicates the functions of one system with a different
system, so that the second system behaves like the first system.
Emulation focuses on exact reproduction of external behavior, which is
in contrast to simulation, which concerns an abstract model of the
system being simulated, often considering its internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local
area networks (LANs). It defines wiring and signaling for the physical
layer, and frame formats and protocols for the media access control
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized
as IEEE 802.3. It has become the most widespread LAN technology in
use during the 1990s to the present.
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EtherTalk

A suite of protocols developed by Apple Computer for computer
networking. It was included in the original Macintosh (1984) and is now
deprecated by Apple in favor of TCP/IP networking.

FDI

Foreign Device Interface (FDI) is a card installed inside the machine to
allow a third party device such as a coin operated device or a card
reader. Those devices allow the pay-for-print service on your machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for
exchanging files over any network that supports the TCP/IP protocol
(such as the Internet or an intranet).

Fuser Unit

The part of a laser printer that fuses the toner onto the print media. It
consists of a heat roller and a pressure roller. After toner is transferred
onto the paper, the fuser unit applies heat and pressure to ensure that
the toner stays on the paper permanently, which is why paper is warm
when it comes out of a laser printer.

Gateway

A connection between computer networks, or between a computer
network and a telephone line. It is very popular, as it is a computer or a
network that allows access to another computer or network.

Grayscale

A shades of gray that represent light and dark portions of an image
when color images are converted to grayscale; colors are represented
by various shades of gray.

Halftone

An image type that simulates grayscale by varying the number of dots.
Highly colored areas consist of a large number of dots, while lighter
areas consist of a smaller number of dots.

HDD

Hard Disk Drive (HDD), commonly referred to as a hard drive or hard
disk, is a non-volatile storage device which stores digitally-encoded data
on rapidly rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an
international non-profit, professional organization for the advancement
of technology related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to
a specific connector type on the end of the parallel cable that attaches to
the peripheral (for example, a printer).



Intranet

A private network that uses Internet Protocols, network connectivity, and
possibly the public telecommunication system to securely share part of
an organization's information or operations with its employees.
Sometimes the term refers only to the most visible service, the internal
website.

IP address

An Internet Protocol (IP) address is a unique number that devices use in
order to identify and communicate with each other on a network utilizing
the Internet Protocol standard.

IPM

The Images Per Minute (IPM) is a way of measuring the speed of a
printer. An IPM rate indicates the number of single-sided sheets a printer
can complete within one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for
printing as well as managing print jobs, media size, resolution, and so
forth. IPP can be used locally or over the Internet to hundreds of
printers, and also supports access control, authentication, and
encryption, making it a much more capable and secure printing solution
than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet
Exchange. It is a networking protocol used by the Novell NetWare
operating systems. IPX and SPX both provide connection services
similar to TCP/IP, with the IPX protocol having similarities to IP, and
SPX having similarities to TCP. IPX/SPX was primarily designed for
local area networks (LANs), and is a very efficient protocol for this
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an
international standard-setting body composed of representatives from
national standards bodies. It produces world-wide industrial and
commercial standards.

ITU-T

The International Telecommunication Union is an international
organization established to standardize and regulate international radio
and telecommunications. Its main tasks include standardization,
allocation of the radio spectrum, and organizing interconnection
arrangements between different countries to allow international phone
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile
transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression
standard with no loss of accuracy or quality, which was designed for
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compression of binary images, particularly for faxes, but can also be
used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used
standard method of lossy compression for photographic images. It is the
format used for storing and transmitting photographs on the World Wide
Web.

LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking
protocol for querying and modifying directory services running over
TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that indicates
the status of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated
with a network adapter. MAC address is a unique 48-bit identifier usually
written as 12 hexadecimal characters grouped in pairs (e. g.,
00-00-0c-34-11-4e). This address is usually hard-coded into a Network
Interface Card (NIC) by its manufacturer, and used as an aid for routers
trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes the
following functionality in one physical body, so as to have a printer, a
copier, a fax, a scanner and etc.

MH

Modified Huffman (MH) is a compression method for decreasing the
amount of data that needs to be transmitted between the fax machines
to transfer the image recommended by ITU-T T.4. MH is a
codebook-based run-length encoding scheme optimized to efficiently
compress white space. As most faxes consist mostly of white space, this
minimizes the transmission time of most faxes.

MMR

Modified Modified READ (MMR) is a compression method
recommended by ITU-T T.6.

Modem

A device that modulates a carrier signal to encode digital information,
and also demodulates such a carrier signal to decode transmitted
information.

MR

Modified Read (MR) is a compression method recommended by ITU-T
T.4. MR encodes the first scanned line using MH. The next line is
compared to the first, the differences determined, and then the
differences are encoded and transmitted.



NetWare

A network operating system developed by Novell, Inc. It initially used
cooperative multitasking to run various services on a PC, and the
network protocols were based on the archetypal Xerox XNS stack.
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual
image for print using a laser beam emitted from a laser printer, and it is
usually green or rust colored and a cylinder shaped.

An imaging unit containing a drum slowly wears the drum surface by its
usage in the printer, and it should be replaced appropriately since it gets
worn from grits of a paper and the drum cleaning blade.

Originals

The first example of something, such as a document, photograph or text,
etc, which is copied, reproduced or translated to produce others, but
which is not itself copied or derived from something else.

osl

Open Systems Interconnection (OSI) is a model developed by the
International Organization for Standardization (ISO) for communications.
OSI offers a standard, modular approach to network design that divides
the required set of complex functions into manageable, self-contained,
functional layers. The layers are, from top to bottom, Application,
Presentation, Session, Transport, Network, Data Link and Physical.

PABX

A private automatic branch exchange (PABX) is an automatic telephone
switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language
(PDL) developed by HP as a printer protocol and has become an
industry standard. Originally developed for early inkjet printers, PCL has
been released in varying levels for thermal, dot matrix printer, and
xerographic printers.

PDF

Portable Document Format (PDF) is a proprietary file format developed
by Adobe Systems for representing two dimensional documents in a
device independent and resolution independent format.

PostScript

PostScript (PS) is a page description language and programming
language used primarily in the electronic and desktop publishing areas. -
that is run in an interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the computer
to the printer.

Print Media

The media like paper, envelopes, labels, and transparencies which can
be used in a printer, a scanner, a fax or, a copier.

Glossary_ 130

PPM

Pages Per Minute (PPM) is a method of measurement for determining
how fast a printer works, meaning the number of pages a printer can
produce in one minute.

PRN file

An interface for a device driver, this allows software to interact with the
device driver using standard input/output system calls, which simplifies
many tasks.

Protocol

A convention or standard that controls or enables the connection,
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of the
world's public circuit-switched telephone networks which, on industrial
premises, is usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for
remote user authentication and accounting. RADIUS enables
centralized management of authentication data such as usernames and
passwords using an AAA (authentication, authorization, and accounting)
concept to manage network access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The
higher the dpi, the greater the resolution.

SMB

Server Message Block (SMB) is a network protocol mainly applied to
share files, printers, serial ports, and miscellaneous communications
between nodes on a network. It also provides an authenticated
Inter-process communication mechanism.

SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail
transmissions across the Internet. SMTP is a relatively simple,
text-based protocol, where one or more recipients of a message are
specified, and then the message text is transferred. It is a client-server
protocol, where the client transmits an email message to the server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network
(WLAN). All wireless devices in a WLAN use the same SSID in order to
communicate with each other. The SSIDs are case-sensitive and have a
maximum length of 32 characters.



Subnet Mask

The subnet mask is used in conjunction with the network address to
determine which part of the address is the network address and which
part is the host address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol (IP);
the set of communications protocols that implement the protocol stack
on which the Internet and most commercial networks run.

TCR

Transmission Confirmation Report (TCR) provides details of each
transmission such as job status, transmission result and number of
pages sent. This report can be set to print after each job or only after
failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped
image format. TIFF describes image data that typically come from
scanners. TIFF images make use of tags, keywords defining the
characteristics of the image that is included in the file. This flexible and
platform-independent format can be used for pictures that have been
made by various image processing applications.

Toner Cartridge

A kind of bottle or container within a machine like a printer which
contains toner. Toner is a powder used in laser printers and
photocopiers, which forms the text and images on the printed paper.
Toner can be fused by the heat of the fuser, causing it to bind to the
fibers in the paper.

TWAIN

An industry standard for scanners and software. By using a
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can
be initiated from within the program.; an image capture API for Microsoft
Windows and Apple Macintosh operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access network
shares in Window NT and other Microsoft products. The format of a
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL

Uniform Resource Locator (URL) is the global address of documents
and resources on the Internet. The first part of the address indicates
what protocol to use, the second part specifies the IP address or the
domain name where the resource is located.

UsB

Universal Serial Bus (USB) is a standard that was developed by the
USB Implementers Forum, Inc., to connect computers and peripherals.
Unlike the parallel port, USB is designed to concurrently connect a
single computer USB port to multiple peripherals.
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Watermark

A watermark is a recognizable image or pattern in paper that appears
lighter when viewed by transmitted light. Watermarks were first
introduced in Bologna, ltaly in 1282; they have been used by
papermakers to identify their product, and also on postage stamps,
currency, and other government documents to discourage
counterfeiting.

WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE
802.11 to provide the same level of security as that of a wired LAN. WEP
provides security by encrypting data over radio so that it is protected as
it is transmitted from one end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that is
originally introduced in Windows Me and Windows XP. A scan can be
initiated from within these operating systems by using a WIA-compliant
scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless
(Wi-Fi) computer networks, which was created to improve upon the
security features of WEP.

WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small
business or home users. A shared key, or password, is configured in the
wireless access point (WAP) and any wireless laptop or desktop
devices. WPA-PSK generates a unique key for each session between a
wireless client and the associated WAP for more advanced security.

XPS

XML Paper Specification (XPS) is a specification for a Page Description
Language (PDL) and a new document format, which has benefits for
portable document and electronic document, developed by Microsoft. It
is an XML-based specification, based on a new print path and a
vector-based device-independent document format.
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